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1  Safety and regulatory information
The product documentation helps you use the product safely and efficiently. Follow the
instructions provided here and in the following sections.

Intended use

The R&S NPA power analyzers are used to measure and analyze AC/DC load and
standby current characteristics, e.g. for measuring inrush currents or compliance test-
ing. It is designed for industrial use, e.g. production testing, maintenance and engineer-
ing labs.

The test adapter R&S NPA-Zx is an accessory for the R&S NPA power analyzers. It
can be used to analyze the performance of the mains with the DUT connected. The
test adapter is available with several country-specific outlets. The AC/DC clamp-on
current probes R&S HZC50 and R&S HZC51 provide extended power measurement
range.

Use the product and its accessories only for their designated purpose. Observe the
operating conditions and performance limits stated in the specificartion document, also
called data sheet.

Target audience

Only connect, set up and use a power analyzers if you are an electrically skilled per-
son. Such persons have the education and experience needed to recognize risks and
to avoid hazards of working with electricity.

This document provides information throughout the life cycle of the product for instal-
lers, operators, technicians, maintenance and service personnel.

Follow the safety instructions provided in Section 1.1, "Safety instructions",
on page 10 and the additional information provided during setup or operation proce-
dures.

Where do I find safety information?

Safety information is part of the product documentation. It warns you of potential dan-
gers and gives instructions on how to prevent personal injury or damage caused by
dangerous situations. Safety information is provided as follows:
● In Section 1.1, "Safety instructions", on page 10. The same information is provi-

ded in many languages in printed format. The printed "Safety Instructions" for
"Power Supplies and Power Analyzers" (document number 1171.2055.99) are
delivered with the product.

● Throughout the documentation, safety instructions are provided when you need to
take care during setup or operation.
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1.1  Safety instructions

Products from the Rohde & Schwarz group of companies are manufactured according
to the highest technical standards. To use the products safely, follow the instructions
provided here and in the product documentation. Keep the product documentation
nearby and offer it to other users.

Use the product only for its intended use and within its performance limits. Intended
use and limits are described in the product documentation such as the data sheet,
manuals and the printed "Safety Instructions". If you are unsure about the appropriate
use, contact Rohde & Schwarz customer service.

Only people skilled in electrical work should connect, set up and use the product. Such
persons have the education and experience needed to recognize risks and avoid haz-
ards of working with electricity. These users also need sound knowledge of at least one
of the languages in which the user interfaces and the product documentation are avail-
able.

Reconfigure or adjust the product only as described in the product documentation or
the data sheet. Any other modifications can affect safety and are not permitted.

Never open the casing of the product. Only service personnel authorized by
Rohde & Schwarz are allowed to repair the product. If any part of the product is dam-
aged or broken, stop using the product. Contact Rohde & Schwarz customer support at
https://www.rohde-schwarz.com/support.

Lifting and carrying the product

Look up the maximum weight in the data sheet. A single person can only carry a maxi-
mum of 18 kg safely depending on age, gender and physical condition. If your product
is heavier than 18 kg, do not move or carry it by yourself.

To move the product safely, you can use lifting or transporting equipment such as lift
trucks and forklifts. Follow the instructions provided by the equipment manufacturer.

Choosing the operating site

Only use the product indoors. The product casing is not waterproof. Water that enters
can electrically connect the casing to live parts, which can lead to electric shock, seri-
ous personal injury or death if you touch the casing.

Unless otherwise specified, you can operate the product up to an altitude of 2000 m
above sea level. The product is suitable for pollution degree 2 environments where
nonconductive contamination can occur. For more information on environmental condi-
tions such as ambient temperature and humidity, see the data sheet.

Setting up the product

Always place the product on a stable, flat and level surface with the bottom of the prod-
uct facing down. If the product is designed for different positions, secure the product so
that it cannot fall over.

If the product has foldable feet, always fold the feet completely in or out to ensure sta-
bility. The feet can collapse if they are not folded out completely or if the product is

Safety instructions

https://www.rohde-schwarz.com/support
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moved without lifting it. The foldable feet are designed to carry the weight of the prod-
uct, but not an extra load.

If stacking is possible, keep in mind that a stack of products can fall over and cause
injury.

If you mount products in a rack, ensure that the rack has sufficient load capacity and
stability. Observe the specifications of the rack manufacturer. Always install the prod-
ucts from the bottom shelf to the top shelf so that the rack stands securely. Secure the
product so that it cannot fall off the rack.

Connecting to power

The product is an overvoltage category II product. Connect the product to a fixed
installation used to supply energy-consuming equipment such as household applian-
ces and similar loads. Keep in mind that electrically powered products have risks, such
as electric shock, fire, personal injury or even death. Replace parts that are relevant to
safety only by original parts, e.g. power cables or fuses.

Take the following measures for your safety:
● Before switching on the product, ensure that the voltage and frequency indicated

on the product match the available power source. If the power adapter does not
adjust automatically, set the correct value and check the rating of the fuse.

● If a product has an exchangeable fuse, its type and characteristics are indicated
next to the fuse holder. Before changing the fuse, switch off the product and dis-
connect it from the power source. How to change the fuse is described in the prod-
uct documentation.

● Only use the power cable delivered with the product. It complies with country-spe-
cific safety requirements. Only insert the plug into an outlet with protective conduc-
tor terminal.

● Only use intact cables and route them carefully so that they cannot be damaged.
Check the power cables regularly to ensure that they are undamaged. Also ensure
that nobody can trip over loose cables.

● Only connect the product to a power source with the safety fuse specified in the
data sheet.

● Ensure that you can disconnect the product from the power source at any time.
Pull the power plug to disconnect the product. The power plug must be easily
accessible. If the product is integrated into a system that does not meet these
requirements, provide an easily accessible circuit breaker at the system level.

Working with hazardous voltages

Voltages higher than 30 V RMS, or 42 V peak, or 60 V DC are regarded as hazardous
contact voltages. Direct contact with them can cause serious injuries.

When working with hazardous contact voltages, use protective measures to preclude
direct contact with the measurement setup:

● Before each measurement, inspect all components for damage and replace them if
necessary.

● Do not touch exposed connections and components when power is applied.

Safety instructions
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● Casing, chassis and all measuring terminals are connected to a grounding connec-
tion. Never disconnect a grounding connection on the product.

● Switch off the power before connecting or disconnecting the terminal block to the
rear panel connector. Tighten all wires connected to the terminal block.

● Only use the wires and terminal blocks delivered with the product.
● Only use insulated wires, not stripped wires, for the terminal connections.
● Turn the mains switch off when the product is not in use.
● When operating measuring accessories, only use the cables delivered with the

accessory. If you have to use cables from other manufacturers, make sure that
they are of the required overvoltage category.

Do not operate the product in series or parallel unless that setup is supported. If acces-
sories are provided for a product, only use them for that product. See the data sheet.

In series or parallel setups, protect yourself against electric shock before connecting
access ports such as the Ethernet port or the USB port using one of the following
measures:

● Ensure that all products are grounded by connecting them to the AC power.
● Disconnect all power connections to the product, including outputs.

Measurement categories

IEC 61010-2-030 defines measurement categories that rate instruments on their ability
to resist short transient overvoltages that occur in addition to the working voltage. Use
the measurement setup only in electrical environments for which they are rated.

● 0 - Instruments without rated measurement category
For measurements performed on circuits not directly connected to mains, for exam-
ple, electronics, circuits powered by batteries, and specially protected secondary
circuits. This measurement category is also known as CAT I.

● CAT II:
For measurements performed on circuits directly connected to the low-voltage
installation by a standard socket outlet, for example, household appliances and
portable tools.

● CAT III:
For measurements performed in the building installation, such as junction boxes,
circuit breakers, distribution boards, and equipment with permanent connection to
the fixed installation.

● CAT IV:
For measurements performed at the source of the low-voltage installation, such as
electricity meters and primary overcurrent protection devices.

Safety instructions
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Cleaning the product

Use a dry, lint-free cloth to clean the product. When cleaning, keep in mind that the
casing is not waterproof. Do not use liquid cleaning agents.

Meaning of safety labels

Safety labels on the product warn against potential hazards.

Potential hazard

Read the product documentation to avoid personal injury or product damage.

Electrical hazard

Indicates live parts. Risk of electric shock, fire, personal injury or even death.

Hot surface

Do not touch. Risk of skin burns. Risk of fire.

Protective conductor terminal

Connect this terminal to a grounded external conductor or to protective ground. This connec-
tion protects you against electric shock if an electric problem occurs.

1.2  Labels on the R&S NPA power analyzers

Labels on the casing inform about:
● Personal safety, see "Meaning of safety labels" on page 13.
● Product and environment safety, see Table 1-1.
● Identification of the product, see the serial number on the rear panel.

Labels on the R&S NPA power analyzers
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Table 1-1: Labels regarding the R&S NPA power analyzers and environment safety

Labeling in line with EN 50419 for disposal of electrical and electronic equipment after the prod-
uct has come to the end of its service life. For more information, see "Disposing of electrical and
electronic equipment" on page 259.

Grounding terminal (earth ground contact)

Chassis grounding terminal

ON (supply voltage)

OFF (supply voltage)

1.3  Warning messages in the documentation

A warning message points out a risk or danger that you need to be aware of. The sig-
nal word indicates the severity of the safety hazard and how likely it will occur if you do
not follow the safety precautions.

DANGER

Imminently hazardous situation. Will result in death or serious injury if not avoided.

WARNING

Potentially hazardous situation. Could result in death or serious injury if not avoided.

CAUTION

Potentially hazardous situation. Could result in minor or moderate injury if not avoided.

NOTICE

Potential risks of damage. Could result in damage to the supported product or to other
property.

1.4  Where to find key documents on Rohde & Schwarz

Certificates issued to Rohde & Schwarz that are relevant for your country are provided
at www.rohde-schwarz.com/key-documents, e.g. concerning:
● Quality management
● Environmental management
● Information security management

Where to find key documents on Rohde & Schwarz

https://www.rohde-schwarz.com/key-documents
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● Accreditations

1.5  Korea certification class A

이 기기는 업무용(A급) 전자파 적합기기로서 판매자 또는 사용자는 이 점을 주의하시기
바라며, 가정외의 지역에서 사용하는 것을 목적으로 합니다.

Korea certification class A
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2  Welcome
The R&S NPA power analyzers are compact instruments for measuring AC/DC load
and standby current characteristics. Offering a numerical and graphical display, and
numerous measurement and mathematical functions, a R&S NPA enables you to mea-
sure and analyze power without additional equipment such as computers or a remote
environment.

2.1  Key features

The R&S NPA power analyzers set standards in power analyzing. Outstanding key fea-
tures are:
● Graphical display up to the 50th harmonic on the logarithmic scale
● Configurable dual-channel trend chart function
● Simultaneous display of current and voltage
● High basic measurement accuracy
● Up to 26 definable measurement and mathematical functions
● Adjustable filter system
● Clearly represented display of all measured parameters
● Customizable display of up to 10 numerical measurement functions at a time

For more information, see the specifications document.

2.2  Documentation overview

This section provides an overview of the R&S NPA user documentation. Unless speci-
fied otherwise, you find the documents at:

www.rohde-schwarz.com/manual/npa

Further documents are available at:

www.rohde-schwarz.com/product/npa

2.2.1  Getting started manual

Introduces the R&S NPA power analyzers and describes how to set up and start work-
ing with the product. Includes basic operations, typical measurement examples, and
general information, e.g. safety instructions, etc. A printed version is delivered with the
instrument.

Documentation overview

http://www.rohde-schwarz.com/manual/npa
http://www.rohde-schwarz.com/product/npa


WelcomeR&S®NPA

17User Manual 1179.1664.02 ─ 05

2.2.2  User manual

Contains the description of all instrument modes and functions. It also provides an
introduction to remote control, a complete description of the remote control commands
with programming examples, and information on maintenance and instrument interfa-
ces. Includes the contents of the getting started manual.

The user manual is also available for download or for immediate display on the Inter-
net.

2.2.3  Tutorials

Tutorials offer guided examples and demonstrations on operating the R&S NPA power
analyzers. They are provided on the product page of the internet.

2.2.4  Service manual

Describes the performance test for checking the rated specifications, module replace-
ment and repair, firmware update, troubleshooting and fault elimination, and contains
mechanical drawings and spare part lists.

The service manual is available for registered users on the global Rohde & Schwarz
information system (GLORIS):

See https://gloris.rohde-schwarz.com

2.2.5  Instrument security procedures

Deals with security issues when working with the R&S NPA in secure areas. It is avail-
able for download on the internet.

2.2.6  Printed safety instructions

Provides safety information in many languages. The printed document is delivered with
the product.

2.2.7  Specifications and product brochures

The specifications document, also known as the data sheet, contains the technical
specifications of the R&S NPA. It also lists the firmware applications and their order
numbers, and optional accessories.

The brochure provides an overview of the instrument and deals with the specific char-
acteristics.

See www.rohde-schwarz.com/brochure-datasheet/npa

Documentation overview

https://gloris.rohde-schwarz.com
http://www.rohde-schwarz.com/brochure-datasheet/npa
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2.2.8  Calibration certificate

The document is available on https://gloris.rohde-schwarz.com/calcert. You need the
device ID of your instrument, which you can find on a label on the rear panel.

2.2.9  Release notes and open source acknowledgment (OSA)

The release notes list new features, improvements and known issues of the current
software version, and describe the software installation.

The software uses several valuable open source software packages. An open source
acknowledgment document provides verbatim license texts of the used open source
software.

See www.rohde-schwarz.com/firmware/npa

2.2.10  Application notes, application cards, white papers, etc.

These documents deal with special applications or background information on particu-
lar topics.

See www.rohde-schwarz.com/application/npa

2.2.11  Remote control driver

The instrument drivers enable remote control via the corresponding interfaces. The
drivers and installation instructions are available for download on the product page at:

www.rohde-schwarz.com/driver/npa

Documentation overview

https://gloris.rohde-schwarz.com/calcert
http://www.rohde-schwarz.com/firmware/npa
http://www.rohde-schwarz.com/application/npa
http://www.rohde-schwarz.com/driver/npa
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3  Getting started
This section contains the information you have received as a printed book together
with your instrument. The information is provided again to enable you to search
throughout the complete description.

3.1  Preparing for use

Here, you can find basic information about setting up the product for the first time.

3.1.1  Lifting and carrying

See "Lifting and carrying the product" on page 10.

For mounting the R&S NPA in a rack, see Section 3.1.4.2, "Mounting the product in a
rack", on page 21.

3.1.2  Unpacking and checking

1. Unpack the product carefully.

2. Retain the original packing material. Use it when transporting or shipping the prod-
uct later.

3. Using the delivery notes, check the equipment for completeness.

4. Check the equipment for damage.

If the delivery is incomplete or equipment is damaged, contact Rohde & Schwarz.

See Section 15, "Transporting", on page 258.

3.1.3  Choosing the operating site

Specific operating conditions ensure proper operation and avoid damage to the prod-
uct and connected devices. For information on environmental conditions such as ambi-
ent temperature and humidity, see the specifications document.

For safety information, see "Choosing the operating site" on page 10.

Electromagnetic compatibility classes

The electromagnetic compatibility (EMC) class indicates where you can operate the
product. The EMC class of the product is given in the specifications document.
● Class B equipment is suitable for use in:
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– Residential environments
– Environments that are directly connected to a low-voltage supply network that

supplies residential buildings
● Class A equipment is intended for use in industrial environments. It can cause

radio disturbances in residential environments due to possible conducted and radi-
ated disturbances. It is therefore not suitable for class B environments.
If class A equipment causes radio disturbances, take appropriate measures to
eliminate them.

3.1.4  Setting up the product

For safety information, see:
● "Setting up the product" on page 10
● "Intended use" on page 9

3.1.4.1  Placing the product on a bench top

To place the product on a bench top

1. Place the product on a stable, flat and level surface. Ensure that the surface can
support the weight of the product. For information on the weight, see the specifica-
tions document.

2. CAUTION! Foldable feet can collapse. For safety information, see "Setting up the
product" on page 10.
Always fold the feet completely in or out. With folded-out feet, do not place any-
thing on top or underneath the product.

3. WARNING! A stack of products can fall over and cause injury. Never stack more
than three products on top of each other. Instead, mount them in a rack.
Stack as follows:

● If the products have foldable feet, fold them in completely.
● It is best if all products have the same dimensions (width and length). If the

products have different dimensions, stack according to size and place the
smallest product on top.

● Do not exceed the permissible total load placed on the product at the bottom of
the stack:
– 50 kg when stacking products of identical dimensions (left figure).
– 25 kg when stacking smaller products on top (middle figure).
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Left = Stacked correctly, same dimensions
Middle = Stacked correctly, different dimensions
Right = Stacked incorrectly, too many products

4. NOTICE! Overheating can damage the product.
Prevent overheating as follows:

● Keep a minimum distance of 10 cm between the fan openings of the product
and any object in the vicinity to provide sufficient airflow and ventilation.

● Do not place the product next to heat-generating equipment such as radiators
or other products.

3.1.4.2  Mounting the product in a rack

To prepare the rack

1. Observe the requirements and instructions in "Setting up the product" on page 10.

2. NOTICE! Insufficient airflow can cause overheating and damage the product.
Design and implement an efficient ventilation concept for the rack.

To mount the product in a rack

1. Use an adapter kit to prepare the R&S NPA for rack mounting.

a) Order the rack adapter kit designed for the R&S NPA power analyzers. For the
order number, see the specifications document.

b) Mount the adapter kit. Follow the assembly instructions provided with the
adapter kit.

2. Lift the R&S NPA to shelf height.

3. Push the R&S NPA onto the shelf until the rack brackets fit closely to the rack.

4. Tighten all screws at the rack brackets with a tightening torque of 1.2 Nm to secure
the R&S NPA at the rack.

To unmount the product from a rack

1. Loosen the screws at the rack brackets.
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2. Bring the lifting equipment to shelf height.

3. Remove the R&S NPA from the rack.

4. If placing the R&S NPA on a bench top again, unmount the adapter kit from the
R&S NPA. Follow the instructions provided with the adapter kit.

3.1.5  Considerations for test setup

Cable selection and electromagnetic interference (EMI)

Electromagnetic interference (EMI) can affect the measurement results.

To suppress electromagnetic radiation during operation:
● Use high-quality shielded cables, for example:

– Double-shielded data cables for connecting external devices. The length of
data cables must not exceed 3 m.

– Shielded cables (RG58/U coaxial cable) for signal transmission connections.
The length of signal cables must not exceed 1 m.

– Double-shielded USB cables. The length of passive USB cables must not
exceed 1 m.

– CAT6+ LAN cables, e.g. RJ-45 with a length ≤3 m.
– Double-shielded IEEE-488 (GPIB) bus cables. We recommend that you use

the double-shielded cable "R&S HZ72" from Rohde & Schwarz (GPIB-cable
2 m, order no. 3594.4269.02).

● Cables for output supply:
– Use insulated cables of the same type
– Keep the cable length as short as possible
– Use cables with maximum cross-section to minimize the conductor resistance

● Always terminate open cable ends.
● Ensure that connected external devices comply with EMC regulations.
● Check regularly that all cables, including power cables are in perfect condition.

Input and output levels

Information on voltage levels is provided in the specifications document. Keep the volt-
age levels within the specified ranges to avoid damage to the product and connected
devices.

3.1.6  Preparing for mains voltage

The R&S NPA is designed for 115 V or 230 V mains voltage. The range is specified on
the label next to the AC power supply, see Rear view > "AC power supply"
on page 37, and in the specifications document.
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If the mains voltage exceeds the permissible range, contact the Rohde & Schwarz cus-
tomer service, see Section 14.4, "Contacting customer support", on page 256.

Take care to adjust the R&S NPA to the supplied mains voltage. When delivered, the
R&S NPA is configured for 230 V mains voltage.

The product is protected with a line fuse. The suitable fuse type depends on the sup-
plied mains voltage. Table 3-1 shows the suitable fuse types.
Table 3-1: Fuse types

Mains voltage Fuse F1/F2

115 V IEC60127-2/5 - F630H/250V, order no. 3622.2330.00

230 V IEC60127-2/5 – F400H/250V, order no. 3622.2323.00

3.1.6.1  Preparing for 115 V

If you want to supply the R&S NPA with 115 V mains voltage, you need to do the fol-
lowing:
● "To change the fuse" on page 23
● "To set the supplied mains voltage" on page 24

To change the fuse

The fuses for 115 V mains voltage are delivered with the R&S NPA.

1. WARNING! The fuse is part of the AC power supply. Handling the fuse while the
power is on can lead to electric shock.
Before changing the fuse, disconnect the product from the power source.

2. Insert a flathead screwdriver with a blade width of approximately 2 mm under the
small opening tab of the fuse holder.

3

1

2

Figure 3-1: AC power connector

1 = Power supply switch
2 = Opening tab of the fuse holder
3 = AC power supply connector

When unlocking the mechanism, the fuse holder is pushed outwards by compres-
sion springs.

Preparing for use



Getting startedR&S®NPA

24User Manual 1179.1664.02 ─ 05

3. Pull out the fuse holder.

4. Lever out the fuse.

Keep the fuse for later use, if intact.

5. WARNING! If the fuse protection is insufficient, the R&S NPA can overheat and
even cause a fire.
Check the fuse rating on the caps of the fuse that is delivered with the R&S NPA.
Make sure that the fuse type matches the characteristics that are indicated next to
the fuse holder for 115 V mains voltage.

6. Inspect the compression springs of the fuse holder carefully. With deformed or pro-
truding springs, you cannot insert the fuse properly. Contact Rohde & Schwarz at
http://www.customersupport.rohde-schwarz.com.

7. Insert the fuses into the groove of the fuse holder.

8. Align the fuse holder with the guide bar facing the socket.

9. Carefully slide the fuse holder against the spring pressure into the slot until both
plastic locks latch.

To set the supplied mains voltage

The AC power supply voltage selector switch is on the rear panel.

► To set to 115 V mains voltage, use a tool e.g. a flat screwdriver to slide the voltage
selector so that the label indicates 115 V.

3.1.6.2  Reverting to 230 V

If needed, you can revert to 230 V mains voltage by:
● Inserting the fuse for 230 V mains voltage.
● Selecting 230 V as supplied mains voltage.

3.1.7  Connecting to power

For safety information, see:
● "Connecting to power" on page 11
● "Working with hazardous voltages" on page 11

To ground the chassis

The protective ground terminal  on the rear panel enables you to connect a ground
cable firmly with a screw, see "Ground terminal" on page 37.

See also Section 1.2, "Labels on the R&S NPA power analyzers", on page 13

1. Unscrew the screw of the ground terminal using a cross-recess screw driver.

2. Attach a ground cable with a ring terminal and pass the screw through it.
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3. Tighten the screw to 1.2 Nm using a torque wrench.

4. Connect the cable to ground.

To connect to AC supply

1. If necessary, ground the chassis of the R&S NPA. See "To ground the chassis"
on page 24.

2. WARNING! If the fuse protection is insufficient, the R&S NPA can overheat and
even cause a fire.
Ensure that R&S NPA is prepared for the supplied mains voltage. See Sec-
tion 3.1.6, "Preparing for mains voltage", on page 22.

3. Plug the AC power cable into the AC power supply connector. Only use the AC
power cable delivered with the R&S NPA.

4. Plug the AC power cable into a power outlet with ground contact.
Do not use a cheater plug or other means to bypass or disconnect the protective
ground lead.

The required ratings are listed on the reat panel of the R&S NPA, see rear panel.

3.1.8  Connecting to LAN

The R&S NPA power analyzers provide Ethernet (LAN) connectivity. If you have
assigned the corresponding rights, you can use this interface for remote control and
data transfer from a controller PC. Make sure that you have connected the controller
PC in the same network.

Consult your network administrator before performing the following tasks to avoid a
network failure:
● Connecting the instrument to the network
● Configuring the network
● Changing IP addresses

For remote control over other interfaces, refer to the description in Section 12, "Net-
work operation and remote control", on page 170.

To operate the instrument securely

1. NOTICE! The R&S NPA is designed to operate at local workplaces or in secured
networks (LAN).
When connected to the LAN, the R&S NPA can potentially be accessed from the
internet, which constitutes a security risk. For example, attackers can misuse or
damage your device.
Use secured connections for internet or remote access, if applicable.

2. Ensure that the network settings comply with the security policies of your company.
Contact your local system administrator or IT department before connecting your
product to your company LAN.
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3. Always install the latest firmware.

To connect to LAN

The LAN connector is on the rear panel.

1. WARNING! Risk of electric shock. With certain test setups , you achieve higher
voltages and currents. Observe the safety information in "Working with hazardous
voltages" on page 11.
Ensure that all products are grounded by connecting them to the AC power.

2. Connect the LAN socket using an RJ-45 cable to the LAN.

By default, the R&S NPA is configured to use DCHP that assigns the IP address
automatically.
If the R&S NPA cannot obtain an IP address automatically, it returns a time-out
message after about three minutes and clears the parameters in the "Ethernet Set-
tings" dialog. Possible reasons are that the LAN does not support DCHP or
requires a specific TCP/IP configuration, or that the connection is missing.

3. If the time-out message is displayed, proceed as follows:

a) Check if you have connected of both, the R&S NPA and the controller PC to
the LAN.

b) Consult your network administrator to request support and an IP address, if
necessary.

c) If necessary, assign the IP address manually as described in Section 12.4,
"Adjusting the interface addresses", on page 185.

If connected and switched on, the R&S NPA indicates the address information and
LAN parameters in the "Ethernet Settings" dialog.

Figure 3-2: Ethernet settings dialog

See Section 12.2.2, "Ethernet settings", on page 179. For information on how to
control the instrument remotely, see "To start a remote control session"
on page 189.
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3.1.9  Connecting USB devices

The USB A connector is on the front panel.

You can connect or disconnect all USB devices from the R&S NPA during operation.
But do not remove an external USB memory stick during a firmware update, data log-
ging and storing screen captures, as it can lead to unsuccessful updates and loss of
data.

To connect USB storage devices

USB storage devices, such as memory sticks, allow easy data transfer from/to the
R&S NPA. You can also use them for firmware updates.

► Connect the USB storage device to the USB type A connector directly, without con-
necting cable.
Connecting cables can cause electromagnetic radiation and impair the measure-
ment result.

3.1.10  Connecting a device under test (DUT)

For safety information, see "Working with hazardous voltages" on page 11.

The R&S NPA power analyzer enables you to measure AC/DC loads and current char-
acteristics with different measurement methods.

As a brief introduction, the following test setup example describes the basic steps to be
taken when setting up a measurement with the R&S NPA-Zx test adapter. See also the
installation instructions of the R&S NPA-Zx test adapter.

For further applications and test setups, see Section 4, "Measurement setups",
on page 48.

Test setup

This setup shows the R&S NPA-Zx test adapter connected to the R&S NPA power ana-
lyzer, and a DUT connected to the adapter.

The R&S NPA-Zx test adapter is like a standard AC outlet with grounded safety sock-
ets. The three connections V, A and COM to the power analyzers transmit the mains
values for the measurement.
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Figure 3-3: Measurement setup of the R&S NPA and the R&S NPA-Zx to a DUT

1 = R&S NPA power analyzer
2 = R&S NPA-Zx test adapter
3 = Power supply of the R&S NPA-Zx (cord with IEC plug)
4 = DUT power plug
5 = A, COM and V connection cables

To connect the R&S NPA-Zx test adapter to the R&S NPA power analyzer

See also Figure 3-3.

1. Use the cables delivered with the R&S NPA-Zx test adapter, as they are aligned for
connection of the R&S NPA-Zx to the R&S NPA power analyzer.
If you use other measurement equipment, ensure that it fulfills the requirements as
described in the R&S NPA-Zx installation instructions, section "Connecting to the
R&S NPA power analyzer and the DUT".

2. Inspect the cables and the cable connectors to ensure that they are not damaged.

Note: If the visual inspection shows any damage, replace the cable.

3. Inspect the A, COM and V safety sockets of both, the R&S NPA and the R&S NPA-
Zx visually to check that they are clean, undamaged and mechanically compatible.

Note: If the visual inspection shows that a connector requires cleaning, see Sec-
tion 16.1, "Cleaning", on page 259.

4. To connect the R&S NPA to the R&S NPA-Zx:

a) Connect the black cable to the COM safety socket of the R&S NPA "Measure-
ment connectors" on page 34.

b) Connect the blue cable to the A, and the red cable to the V safety sockets.
c) Stick to the color and connect the cables to the COM, A and V safety sockets

of the R&S NPA-Zx.

5. To connect the R&S NPA and the R&S NPA-Zx to the AC supply:
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a) Power on the R&S NPA, as described in Section 3.1.7, "Connecting to power",
on page 24.

b) Power on the R&S NPA-Zx as described in the R&S NPA-Zx test adapter instal-
lation instructions, section "Connecting to power".

c) Switch on the R&S NPA, see Section 3.1.11, "Switching on or off",
on page 29.

Tip: The R&S NPA-Zx does not have an On/Off switch.

To connect to the DUT

1. NOTICE! Risk of damage to the R&S NPA-Zx. The R&S NPA-Zx test adapter stan-
dard AC ground safety outlet system is approved for a 10 A continuous load.
Higher loads can damage or even destroy the device.
Ensure that the load meets the values specified in the specifications document.

2. Plug in the power cable of the DUT into the DUT power plug of the R&S NPA-Zx
test adapter.

3. To configure and execute a measurement, continue as described in the examples
under Section 3.3, "Trying out the instrument", on page 38.

See also the installation instructions of the R&S NPA-Zx test adapter.

3.1.11  Switching on or off

For safety reason, switch off the mains switch when the R&S NPA is not in use.

To switch on the R&S NPA

The instrument is off but connected to power, see Section 3.1.7, "Connecting to
power", on page 24.

1. Set the AC power supply switch on the rear panel to position [I].

The LED of the standby key lights red, see "POWER On/Standby key"
on page 34.

2. Press the standby key on the front panel.

The LED of the standby key turns off. The instrument performs a system check,
boots the operating system, and starts the firmware.

At restart, the R&S NPA starts up in the operating mode used before the last
switch-off.

Note: Initially, the R&S NPA displays a help screen.

3. To hide the help screen, press the key next to the "Hide" softkey on the front panel.

Tip: The "Hide Forever" softkey deactivates the automatic display of the help
screen when starting the instrument.
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To shut down the product

► Press the standby key.

All current settings are saved and the operating system shuts down. The LED of
the standby key changes to red.

To disconnect from power

The product is in the standby state.

1. NOTICE! Risk of data loss. If you disconnect the product from power when it is in
the ready state, you can lose settings and data. Shut it down first.
Set the switch on the power supply to position [0].

The LED of the standby key is switched off.

2. Disconnect the product from the power source.

3.1.12  Configuring the initial instrument settings

Basically, you can start working with the R&S NPA without any special initial settings. If
necessary, you can set the internal clock to the current date and time when you put it
into operation the first time.

This section describes how to set up date the R&S NPA initially. For further basic
instrument settings, see the R&S NPA user manual.

To set date and time of the instrument internal clock

1. Press the [SETUP] key on the front panel.

2. In the setup softkey menu, press the "Misc" softkey.

Figure 3-4: Setup softkey menu

3. In the miscellaneous menu, select the "Date & Time" softkey.

The "Set Date & Time" dialog opens. It indicates the date and time of the internal
clock. Yellow digits are editable.

4. Turn the [rotary knob] to increase or decrease, e.g., the "<year>" digits.
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5. Press the [rotary knob] to confirm the setting.

6. Select the following digits with the right [▶] arrow key.

7. Repeat steps (step 4 to step 6) to complete the date and time setting.

8. Press the [rotary knob] to confirm the setting.

The R&S NPA uses the information for assigning a time stamp to saved measure-
ment readings and printed outputs during operation.

3.2  Instrument tour

The instrument tour provides an overview of the front control elements and connectors
of the R&S NPA instrument models.

The meanings of the labels on the R&S NPA are described in Section 1.2, "Labels on
the R&S NPA power analyzers", on page 13.

3.2.1  Front view

Depending on the R&S NPA instrument model, some of the connectors and control
elements are not available.

Figure 3-5 shows the front view of the R&S NPA101 power meter instruments. The
power meter has no sensor input connectors.

Figure 3-5: Front view of the R&S NPA101

1 = Display
2 = "Interactive softkeys" on page 33
3 = "System and function keys" on page 33
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4 = "Navigation controls" on page 34.
5 = Measurement input connectors, see "Measurement connectors" on page 34
6 = Back key, see "Navigation controls" on page 34
7 = USB connector, see "USB A" on page 35
8 = "POWER On/Standby key" on page 34

Figure 3-6 represents the R&S NPA701(-G) and also the R&S NPA501(-G) power ana-
lyzer as the front views of both instument models are the same.

Figure 3-6: Front view of the R&S NPA701(-G) and R&S NPA501(-G)

1 = Display
2 = "Interactive softkeys" on page 33
3 = "System and function keys" on page 33
4 = "Navigation controls" on page 34.
5 = Measurement input connectors, see "Measurement connectors" on page 34
6 = Sensor input connectors, see "Sensor connectors" on page 34
7 = Back key, see "Navigation controls" on page 34
8 = USB connector, see "USB A" on page 35
9 = "POWER On/Standby key" on page 34

3.2.1.1  Display

The color display indicates the measurement readings and dialogs for configuring the
instrument and measurement settings. The screen display provides status and setting
information and allows you to access functions and settings with the interactive soft-
keys.

See Section 3.4.2.1, "Understanding the display information", on page 42.
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3.2.1.2  Keys

This section describes briefly the functionality of the controls. For information on how to
operate the instrument, see Section 3.4.2, "Means of manual interaction", on page 41.

Interactive softkeys

The interactive softkeys to the right of the display provide access to submenus and
functions of the instrument, depending on the selected view.

System and function keys

System and function keys provide access to the instrument settings and functions.
Table 3-2: Measurement parameter keys

Key Assigned functions

[U ▲]1)

[U ▼]1)

Increase or decrease the voltage range manually in predefined steps.

[I ▲]1)

[I ▼]1)

Increase or decrease current range manually in predefined steps.

[VIEW] Switches between the display modes.
The supported views depend on the instrument models:
● numerical views: R&S NPANPA101, R&S NPA501(-G) and

R&S NPA701(-G)
● graphical views: R&S NPA501(-G) and R&S NPA701(-G)

[ACQ] Opens the data acquisition menu to configure how the instrument acquires
measurement data.

[START/STOP] Starts/stops the energy counter.

[HOLD] Stops the update of measurement values.

[RESET] Resets the energy counter.

[NULL] Sets the current display values as zero reference values and displays devi-
ations.

[MEAS] Opens the measurement menu to select the measurement mode.
The supported measurement modes depend on the instrument models:
● "Integrator" and "Logging": R&S NPA101, R&S NPA501(-G),

R&S NPA701(-G)
● "Limit": R&S NPA501(-G), R&S NPA701(-G)
● Standards: R&S NPA701(-G)

[EXT] Depends on instrument models:
● R&S NPA101: not supported, the instrument beeps on using the key
● R&S NPA501(-G), R&S NPA701(-G): Opens the external measure-

ment menu to configure the settings when using external probes.

1) Pressing and holding the key activates the automatic adjustment ("AUTORANGE") of the measurement
range. You can activate autorange for the acqusition parameters U and I separately.
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Table 3-3: Utility keys

Key Assigned functions

[SETUP] Opens the menu to configure general instrument settings.

[SAVE/RECALL]2) Saves and loads instrument settings and provides access to configure the
screenshot functionality.

[HELP] Displays integrated help topics.

[SHIFT] Activates the numeric keypad for setting when applicable.

2) Pressing and holding the key saves the screenshot to a USB memory device, if connected.

Navigation controls

The navigation controls include a rotary knob, arrow keys, and the back key. The arrow
keys light up, when you can use them and the rotary knob for your settings. They allow
to navigate within the main view, menus and dialogs, see "Navigation controls"
on page 44.
Table 3-4: Navigation controls

Key Assigned functions

[Rotary knob] Pressing the knob opens or confirms a setting.

Turning the knob allows to adjust a setting, e.g. in an on-screen value list.

[▲] / [▼] /

[▲] / [▼]2)

Navigate up, down, right or left to select settings, when navigation is availa-
ble.

[back] Returns to the previous menu level or closes a view.

POWER On/Standby key

The [On/Standby] key switches the instrument from the standby to the ready state or
vice versa. In standby state, the LED of the [On/Standby] key lights red.

See Section 3.1.11, "Switching on or off", on page 29.

3.2.1.3  Connectors

The measurement input connectors and the USB connector are on the front panel.

Measurement connectors
Measurement input connectors.
4 mm safety sockets:
● A: Input for current measurement.
● COM: Common (shared) ground for voltage and current measurement.
● V: Input for voltage measurement.

Sensor connectors
Instrument models R&S NPA501(-G) / R&S NPA701(-G)
Sensor input connectors used for measurements with external shunts or current
clamps.
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4 mm safety sockets:
● IN: Input for external shunt or current probes.
● COM: Measurement ground for voltage and current measurement.

USB A
USB type A connector, to connect a memory device.

3.2.2  Rear view

This section provides an overview of the connectors on the rear panel of the instru-
ment. For technical data of the connectors, refer to the specifications document.

Figure 3-7 shows the rear panel view of the R&S NPA101 power meter instruments.
The power meter has no IEC 625/IEEE 488 interface and no analog and digital con-
nectors.

Figure 3-7: Rear view of the R&S NPA101

1 = "AC power supply" on page 37
2 = "Kensington lock" on page 37
3 = "AC power supply voltage selector switch" on page 37
4 = "Ground terminal" on page 37
5 = USB host connector, see "USB B" on page 37
6 = Ethernet (LAN) interface, see "LAN" on page 37

Figure 3-8 represents the R&S NPA701(-G) and also the R&S NPA501(-G) power ana-
lyzer as both instument models providee the same interfaces and connectors.
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Figure 3-8: Rear view of the R&S NPA501(-G) and R&S NPA701(-G)

1 = IEEE 488 (GPIB) interface (instrument models R&S NPA501-G, R&S NPA701-G), see "IEC 625/IEEE
488" on page 36

2 = "AC power supply" on page 37
3 = "Kensington lock" on page 37
4 = "AC power supply voltage selector switch" on page 37
5 = "Ground terminal" on page 37
6 = USB host connector, see "USB B" on page 37
7 = Ethernet (LAN) interface, see "LAN" on page 37
8 = "ANALOG IN, ANALOG OUT" on page 36
9 = "DIGITAL IN, DIGITAL OUT" on page 36

3.2.2.1  Connectors

DIGITAL IN, DIGITAL OUT
Instrument models R&S NPA501(-G), R&S NPA701(-G)
Connectors for digital inputs and outputs, e.g. to display "Pass/Fail" status information.
At the digital output, you can apply a limit value.

ANALOG IN, ANALOG OUT
Instrument models R&S NPA501(-G), R&S NPA701(-G)
Connectors for analog inputs and outputs, e.g. to display "Pass/Fail" status informa-
tion. At the analog output, you can apply a limit value.

IEC 625/IEEE 488
Instrument models: R&S NPA501-G, R&S NPA701-G
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GPIB (general purpose interface bus) interface to connect a computer for remote con-
trol of the R&S NPA. To set up the connection, use high-quality shielded cables.
See Section 12.1, "Remote control interfaces and protocols", on page 170.

LAN
RJ-45 connector to connect the R&S NPA to a LAN (local area network) for remote
control, remote operation, and data transfer.
How to: Section 3.1.8, "Connecting to LAN", on page 25

USB B
USB type B connector, to connect a computer for remote control of the R&S NPA.
See Section 12.1, "Remote control interfaces and protocols", on page 170.
How to: Section 12.3.2, "Connecting the R&S NPA to the USB interface", on page 184.

Ground terminal
Protective ground socket to secure the R&S NPA, e.g. with a grounded external con-
ductor.
See Section 1.2, "Labels on the R&S NPA power analyzers", on page 13.

AC power supply
Mains power supply with power switch, fuse holder and IEC socket.
● Mains power switch:

Switch for connecting and disconnecting the internal power supply from the power
source, see Section 3.1.11, "Switching on or off", on page 29.

● Fuse holder
Socket for the fuse securing the line voltage. Depending on the power supply sys-
tem, the corresponding fuse must be plugged before connecting to power. See
Section 3.1.7, "Connecting to power", on page 24.

● IEC socket
Power supply connector for connecting the R&S NPA to the mains, see Sec-
tion 3.1.7, "Connecting to power", on page 24.

AC power supply voltage selector switch
Switch for selecting the line voltage 115 V or 230 V.
How to: Section 3.1.7, "Connecting to power", on page 24.

Kensington lock
Flat key security slot to prevent the instrument from removal.
A Kensington lock system consists of a small, metal-reinforced hole combined with a
metal anchor attached to a rubberized metal cable secured with a key lock. The end of
the cable has a small loop that allows the cable to be looped around a permanent
object, such as a heavy table or other similar equipment.

Instrument tour
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3.3  Trying out the instrument

The R&S NPA power analyzers provide manually settable measurements, and auto-
mated test procedures. The automated test procedures comply with the requirements
of specific standards for power measurement and analysis. The following examples
introduce step by step a typical power measurement with any model of the R&S NPA
power analyzers, and an automated compliance test with an R&S NPA701 instrument,
supported by the verification wizard.

For the description of the complete functionality of the R&S NPA, see the R&S NPA
power analyzers user manual. For basic instrument operation, see Section 3.4, "Instru-
ment control", on page 41.

Prerequisites:
● The R&S NPA is set up, connected to power and started up as described in Sec-

tion 3.1.4, "Setting up the product", on page 20.
● The measurement is set up with the DUT connected to the R&S NPA-Zx test

adapter, as described in Section 3.1.10, "Connecting a device under test (DUT)",
on page 27.

Measuring the power characteristics of a load

This measurement example describes a typical numeric measurement application of
the R&S NPA101 power meter. The example leads you through the steps to be taken
to measure and view the readings in numeric mode. It shows, how to select the param-
eters for the display individually, and how to export the results of the measurement for
evaluating, e.g. on a PC application.

To start the measurement

1. Set the instrument to default to start from an initial state:

a) Press the [SETUP] key on the front panel.
b) In the setup menu, select the "Default Settings" softkey.

The instrument displays the "Help" topic with short instructions on the setting, e.g.
the numeric mode.

2. Select the "Hide" softkey to close the "Help" topic.

3. Press the [VIEW] key.

4. Select the "Numeric" softkey.

Trying out the instrument
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Figure 3-9: Numeric view

The instrument starts the measurement immediately and updates the measure-
ment readings continuously.
The numeric display shows the readings of six measurement parameters, as listed
in Table 3-5.
Table 3-5: Parameters displayed in numeric view

Parameter Description (unit) Parameter Description (unit)

"URMS" True RMS voltage (V) "IRMS" True RMS current (mA)

"P" Active power (mW) "FPLL" PLL source frequency (Hz)

"URange" Range voltage shown as bar graph
(V)

"IRange" Range current shown as bar
graph (mA)

To save and export measurement results

To keep measurement results for evaluation, you can save current measurement read-
ings as screenshots to an external USB memory device. This example briefly shows
how to save a snapshot of a measurement result.

To record measurement readings over a certain period of time, use the logging func-
tion, as described in Section 7.2, "Data logging", on page 81.

The USB connector is on the front panel.

To create and save a snapshot:

1. Plug in a USB memory stick.

2. Press the "HOLD" key.

The R&S NPA freezes the current display.

3. Press and hold the [SAVE/RECALL] key.

The instrument indicates the saving process until it is completed.
The R&S NPA creates a generic file name and saves the file on the memory device
with the extension *.png.

Trying out the instrument
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To save instrument settings

The R&S NPA can save instrument settings and screenshots. It saves screenshots
always on an external USB memory stick, to save instrument settings select either the
internal non-volatile memory or the USB stick.

The USB connector is on the front panel.

To create and save a snapshot:

1. Plug in a USB memory stick.

2. Press the [SAVE/RECALL] key on the front panel.

3. Press the "Device Settings" softkey.

Figure 3-10: Device settings softkey

4. Select "Save" to open the save to memory dialog.

Figure 3-11: Save softkey

5. Select the memory location, e.g. "STORAGE" > "Front USB".

6. Confirm with "Accept".

7. Press the "FILE NAME" softkey.

Figure 3-12: File name softkey

The system file manager dialog opens.

8. Assign a filename, if needed.
For settings, the R&S NPA assigns the default filename SETxxxx. "xxxx" refers to
an incremental index starting from "0001".

Trying out the instrument
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9. Select the "Comment" softkey to add a comment.

Figure 3-13: Comment softkey

The comment appears in the footer of the file manager when the file is selected.

10. Confirm with "Accept".

11. Press the "Save" softkey.

The R&S NPA saves the instrument settings in binary (HDS) format.

3.4  Instrument control

This section provides an overview on how to work with the R&S NPA. It introduces the
possibilities for operating the instrument and describes the basic functionality of the
control elements.

● Ways to operate the instrument.............................................................................. 41
● Means of manual interaction...................................................................................41
● Remote control........................................................................................................46

3.4.1  Ways to operate the instrument

You can operate an R&S NPA in two ways:
● Manual operation

Use the front panel controls to configure your measurement. The description under
Section 3.4.2, "Means of manual interaction", on page 41 shows how to operate
the instrument manually.

● Remote control
Create programs to automate repeating settings, tests and measurements. A con-
troller PC with remote access to the instrument runs the programs.
See Section 3.4.3, "Remote control", on page 46 for an overview of the interfaces
provided for remote control.

3.4.2  Means of manual interaction

To configure the R&S NPA manually, use the front panel controls, see Section 3.2.1,
"Front view", on page 31. The display shows the current settings and measurement
results. Interactive softkeys lead you to menus, dialogs and settings.

● Understanding the display information....................................................................42
● Accessing the functionality......................................................................................43
● Accessing menus and dialogs.................................................................................45
● Entering data...........................................................................................................45

Instrument control
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3.4.2.1  Understanding the display information

At the top of the display, the R&S NPA shows a status bar. It indicates the set voltage
and current measuring ranges, information on the measurement mode and general
settings, e.g. the selected interface. On the right-hand side of the screen layout, an
interactive softkey menu provides access to the selected measurement functions and
settings.

The result field depends on the selected view and the measurement mode. It shows
readings either numerically, bar graphs or waveform signals graphically.

Figure 3-14 shows the display of the numeric mode as an example.

For detailed information, see Section 8, "Display modes", on page 114.

Figure 3-14: Example of screen display in numeric mode

1 = Voltage measuring range
2 = Current measuring range
3 = Acquisition mode
4 = System time / integrator duration (when enabled)
5 = Logging enabled (green)/disabled (white)
6 = Active interface: TMC/VCP/LAN/GPIB
7 = Softkeys, in this example to switch between the four available pages of numeric measurements
8 = Measuring range and limits shown as bar graph ("URange"/"IRange" function)
9 = Measurement reading with unit
10 = Measurement parameter

Display indicators and characteristics

Additional display indicators and characteristics:
● General color coding:

Instrument control
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– White: measurement readings, parameter labels, parameter settings in the sta-
tus bar when manually selected, setting dialogs and functions

– Blue: parameter settings in the status bar if automatic selection is enabled,
softkey switches

– Orange: selected softkeys, settings in edit mode
– Yellow: general information and messages
– Green: messages and settings parameter names, settings in the status bar
– Red: warnings, notifications on inactive connections and settings

● Selected parameters have a blue background, the inactive counterparts are indica-
ted with a gray background.

● "---" dashes on the display indicate that the R&S NPA could not determine a value.
● "-OL-" on the display indicate that the measured value exceeds the currently

selected voltage or current measurement range.
●  symbol indicates the operation with the rotary knob.
● If the NULL function is activated, the R&S NPA displays deviations to the selected

reference value on the screen.
● "Fallback" time, an adjustable time period:

When this time period has elapsed, the instrument either closes a setting dialog,
returns to a previous dialog or assigns a certain setting automatically without hav-
ing confirmed manually.
Settings in menus are not affected by the fallback time.
See FALLBACK.

3.4.2.2  Accessing the functionality

The R&S NPA provides all functionalities by function keys, interactive softkeys and the
navigation controls on the front panel. This section describes the basic operation for
manual interaction with the instrument.

System and function keys

System and function keys include the measurement function keys (see Table 3-2) and
utility keys (see Table 3-3). Measurement parameter keys enable you to select and to
configure the measurement and to select the results display. A selected measurement
key lights up, indicating that the function is active. With the utility keys, you can config-
ure general instrument settings, manage data and configuration files and get help infor-
mation directly on the instrument.

Numeric keypad

The numeric keypad,

Pressing the [SHIFT] key, the R&S NPA switches the measurement function keys to a
numeric keypad to enter values for some parameters directly. The key remains lighting
while the numeric keypad is active.

With the numeric keypad, you can perform the commonly known actions:
● Insert numbers [0]...[9]

Instrument control
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● Insert a decimal point [.]
● Insert negative numbers with the [-] minus key
● Delete a digit [←] (backspace)
● Abort with [EXT]
● Confirm with [ENTER]

A value entered with the numeric keypad must to be confirmed to apply the setting.
Press either the [ENTER] key, the rotary knob or select one of the proposed units with
the softkeys.

Interactive softkeys

The interactive softkeys lead to submenus and functions. They allow you to set states
directly or access further settings lists or menus. The instrument assigns the setting
options for selection next to the softkeys on the right of the screen.

If a specific setting is in the current configuration not available, the softkey is grayed
out and blocked.

Navigation controls

The navigation controls include a rotary knob and arrow keys. They allow you to navi-
gate within a setting, menus or dialogs.
● Rotary knob

The rotary knob has several functions:
– Moves the selection, e.g. to a parameter in a settings dialog by turning clock-

wise or counterclockwise.
– Activates the edit mode of a parameter when pressed.
– Increments (by turning clockwise) or decrements (counterclockwise) a numeric

parameter at a defined step size.
– Acts like the [Enter] key when pressed.

● Arrow keys
– Move the selection up and down, or forward and backward, e.g. to a parameter

in a settings dialog.
– Return to a previous menu level (left arrow key).
– In a numeric input field, increase or decrease the value, or navigate to the next

or previous position.
● Back  key

The actions triggered by pressing this key vary, depending on where you press the
key:
– In menus:

Returns to a previous level (similar to the left arrow key). The menu closes
when you go back from the first menu level.

– On the screen display:
Resets an activated function, e.g. the edit mode.

– "Harmonics", "Waveform", "Trendchart" and "Inrush" modes, available for
instrument models R&S NPA501(-G), R&S NPA701(-G):

Instrument control
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Toggles the softkey menu: folds down the softkey menu to a narrow menu bar.
The bar displays the settings in abbreviated form, but still provides quick
access to change a setting with the corresponding softkey. Folded out, the soft-
key menu indicates the parameters and settings in the usual menu size.

3.4.2.3  Accessing menus and dialogs

All functions have the settings and parameters assigned to softkey menus. Use the
corresponding softkey on the front panel for accessing submenus and settings.

Throughout the description, the term "menu" refers to selection lists for softkeys and
settings, and the term "dialog" refers to editable windows in the instrument.

To open a menu

1. Press a function key on the front panel.

The R&S NPA displays the softkey menu of the selected function. The white arrow
tag at the bottom of a softkey indicates that you can access further settings in a
submenu.

2. Press the interactive softkey to open the corresponding function.

The selection leads you either to the settings parameters directly, or to further soft-
key submenus.

3. To access the next submenu, press the corresponding softkey.

To close or exit a dialog or menu

► Press the  [back] on the front panel.

The instrument returns to the previous menu level or exits the menu mode if it is
already at the main menu level.

3.4.2.4  Entering data

Depending on the settings, you can enter data either with the [rotary knob] or the
[SHIFT] key and the numeric keypad on the front panel.

Entering numeric parameters

If the input field requires numeric input, you can use the [rotary knob] and the [arrow]
keys on the front panel to enter a value. Alternatively, you can use the [SHIFT] key and
the numeric keypad on the front panel.

To correct a value

1. Rotate the rotary knob to increase (clockwise direction) or to decrease (counter-
clockwise direction) to the required value.

2. Alternatively, use the [SHIFT] key on the front panel for setting the numeric value
directly.

Instrument control
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3. Press the rotary knob to confirm the setting.

Entering alphanumeric data

For input of texts, e.g., file names or designators, the R&S NPA provides an embedded
standard editor with an alphanumerical keyboard.

Use the standard editor to perform the following actions:
● Assign names for specific settings, e.g. the instrument name.
● Define a directory or folder.
● Save the settings files.
● Save measurement data files.

To enter a text

The header of the editor shows a generic label, starting with "Enter..." and the parame-
ter you want to enter, e.g. "Enter file name".

Figure 3-15: Generic standard editor

1. In the "Enter ..." dialog, select a character with the rotary knob.

2. Confirm with the [ENTER] key.

3. Repeat the steps until you have completed the name.

4. For navigation, use the controls in the softkey menu on the right:
● The "Backspace" softkey deletes the character to the left of the cursor.
● "Default" assigns the name automatically containing an abbreviated designa-

tion and a generic number.
● "CURSOR ←", "CURSOR →" moves the cursor to the left or to the right.
● "Accept" confirms the entry and closes the editor.

3.4.3  Remote control

In addition to operating the R&S NPA directly on the instrument, it is also possible to
operate and control it from a remote PC.

Instrument control
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Remote control interfaces

The R&S NPA provides several interfaces for remote control:
● Ethernet (LAN) interface
● USB standard interface
● IEE-488 bus interface (GPIB) (instrument model R&S NPAxxx-G)

How to:
● Configure the remote control interfaces, see Section 12, "Network operation and

remote control", on page 170
● Set up LAN connection for remote control, see Section 3.1.8, "Connecting to LAN",

on page 25 for an example on how to set up LAN connection for remote control.
● Start remote operation, see Section 12.5, "Starting and stopping remote control",

on page 189

Instrument control
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4  Measurement setups
The following description briefly outlines the most important characteristics and
aspects of the measurement setups. It also points out the correct cabling and techni-
cally required background knowledge that must be considered for the corresponding
setups and measurement methods.

The connectors are on the front panel.

To connect a DUT to the R&S NPA for measurements, you have the following options:
● Connecting the DUT using the R&S NPA-Zx test adapter.

This option is described in Section 3.1.10, "Connecting a device under test (DUT)",
on page 27. It shows a typical test setup with the R&S NPA-Zx test adapter and
describes the basic steps to be taken when setting up the measurement.

● Connecting the DUT directly, see Section 4.3, "Connecting a DUT directly",
on page 52.

● Using an AC/DC current probe or external shunt, supported by instrument models
R&S NPA501(-G), R&S NPA701(-G), see Section 4.4, "Connecting an external
AC/DC shunt or clamp-on current probe", on page 53.

Considerations on test setups
● If not denoted explicitly, use the red V connector for voltage measurement, and the

blue A connector for current measurement.
The black COM connector is the ground reference for both, voltage or current mea-
surements.

● If the input current in the measurement range ≤200 mA for crest factor = 3 exceeds
the permissible 2 A, the R&S NPA prompts the notification "Overcurrent Protec-
tion". The R&S NPA turns off automatically.

Figure 4-1: Overcurrent protection

To continue the measurement, either adjust the measurement range to 500 mA (for
crest factor = 3) manually, or activate the automatic range setting.

● Internal wiring of the R&S NPA
The internal wiring of the A, V, and COM input connectors provides several meth-
ods to measure the DUT:
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V

1 3

A

2 4

COMA V

Figure 4-2: Internal wiring of A, V and COM of the R&S NPA

1 = Current input connector A
2 = Internal shunt
3 = Common (shared) ground COM
4 = Voltage input connector V

– Current-based measurement, see Section 4.2, "Current-based measurement",
on page 51

– Voltage-based measurement, see Section 4.1, "Voltage-based measurement",
on page 50

– Measurements with external shunts or current probes, see Section 4.4, "Con-
necting an external AC/DC shunt or clamp-on current probe", on page 53.

● Internal wiring of the R&S NPA-Zx test adapter

A VCOM

1

2

3

Figure 4-3: Internal wiring of A, V and COM of the R&S NPA-Zx

1 = AC power supply
2 = A, COM, V output connectors
3 = DUT power plug
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To set up measurement with the R&S NPA-Zx

1. Inspect the connectors and the cables visually to check that they are clean,
undamaged and mechanically compatible.

Note: If the visual inspection shows that a connector requires cleaning, see Sec-
tion 16.1, "Cleaning", on page 259.

2. To connect the R&S NPA-Zx test adapter to the R&S NPA:

Figure 4-4: R&S NPA-Zx to R&S NPA measurement setup

3. Select the black cable.

4. Connect the COM connector of the R&S NPA to the COM connector of the
R&S NPA-Zx.

5. Using the blue cable, connect the A connector of the R&S NPA with the A connec-
tor of the R&S NPA-Zx.

6. Connect the V connectors of both instruments with the red cable.

4.1  Voltage-based measurement

Used for measurements with high currents.

1 V

5 4

3

2

A

Iu

Figure 4-5: Voltage-based measurement circuit

Voltage-based measurement
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1 = Mains (source)
2 = Current output A
3 = DUT (load)
4 = Common shared output COM
5 = Voltage output V

The voltage drop at the shunt increases with the current linearly. The measurement
achieves a precise voltage reading at the load.

The measurement setup requires that you swap the A and COM inputs and invert the
measured current reading.

To set up a voltage-based measurement with the R&S NPA-Zx

1. Inspect the connectors and the cables visually to check that they are clean,
undamaged and mechanically compatible.

Note: If the visual inspection shows that a connector requires cleaning, see Sec-
tion 16.1, "Cleaning", on page 259.

2. To connect the R&S NPA-Zx to the R&S NPA, consider that you swap the A and
COM inputs:

a) Black cable: connect the A connector of the R&S NPA to the COM connector
of the R&S NPA-Zx.

b) Blue cable: connect the COM connector of the R&S NPA with the A connector
of the R&S NPA-Zx.

c) Red cable: connect the V connectors of both instruments.

3. On the R&S NPA, configure the measurement settings:

a) Press the [ACQ] key on the front panel.
b) In the acquisition softkey menu, press the "Current" softkey.
c) In the current softkey menu, select the "INVERT" key
d) Set "INVERT > On".
e) Press the [Back] key to return to full display of the measurement view.

4.2  Current-based measurement

Used for measurements with low currents and high voltages.

Current-based measurement
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1 V
Ui

5 4

3

2

A

Figure 4-6: Current-based measurement circuit

1 = mains (source)
2 = voltage output V
3 = DUT (load)
4 = common shared output COM
5 = current output A

The current-based measurement prevents a current flow through the shunt, which
would lead to impact of the readings at low currents.

To set up a current-based measurement with the R&S NPA-Zx

1. Inspect the connectors and the cables visually to check that they are clean,
undamaged and mechanically compatible.

Note: If the visual inspection shows that a connector requires cleaning, see Sec-
tion 16.1, "Cleaning", on page 259.

2. Connect the R&S NPA-Zx to the R&S NPA as described under "To set up measure-
ment with the R&S NPA-Zx" on page 50.

3. On the R&S NPA, configure the measurement settings.

4.3  Connecting a DUT directly

For measurements with loads within the specified limits for voltage (up to 600 Vrms) and
current (up to 20 Arms), you can directly connect the DUT to the R&S NPA.

To connect a DUT directly

How to connect the DUT to the R&S NPA depends on the test setup.

1. Depending on the expected load, proceed as described for the corresponding test
setup:

● If you want to measure high currents, refer to Section 4.2, "Current-based mea-
surement", on page 51.

Connecting a DUT directly
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● If you expect low currents, refer to Section 4.1, "Voltage-based measurement",
on page 50.

2. To configure the measurement, see Section 6, "Data acquisition", on page 59.

For specifications, see the datasheet at www.rohdeschwarz. com/brochure-datasheet/
npa.

4.4  Connecting an external AC/DC shunt or clamp-on cur-
rent probe

Instrument models R&S NPA501(-G) and R&S NPA701(-G) enable you to use an
external AC/DC current probe or shunt to measure the current and voltage of a DUT.
For example, Rohde & Schwarz provides the clamp-on current probes R&S HZC50
R&S HZC51. The clamp-on probes provide safety plugs you can directly connect to the
instrument.

Measurements with clamp-on probes use the sensor connection to compensate volt-
age drops on the supply lines to the load.

Figure 4-7: R&S HZC51 clamp-on current probe

To connect the external clamp-on current probe

Instrument models R&S NPA501(-G) and R&S NPA701(-G) only

1. Inspect the connectors and the cables visually to check that they are clean,
undamaged and mechanically compatible.

Note: If the visual inspection shows that a connector requires cleaning, see Sec-
tion 16.1, "Cleaning", on page 259.

2. DANGER! Risk of electrical shock. Never use a BNC adapter to connect an exter-
nal clamp-on current probe to the R&S NPA. Depending on the polarity of the volt-
age, the BNC plug coupling is live. Touching a live electrical device causes serious
personal injury, or even death.
Align the cable connector of the probe with the colors matching to the "Sensor"
connectors of the R&S NPA.

Connecting an external AC/DC shunt or clamp-on current probe

http://www.rohdeschwarz.com/brochure-datasheet/npa
http://www.rohdeschwarz.com/brochure-datasheet/npa
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3. Plug the cable connector of the probe to the COM and the IN connectors of the
R&S NPA.

4. To configure the measurement, see Section 9.3, "Sensor settings", on page 139.

Connecting an external AC/DC shunt or clamp-on current probe
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5  Measurement parameters and ranges

5.1  Measurement parameters

The R&S NPA always derives all calculated parameters from the measurement,
regardless of the selection on the screen. The following table shows all parameters
available for display. Parameters that only apply to certain instrument models are poin-
ted out. The columns to the right show the subsets of parameters available for certain
functions only.
Table 5-1: List of measured and calculated parameters

Parameter Description (unit) Trendchart Limit Integrator

P Active power (W) x x  

S Apparent power (VA) x x  

Q Reactive power (var) x x  

LAMBDA Power factor λ  x  

PHI Phase difference Phi (°) x x  

FU Voltage frequency (Hz) x x  

FI Current frequency (Hz) x x  

UPPeak*) Maximum voltage (V)    

UMPeak*) Minimum voltage (V)    

IPPeak*) Maximum current (mA)    

IMPeak*) Minimum current (mA)    

PPPeak*) Maximum power (W)    

PMPeak*) Minimum power (W)    

URMS True RMS voltage (V)

root mean square voltage

x x  

UAVG Average voltage (V) x x  

IRMS True RMS current (mA)

root means square current

x x  

IAVG Average current (mA) x x  

UTHD Total harmonic distortion voltage (%) x x  

ITHD Total harmonic distortion current (%) x x  

DIN*) Digital input value (Hz) x   

AIN*) Analog input value (V) x   

TIME Integration time (00:00.0)    

Measurement parameters
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Parameter Description (unit) Trendchart Limit Integrator

WH Watt hour (mWh),

sum of positive and negative watt
hour

  x

WHP Positive watt hour (mWh)   x

WHM Negative watt hour (mWh)   x

AH Ampere hour(mAh)

Sum of positive and negative ampere
hour

  x

AHP Positive ampere hour (mAh)   x

AHM Negative ampere hour (mAh)   x

Lim1..6*) Limit 1 to Limit 6 (%)    

URange Range voltage (V)

Voltage measurement range shown
as bar graph

   

IRange Range current (mA)

Current measurement range shown
as bar graph

   

FPLL PLL source frequency (Hz)

Phase locked loop synchronization
frequency

x x  

*):R&S NPA501(-G) / R&S NPA701(-G) only    

5.2  Measurement ranges

Each measurement requires, that you select the expected voltage and current mea-
surement range before you start a measurement.

Regardless of the selected measurement mode and display, you can set the voltage
and current measurement ranges directly with the keys on the front. The R&S NPA
shows the settings in the status bar on the screen.

About
● The R&S NPA provides the function to adjust the voltage and current measurement

ranges automatically, but also allows you to select each manually.
How to: see "To set automatic measurement range" on page 58 and "To select a
measurement range manually" on page 57

● Automatic measurement range selection:
– Thresholds:

If the measured value exceeds 120% of the set range, the instrument switches
to the next higher range.
If the measured value is ≤95% of the set range over a period of 0.6 s, the
instrument switches to the next lower range.

Measurement ranges
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– If the applied current exceeds the set range, the R&S NPA first switches to the
maximum measurement range to protect the internal shunt from damage. In
the next step, it adjusts the range accordingly.
Example:
Applied current: >2 A
Selected range: ≤200 mA *3 (crest factor) = 600 mA
The R&S NPA sets the current range to 20 A, and then adjusts the range to
5 A.

– Automatic range selection disables manual range selection.
● Manual measurement range selection:

– If the applied current value exceeds the maximum measurement range, the
R&S NPA prompts an overload message.

Figure 5-1: Example of OL display

A red measurement bar indicates that the applied signal exceeds the set range.
– Adjusting the range manually disables automatic range selection.

● Sensor measurement with an external clamp-on probe disables automatic current
measurement mode, supported by (R&S NPA501(-G), R&S NPA701(-G), see Sec-
tion 4.4, "Connecting an external AC/DC shunt or clamp-on current probe",
on page 53

To select a measurement range manually

By default, automatic range is enabled, indicated in dark green in the status bar. To
switch to manual selection of voltage and current measurement ranges, proceed as fol-
lows:

1. Press the [ACQ] key on the front panel.

2. Press the [U ▲] or key [U ▼] key, to switch to manual voltage range.
Alternatively, you can select the parameter and use the "AUTORANGE" softkey.

3. Press the [U ▲] key to increase the voltage range, or [U ▼] key to decrease it
respectively.

4. Press the keys repeatedly until you have selected the range you need for your
measurement.

The available settings depend on the crest factor, see Table 6-1.

Measurement ranges
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5. Proceed the same way to select the current measurement range using the [I ▲] and
[I ▼] keys.
The available settings depend on the crest factor, see Table 6-2.

6. To display the range graphically, assign the functions "URange" and "IRange" on
the measurement page.

7. How to: see "To select parameters different from default display" on page 116.

Figure 5-2: Graphical display of the measurement ranges

To set automatic measurement range

If automatic range is disabled, the R&S NPA indicates the parameter in the status bar
in light green. You have several options, to set the automatic range:

1. Press the [ACQ] key on the front panel.

2. Using the function keys:

a) If automatic voltage range is disabled, press and hold either the [U ▲] or the [U
▼] key to switch to automatic mode.

b) Pressing one of the keys again returns to manual mode.

For automatic current range selection, use the [I ▲] or the [I ▼] keys the same way.

3. Using the acquisition settings:

a) Press the [ACQ] key.
b) Press the softkey of a parameter, e.g., the "Voltage" softkey.
c) Select "AUTORANGE" > "On".

Measurement ranges
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6  Data acquisition
Acquisition modes

The R&S NPA acquires current and voltage readings simultaneously using a sampling
frequency of 500 kSample/s. It refreshes the values displayed on the screen 10 times
per second.

Provided acquisition modes:
● DC: Measures synchronized to 100 ms display update rate.
● AC: Measures synchronized to a voltage or current period.
● AUTO: Detects an incoming signal and selects the corresponding acquisition mode

automatically.
● EXTERN: Measures synchronized to the external BNC connector (DIGITAL IN).

Crest factor

The crest factor represents the ratio of peak values to the effective values (RMS) of a
waveform, i.e. an alternating signal.

This factor indicates how extreme peaks are in a waveform, which is important espe-
cially for the measurement of pulse-shaped sizes. For example, the ratio of √2=1.414
applies to pure sine wave types. The accuracy of the calculated effective value
remains the same as long as the peak value is within the peak range.

To evaluate the waveform distortion of nonlinear electrical loads, you can use e.g., the
waveform or trend chart mode, see Section 8, "Display modes", on page 114.

Figure 6-1: Sample configuration

Depending on the measurement, you can select a crest factor of 1, 3 or 6. Factor 6 is
required, e.g. for measurements of sinusoidal waveforms with spikes or for standby
measurements according to IEC 62018.
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Invert function

Figure 6-2: Inversion

In AC acquisition, the R&S NPA includes the sign of the measured parameters to
derive the correct input or output values, e.g., the power value. Depending on the test
setup, it can be necessary to measure a parameter inverted, as for e.g. for the Voltage-
based measurement, see page 50. This setup requires the wires to be swapped and
thus also the measurement parameter to be inverted, see Voltage Settings > Invert and
Current Settings > Invert.

Filter

The R&S NPA features filter functions to increase the accuracy of the measurement:
● Frequency filter

500 Hz low-pass filter in the frequency path acquires the zero crossings to deter-
mine the signal period precisely. The filter does not affect the signal path.

● Digital filter
Calculates the average value of the filter setting over several periods. This function
increases the accuracy and achieves more stability for fluctuating values.

● BWL:
1 kHz low-pass filter limits the bandwidth to generate a pure signal adjusted to RF.

You can enable the filters for Aquisition modes "AC" and "AUTO", see Section 6.4,
"Acquisition mode settings", on page 69.

Figure 6-3: Filters arranged as a chain
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Frequency source

The "PLL SRC" (Phase Locked Loop Source frequency synchronization) function sets
the frequency of the fundamental wave as the reference value for the measured har-
monics. By default, the R&S NPA refers to the voltage. However, measurements of sig-
nals with a small or irregular current trace achieve higher accuracy when you use a
current as reference.

Access:

► Press the [ACQ] key on the front panel.

Figure 6-4: Acquisition softkey menu

The acquisition softkey menu contains the main parameters for configuring data
acquisition.

To configure the voltage and current parameters

Voltage and current parameters are similar, therefore the example instruction summari-
zes the settings of both parameters.

To configure the range, crest factor and invert function:

1. Press the [ACQ] key.

2. Press, e.g., the "Voltage" softkey.

3. In the voltage softkey menu, select "AUTORANGE" > "Off".

4. Select the "RANGE" softkey.

5. Select the voltage range with the rotary knob, e.g. 300 V. Alternatively, you can
press the "RANGE" softkey repeatedly to select the voltage range.
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Figure 6-5: Select voltage range

6. Press the "CREST FACT" softkey to enable edit mode.

7. Select the crest factor by turning rotary knob, e.g., set "3".

Figure 6-6: Select crest factor

8. Press the "INVERT" softkey, e.g. "Off".

9. Press the  key to return to the acquisition softkey menu.

To configure the acquisition mode

To configure the acquisition mode, e.g., select the AC mode and set the frequency syn-
chronization and filters:

1. Press the [ACQ] key.

2. Press the "Mode" softkey.

3. In the mode softkey menu, select "MODE" to enable edit mode.
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Figure 6-7: Select the parameter for data acquisition

4. Select, e.g., "AC" with the rotary knob.

5. Press the "PLL SRC" softkey repeatedly until you have selected "Voltage". Alterna-
tively, you can use the rotary knob.

Figure 6-8: Select the PLL source

6. Set "FREQ. FILTER" > "On".

7. Set "DIG. FILTER" > "AUTO".

8. Set "BWL 1KHZ" > "On".

9. Press the  key to return to the acquisition softkey menu.

To enable the peak hold function and set the display update

Instrument models R&S NPA501(-G) and R&S NPA701(-G) support peak hold function
only.

1. Press the [ACQ] key.

2. Press the "Peak Hold" softkey.
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Figure 6-9: Enable peak hold

3. In the peak hold softkey menu, select "ACTIVATE" > "On".

4. Press the  key to return to the acquisition softkey menu.

5. Press the "REFRESH" softkey and select, e.g., "Fast" (toggle function).

Figure 6-10: Set refresh mode

6. Press the  key repeatedly to return to the acquisition softkey menu and to fold it
down.

The R&S NPA shows the readings according to the settings.

Figure 6-11: Example of AC acquisition with peak hold, inverted current and fast refresh

1 = voltage range (status bar)
2 = current, inverted
3 = mode AC -> voltage
4 = peak hold snapshot

● Data acquisition settings......................................................................................... 65
● Voltage settings.......................................................................................................66
● Current settings.......................................................................................................68
● Acquisition mode settings....................................................................................... 69
● Peak hold settings...................................................................................................71
● Refresh settings...................................................................................................... 72
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6.1  Data acquisition settings

Access:

1. Press the [ACQ] key on the front panel.

Figure 6-12: Acquisition softkey menu

2. Select the parameter to open the corresponding softkey menu.

The acquisition softkey menu contains the main parameters for configuring data
acquisition.

The remote commands required to define these settings are described in Section 13.3,
"CHANnel:ACQuisition subsystem", on page 195.

How to:
● "To configure the voltage and current parameters" on page 61
● "To configure the acquisition mode" on page 62
● "To enable the peak hold function and set the display update" on page 63

Settings

Voltage.......................................................................................................................... 65
Current.......................................................................................................................... 65
Mode............................................................................................................................. 66
Peak Hold......................................................................................................................66
REFRESH..................................................................................................................... 66

Voltage
Opens the softkey menu for setting the voltage parameters, see Section 6.2, "Voltage
settings", on page 66.
Remote command: 
n.a.

Current
Opens the softkey menu for setting the current parameters, see Section 6.3, "Current
settings", on page 68.

Data acquisition settings
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Remote command: 
n.a.

Mode
Opens the softkey menu for selecting the data acquisition mode, see Section 6.4,
"Acquisition mode settings", on page 69.
Remote command: 
n.a.

Peak Hold
Opens the peak hold softkey menu, see Section 6.5, "Peak hold settings",
on page 71.
Remote command: 
n.a.

REFRESH
Selects the update rate for the result display, see Section 6.6, "Refresh settings",
on page 72.
Remote command: 
n.a.

6.2  Voltage settings

Access:

1. Press the [ACQ] key on the front panel.

2. Press the "Voltage" softkey.

Figure 6-13: Voltage softkey menu

How to: see "To configure the voltage and current parameters" on page 61.

Voltage settings
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Settings

AUTORANGE................................................................................................................67
RANGE......................................................................................................................... 67
CREST FACT................................................................................................................67
INVERT......................................................................................................................... 67

AUTORANGE
Starts the automatic adjustment of the voltage range.
Remote command: 
CHANnel[:ACQuisition]:VOLTage:RANGe:AUTO on page 203

RANGE
If AUTORANGE = OFF, selects the voltage range manually. The available range set-
tings depend on the selected crest factor, see "CREST FACT" on page 67.
Table 6-1: Available voltage range settings

Crest factor 1 Crest factor 3 Crest factor 6

15 V 5 V 2.5 V

45 V 15 V 7.5 V

90 V 30 V 15 V

180 V 60 V 30 V

450 V 150 V 75 V

900 V 300 V 150 V

1.8 kV 600 V 300 V

Remote command: 
CHANnel[:ACQuisition]:VOLTage:RANGe on page 203

CREST FACT
Selects the crest factor for the voltage measurement.
Available settings: "1", "3", "6".
Remote command: 
CHANnel[:ACQuisition]:VOLTage:CFACtor on page 203

INVERT
Inverts the sign of the voltage reading.
This setting is necessary for certain test setups, see Section 4, "Measurement setups",
on page 48.
Remote command: 
CHANnel[:ACQuisition]:VOLTage:INVert on page 203

Voltage settings
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6.3  Current settings

Access:

1. Press the [ACQ] key on the front panel.

2. Press the "Current" softkey.

Figure 6-14: Current softkey menu

How to: see "To configure the voltage and current parameters" on page 61.

Settings

AUTORANGE................................................................................................................68
RANGE......................................................................................................................... 68
CREST FACT................................................................................................................69
INVERT......................................................................................................................... 69

AUTORANGE
Activates the automatic adjustment of the current range.
Remote command: 
CHANnel[:ACQuisition]:CURRent:RANGe:AUTO on page 200

RANGE
If AUTORANGE = OFF, selects the current range manually. The available range set-
tings depend on the selected crest factor, see "CREST FACT" on page 69.
Table 6-2: Available current range settings

Crest factor 1 Crest factor 3 Crest factor 6

15 mA 5 mA 2.5 mA

30 mA 10 mA 5 mA

60 mA 20 mA 10 mA

150 mA 50 mA 25 mA

300 mA 100 mA 50 mA

Current settings
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Crest factor 1 Crest factor 3 Crest factor 6

600 mA 200 mA 100 mA

1.5 A 500 mA 250 mA

3 A 1 A 500 mA

6 A 2 A 1 A

15 A 5 A 2.5 A

30 A 10 A 5 A

60 A 20 A 10 A

Remote command: 
CHANnel[:ACQuisition]:CURRent:RANGe on page 200

CREST FACT
Selects the crest factor for the current measurement.
Available settings: "1", "3", "6".
Remote command: 
CHANnel[:ACQuisition]:CURRent:CFACtor on page 199

INVERT
Turns the sign of the current reading.
This setting is necessary for certain test setups, e.g. Section 4.1, "Voltage-based mea-
surement", on page 50.
Remote command: 
CHANnel[:ACQuisition]:CURRent:INVert on page 199

6.4  Acquisition mode settings

Access:

1. Press the [ACQ] key on the front panel.

Acquisition mode settings
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2. Press the "Mode" softkey.

Figure 6-15: Acquisition mode softkey menu

The acquisition mode softkey menu enables you to select the acquisition parame-
ter, and to configure the frequency synchronization and filters.

Settings

Mode............................................................................................................................. 70
PLL SRC....................................................................................................................... 70
FREQ FILTER............................................................................................................... 70
DIG. FILTER..................................................................................................................71
BWL 1KHZ.................................................................................................................... 71

Mode
Selects the data acquisition mode.
"DC" Sets the mode to measure synchronized to 100 ms display update

rate.
"AC" Sets the mode to measure synchronized to a voltage or current

period.
To set the synchronization frequency, see "PLL SRC" on page 70).

"AUTO" Sets the acquisition mode for the incoming signal automatically.
"EXT" Sets the acquisition mode for measuring an externally applied signal.

The measurement requires synchronization with the external signal.
Remote command: 
CHANnel[:ACQuisition]:MODE on page 201

PLL SRC
Selects the signal source for the synchronization frequency in acquisition MODE AC.
See "Frequency source" on page 61.
Remote command: 
CHANnel[:ACQuisition]:MODE[:AC]:PLL on page 201

FREQ FILTER
Enables the frequency filter.
See "Filter" on page 60.

Acquisition mode settings
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Remote command: 
CHANnel[:ACQuisition]:MODE[:FILTer]:FREQuency on page 202

DIG. FILTER
Enables the digital filter.
See "Filter" on page 60.
Remote command: 
CHANnel[:ACQuisition]:MODE[:FILTer]:DIGital on page 202

BWL 1KHZ
Enables the 1 kHz low-pass filter.
See "Filter" on page 60.
Remote command: 
CHANnel[:ACQuisition]:MODE[:FILTer]:ANALog on page 201

6.5  Peak hold settings

The "PEAK HOLD" function acquires and displays the maximum peak values over all
measurement traces, providing a reliable measured value for the evaluation of the con-
nected load. It displays the readings until a new measurement starts, or you reset or
deactivate the function.

If the R&S NPA indicates "OL", i.e. the value exceeds the maximum, you can reset the
display. The setting does not affect the data acquisition.

Access:

1. Press the [ACQ] key on the front panel.

2. Select the "Peak Hold" softkey.

Figure 6-16: Peak hold softkey menu

The softkey menu enables you to activate the function and reset the peak values.

How to: see "To enable the peak hold function and set the display update" on page 63.

Activate
Starts peak hold monitoring.
Remote command: 
CHANnel[:ACQuisition]:PEAKhold:ACTivate on page 202

Peak hold settings
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Reset
Resets the peak hold values.
Remote command: 
CHANnel[:ACQuisition]:PEAKhold:RESet on page 202

6.6  Refresh settings

Refresh determines the update rate of the measured values displayed in numeric dis-
play mode. The R&S NPA continuously updates the display either fast, indicating the
current readings, or at a slow rate, indicating the average values of the last 10 read-
ings.

Access:

1. Press the [ACQ] key on the front panel.

2. Select the "REFRESH" softkey.

Figure 6-17: Data acquisition refresh softkey

How to: see "To enable the peak hold function and set the display update" on page 63.

REFRESH
Selects the update rate for the result display.
Fast Refreshes the display 10 times per second, indicating the currently

measured values.
Slow Reduces the refresh rate to 1 update per second and displays the

average values of the last 10 readings. The display in slow refresh
rate does not affect the data acquisition.

Remote command: 
n.a.

Refresh settings
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7  Measurement modes
When a measurement is activated, the R&S NPA measures continuously and updates
the display in regular intervals. Depending on the selected view and measurement
mode, the display provides the corresponding results either numerically, or graphically.

The following sections describe the measurement modes and views of the R&S NPA,
and explain the corresponding parameters regarding the corresponding remote control
commands.

7.1  Integrator

The R&S NPA derives the integrator values WHP, WHM, AHP and AHP based on the
measured values. Using this function, you can measure the energy consumption of
electronic devices with fluctuating power consumption. WHP and AHP represent the
positive power and current, and WHM, AHM the corresponding negative values. WH
and AH correspond to the sum of the positive and negative parts of watt-hours and
ampere-hours.

Example: Measuring the energy consumption of a battery
A battery that is charged with 4 Ah and discharged with 1 Ah.

Figure 7-1: Example of integrator output values

Result: AH = AHP - AHM = 4.0005 Ah - 1.0008 Ah =2.9997 Ah, as shown on the
screen.

Access:

1. Press the [MEAS] key on the front panel.

Integrator
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2. Press the "Integrator" softkey.

Figure 7-2: Integrator softkey menu

The softkey menu contains basic parameters for configuring integrator measure-
ments.

The remote commands required to define these settings are described in Sec-
tion 13.11, "INTegrator subsystem", on page 225.

To select the parameters for display

The following instructions refer to the example above, e.g., to select the integration
time, and the watt-hour / ampere-hour parameters, see Example "Measuring the
energy consumption of a battery" on page 73.

1. To select the measurement page, press, e.g., the "1" softkey.

Figure 7-3: Display of 10 parameters

The screen display toggles to the window indicating 10 parameter fields.

2. Press the [rotary knob].

Integrator
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Figure 7-4: Parameter selection enabled

Usually, the first parameter field on the screen changes in edit mode, indicated by
the orange frame.

3. Select the parameter field you want to assign a parameter with the rotary knob or
the arrow keys.

4. Press the [rotary knob].

5. In the parameter list, select e.g., "TIME" with the rotary knob.

Figure 7-5: Parameter selection

6. Press the rotary knob to confirm the selection.

7. Repeat step 2 to step 6 until you have assigned the WH, WHP, WHM, AH, AHP
and AHM parameters to the screen.

To configure an integrator measurement in manual mode

The following example shows how to configure an integrator measurement manually:

1. Configure a measurement page as described in "To select the parameters for dis-
play" on page 74.

2. To access the integrator softkey menu, select [MEAS] > "Integrator".

3. In the integrator softkey menu, press the "MODE" softkey.

Integrator
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Figure 7-6: Integrator mode selection

4. Select "Manual" using the rotary knob.

5. Press the [RANGE SW.] softkey.

6. Select "Allowed" to allow range switching.

Figure 7-7: Range switching selection

7. Select "ACTIVATE" > "On".

8. Start the measurement with the [START/STOP] key on the front panel, or the "Start
Stop" softkey.

Figure 7-8: Start/Stop softkey

The R&S NPA measures the energy use of the DUT and records the readings. The
status bar shows the integration time.

9. To stop the measurement, press the [START/STOP] (toggle function).

10. To reset the readings, press the [RESET] key.

Figure 7-9: Integrator reset softkey

Integrator
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To configure the integrator mode span

The following example shows how to configure an integrator measurement in span
mode:

1. Configure a measurement page as described in "To select the parameters for dis-
play" on page 74.

2. To access the integrator softkey menu, select [MEAS] > "Integrator"

3. In the integrator softkey menu, press the "MODE" softkey.

4. Select "Span" using the rotary knob.

Figure 7-10: Integrator mode span

5. Press the "Start Time" softkey.

Figure 7-11: Start time in span mode

6. You have two options to set the start time:

a) To set a specific time, proceed the same way as described in "To set date and
time of the instrument internal clock" on page 30

b) To start the measurement immediately, press the "Set to curr. time" softkey.

Figure 7-12: Current time softkey

7. Press the "Duration" softkey.

Figure 7-13: Duration softkey

8. Set the measurement time interval with the corresponding softkeys and the rotary
knob.

Figure 7-14: Duration interval setting

Integrator
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a) Press the "Hour" softkey to enable edit mode.
b) Set how many hours you want to measure with the rotary knob.
c) Press the rotary knob to confirm the setting.
d) Set the duration for minutes and seconds the same way.

9. Press the  key to return to the integrator softkey menu.

10. Select "ACTIVATE" > "On" to start the measurement.

Figure 7-15: Start measurement

The measurement starts at the set time and stops when the duration time has
elapsed.

To configure integrator mode duration

The following example shows how to configure an integrator measurement in duration
mode:

1. Configure a measurement page as described in "To select the parameters for dis-
play" on page 74.

2. To access the integrator softkey menu, select [MEAS] > "Integrator"

3. In the integrator softkey menu, press the "MODE" softkey.

4. Select "Duration" using the rotary knob.

Figure 7-16: Integrator mode duration

5. Press the "Duration" softkey to set the duration time interval.

Figure 7-17: Duration softkey

6. Proceed as described in step 8.

7. Press the  key to return to the integrator softkey menu.

8. Select "ACTIVATE" > "On".

Figure 7-18: Start measurement

9. Start the measurement with the [START/STOP] key on the front panel, or the "Start
Stop" softkey.

Integrator
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The R&S NPA measures the energy use of the DUT and records the readings. The
status bar shows the integration time.

The measurement starts at the set time and stops when the duration time has
elapsed.

To configure an external integrator mode

The following example shows how to configure an externally triggered integrator mea-
surement.

1. Assign an external trigger signal at the DIGITAL IN connector.

2. Configure a measurement page as described in "To select the parameters for dis-
play" on page 74.

3. To access the integrator softkey menu, select [MEAS] > "Integrator"

4. In the integrator softkey menu, press the "MODE" softkey.

5. Select "Extern" using the rotary knob.

Figure 7-19: Integrator mode extern

6. Select "ACTIVATE" > "On".

The measurement starts triggered by the high pulse of the external signal, and
stops when the signal switches to a low level.

Settings

Activate......................................................................................................................... 79
Mode............................................................................................................................. 79
Start Stop...................................................................................................................... 80
Reset.............................................................................................................................80
Start Time......................................................................................................................80

└ Set to curr. time...............................................................................................80
└ Set Date & Time..............................................................................................81

Duration.........................................................................................................................81
RANGE SW...................................................................................................................81

Activate
Starts the integrator measurement.
Depending on the operating mode, the integrator is a precondition for starting a mea-
surement.
Remote command: 
INTegrator[:STATe] on page 229

Mode
Selects the integrator mode.

Integrator
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The R&S NPA starts the measurement depending on the selected mode, and when
you Activate the integrator.
"Manual" Starts the integrator measurement manually triggered with Start Stop.

To stop the measurement, press the "START/STOP" softkey again
(toggle function).

"Span" Measures within a defined time interval, set with "Start Time"
on page 80 and "Duration" on page 81.
Integration measurement starts at the set start time. It stops after the
time span has elapsed.

"Duration" Measures within a defined time span.
To set the time period, see "Duration" on page 81.
Integration measurement starts immediately with ACTIVATE > On. It
stops after the time span has elapsed.

"Extern" Triggers the measurement with an external pulse signal.
To assign the signal, use the external BNC connector (DIGITAL IN).
Integration measurement starts with a "high" pulse of the digital sig-
nal. The measurement stops when the external signal is "low".

Remote command: 
INTegrator:MODE on page 228

Start Stop
Starts and stops the integration measurement in the integrator Mode > Manual.
Remote command: 
INTegrator:STARt on page 228
INTegrator:STOP on page 229

Reset
Resets the integration time and values when you have executed the integration mea-
surement manually, i.e. in integrator Mode > Manual or Mode > Extern.
The R&S NPA indicates the integration time in the status line of the display.
Remote command: 
INTegrator:RESet on page 228

Start Time
Opens the softkey menu with time setting parameter for integrator Mode > Span.
Remote command: 
INTegrator:STIMe on page 229

Set to curr. time ← Start Time
Uses the time stamp of the instrument internal date and time for the integration mea-
surement Mode > Span.
To adjust the internal data and time setting, see Section 11.3.2, "Date and time",
on page 159.
Remote command: 
INTegrator:STIMe on page 229

Integrator
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Set Date & Time ← Start Time
Opens the "Set Date & Time" function to configure a date and time stamp in the inte-
grator Mode > Span.
How to: see Section 3.1.12, "Configuring the initial instrument settings", on page 30.
Remote command: 
INTegrator:STIMe on page 229

Duration
Opens the softkey menu with time setting parameters for integrator Mode > Span or
Mode > Duration.
The maximum duration is 96 hours.

"HOUR" Sets number of hours.
"MIN" Sets the minutes.
"SEC" Sets the seconds.
Remote command: 
INTegrator:DURation on page 227

RANGE SW.
Sets the state for range switching during the integrator measurement.
"Allowed" Enables range switching.

The R&S NPA does not record any value during the switching time.

"Blocked" Blocks range switching.
Remote command: 
n.a.

7.2  Data logging

The logging function enables you to record the measurement data. You can save the
readings on the internal memory of the R&S NPA or on an externally connected USB
flash drive. The function provides the file formats .csv or .txt, with user-definable file
name.

Aspects on the logging function:
● The R&S NPA does not support external USB hard drives (or USB extensions).

We recommend that you use USB flash drives with FAT/FAT32 formatting (4 Gbyte
max.). The instrument recognizes the USB device automatically.

● The maximum logging duration is 96 hours ("DURATION").
● When running, the instrument indicates a green "LOG" label in the status bar.

When disabled, the label color is white.

Access:

1. Press the [MEAS] key on the front panel.

Data logging
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2. In the measurement softkey menu, press the "Logging" softkey.

Figure 7-20: Logging softkey menu

The softkey menu contains basic parameters for setting the logging mode, and pro-
vides access to file management parameters.

To select the measurement parameters

1. Select the parameters that you want to record as described in "To select parame-
ters different from default display" on page 116.

2. To start the measurement, see "To start the measurement" on page 38.

To configure the file storage settings

E.g., configure the storage location, file name and file format:

1. Press the [MEAS] key.

2. Press the "LOGGING" softkey.

3. Press the "Storage" softkey.

Figure 7-21: Logging storage softkey

The R&S NPA opens a softkey menu where you can define the file name and stor-
age location.

Data logging
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Figure 7-22: Storage softkey menu

4. Select "STORAGE" to open the dialog for managing the memory location.
In the "TARGET DIRECTORY" dialog, you can create, define or delete directories
as known from common file managers.

Figure 7-23: Storage settings

Tip: Managing the directories is only available for the external memory.

5. Plug in a USB memory stick, if you want to save the logging data in the external
memory.

6. Select the memory location, e.g. "Front".

7. Press the "Change directory" softkey, to navigate to the target directory (toggle
function).

8. To create a directory, press the "Create directory" softkey.
A standard editor opens to assign a directory name.

a) Enter the directory name using the rotary knob.
b) Confirm with "Accept".
c) Use the rotary knob to select the new created target directory.

9. Press the "Remove directory" if you want to delete a subdirectory.
Proceed the same way as decribed for creating a directory.

10. Select the "FILE NAME" softkey.

11. Enter the file name by selecting the digits with the rotary knob.

Data logging
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12. Press the rotary knob to confirm each digit.

Note: The length of the file name is limited to 8 digits.

13. When completed, select "Accept" to confirm your entry.

14. Press the  key to return to the "Logging" softkey menu.

To configure data logging

Prepare data acquisition and configure the data logging parameters:

1. Connect a USB device to the USB connector on the front, see "USB A"
on page 35.

2. Press the [MEAS] key.

3. In the measurement softkey menu, press the "LOGGING" softkey.

4. Select the "LOG PAGE" softkey to enable edit mode.

Figure 7-24: Logging page softkey

The R&S NPA opens a

Figure 7-25: Logging page selection

5. Select the page with the measurement parameters you want to record.

6. Select "INTERVAL" to determine the time period.

Figure 7-26: Logging interval softkey

'The R&S NPA opens a selection list with the available time interval settings.

Data logging
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Figure 7-27: Logging interval selection

7. Select the corresponding time with the rotary knob.

8. On page 2 of the softkey menu, select the data logging mode.

Figure 7-28: Logging mode softkey

9. Depending on the selected mode, the softkey menu varies and displays the setting
parameters required to configure the selected mode.

Example: If you have selected "MODE > Span", you must configure the start time
and duration of the time span.
How to: proceed as also described for measurement mode Section 7.1, "Integra-
tor", on page 73.

To configure the data format

Configure the measurement readings in the data log file:

1. Press the [MEAS] key.

2. In the measurement menu, select the "LOGGING" softkey.

3. On page 2 of the softkey menu, select "CSV".

4. Set the field and line separators for the format of the file content.

5. When completed, press the [MEAS] key.

Note: As "CSV" is a general function for all data formats, it leads you to the general
settings of the instrument. Therefore, the  key returns to the next higher menu
level of the general settings.
To continue with data logging, open the function again with the [MEAS] key and the
"Logging" softkey.

To start data recording

► Select "ACTIVATE" > "On".

Data logging
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Figure 7-29: Start logging

To stop data recording

There are several options that stop the data logging function:

► Select "ACTIVATE" > "Off".

Figure 7-30: Stop logging

Stops data logging at any time, independently of the set mode.

● Data logging mode "Duration" stops data recording when the time span has
elapsed.

● Data logging mode "Span" stops data recording when the time span has
elapsed.

● Data logging mode "MODE > Count" stops recording when the number of mea-
surement readings is reached.

Figure 7-31: Logging mode count

● Data logging mode "Unlimited" records data continuously until you stop it man-
ually. It aborts automatically when the memory size is reached.

Figure 7-32: Logging mode unlimited

7.2.1  Data logging settings

The "Logging" softkey menu enables you to configure the main parameter settings for
data logging.

Access:

1. Press the [MEAS] key on the front panel.

2. In the measurement softkey menu, press the "Logging" softkey.

Data logging
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The remote commands required to define these settings are described in Sec-
tion 13.12, "LOG subsystem", on page 230.

How to: "To configure data logging" on page 84

Settings

ACTIVATE..................................................................................................................... 87
Storage..........................................................................................................................87
LOG PAGE....................................................................................................................87
INTERVAL.....................................................................................................................87
Page 1|2 / Page 2|2.......................................................................................................87
MODE........................................................................................................................... 87
COUNT......................................................................................................................... 88
Duration.........................................................................................................................88
Start Time......................................................................................................................88

└ Set to curr. time...............................................................................................88
└ Set Date & Time..............................................................................................89

ACTIVATE
Starts data acquisition and saving of the readings.
Remote command: 
LOG[:STATe] on page 234

Storage
Opens the storage settings menu, see Section 7.2.2, "Storage settings", on page 89.
Remote command: 
n.a.

LOG PAGE
Selects the measurement readings page for recording.
You can configure and arrange the parameters of a measurement readings page indi-
vidually.
How to: Section 8.1, "Numeric view", on page 115.
Remote command: 
LOG:PAGE on page 233

INTERVAL
Selects the time period for data logging.
The parameter interval specifies the time between the recorded measurement values.
Remote command: 
LOG:INTerval on page 233

Page 1|2 / Page 2|2
The "Page 1|2" softkey toggles between the pages of the "Logging" softkey menu.

MODE
Selects a logging mode.

Data logging
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"Unlimited" Records data continuously, without a time limit.
Data logging starts immediately with Activate > On.
The amount of recorded data is limited by the size of the storage
memory.

"Count" Records a defined number of measurement readings.
To determine the number, see "COUNT" on page 88.
Data logging starts immediately with Activate > On. It stops when the
number of readings is reached.

"Duration" Records measurement readings within a defined time span.
To set the time period, see "Duration" on page 88.
Data logging starts immediately with Activate > On. It stops after the
time span has elapsed.

"Span" Records measurement readings from a certain start time for a defined
time span.
To set the parameter, see "Start Time" on page 88.
Data recording starts at the start time and with Activate > On. It stops
automatically after the time span has elapsed.

Remote command: 
LOG:MODE on page 233

COUNT
Sets the number of measurement readings for data logging Mode > Count.
Remote command: 
LOG:COUNt on page 232

Duration
Opens the softkey menu with time setting parameters for data logging Mode > Duration
or Mode > Span.
The maximum logging duration is 96 hours.

"HOUR" Sets number of hours.
"MIN" Sets the minutes.
"SEC" Sets the seconds.
Remote command: 
LOG:DURation on page 232

Start Time
Opens the softkey menu with time setting parameter for data logging Mode > Span or
Mode > Duration.
Remote command: 
LOG:STIMe on page 234

Set to curr. time ← Start Time
Uses the time stamp of the instrument internal date and time for data logging Mode >
Span.
To adjust the internal data and time setting, see Section 11.3.2, "Date and time",
on page 159.

Data logging
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Remote command: 
LOG:STIMe on page 234

Set Date & Time ← Start Time
Opens the "Set Date & Time" function to configure a date and time stamp for the recor-
ded data in logging Mode > Span.
How to: see Section 3.1.12, "Configuring the initial instrument settings", on page 30.
Remote command: 
LOG:STIMe on page 234

7.2.2  Storage settings

In the "Storage" softkey menu, you can select the memory location and assign the file
name for data logging files.

Access:

1. Press the [MEAS] key on the front panel.

2. In the measurement menu, select the "LOGGING" softkey.

3. Press the "Storage" softkey.

The remote command required to set filename, path and storage location is LOG:
FNAMe on page 232.

How to: "To configure the file storage settings" on page 82

Settings

STORAGE.....................................................................................................................89
└ Change directory.............................................................................................89
└ Create directory.............................................................................................. 90
└ Remove directory............................................................................................90
└ Accept.............................................................................................................90

Filename....................................................................................................................... 90
Browser......................................................................................................................... 90

STORAGE
Selects the memory drive.
"Internal" Saves the file in the internal memory.
"Front" Saves the data to an external USB memory device.

The connector is on the front.

Change directory ← STORAGE
Navigates between the available directories one level up or down, starting from the
currently selected directory.
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Create directory ← STORAGE
Opens a keypad for entering the directory name.

Remove directory ← STORAGE
Deletes a directory from the memory device.
The R&S NPA prompts you to confirm the action.

Accept ← STORAGE
Confirms the settings and returns to the "STORAGE" softkey menu.

Filename
Opens a keypad for entering the file name.

Browser
Opens a keypad for entering the file name.
How to: "Entering alphanumeric data" on page 46.

7.2.3  File format settings

The "CSV" softkey provides access to the standard "CSV" softkey menu. In the CSV
menu, you can define the table separators and decimal floating points for data.

Access:

1. Press the [MEAS] key on the front panel.

2. In the measurement menu, press the "LOGGING" softkey.

3. Press the "PAGE 1|2" softkey.

4. Press the "CSV" softkey.

Figure 7-33: CSV softkey

The instrument opens a softkey menu with the data format settings, described in
Section 11.3.7, "CSV", on page 165.

7.2.4  Evaluating logged data

For the analysis of the measurement results, you can use any spreadsheet program
that supports *.csv or .txt file format and graphical representation also.

For details on the file format, see Section 11.3.7, "CSV", on page 165.

This section deals with a recorded measurement example. It shows the contents of the
log file, describes how to load the file into a program and how to represent the data
when using the Microsoft®EXCEL application.

Data logging
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Example: Data format of a data logging file
The content in the log starts with meta data, which contains a unique identifier of the
instrument, information on date, and measuring and duration, and the settings of the
measurement. The following character string lists the measurement parameter names
and the corresponding measured values, separated by customizable separators.
#Device;NPA701
#Device Name;PM
#Format;LOG
#Date;2020-01-01
#Version;00.021-02.430-03.730
#Serial No.;012345678
#Mode;Count
#Logging Interval[s];1.000
#Specified Logging Count;1800
#Specified Logging Time[s];-----
#Start Time;04:49:33
#Stop Time;04:49:37
#Actual Count;4 

URMS[V];IRMS[A];P[W];FU[Hz];EMPTY;EMPTY;S[VA];Q[var];LAMBDA[];UTHD[%];Timestamp
231.27E+00;45.0E-03;6.63E+00;50.0E+00;nan;nan;10.38E+00;7.98E+00;639E-03;2E+00;
04:49:33:000
231.38E+00;45.0E-03;6.64E+00;50.0E+00;nan;nan;10.38E+00;7.98E+00;639E-03;2E+00;
04:49:34:000
231.35E+00;45.0E-03;6.63E+00;50.0E+00;nan;nan;10.38E+00;7.98E+00;639E-03;2E+00;
04:49:35:000
231.38E+00;44.9E-03;6.63E+00;50.0E+00;nan;nan;10.38E+00;7.99E+00;639E-03;2E+00;
04:49:36:000

If a log file contains empty cells, denoted with "nan" (not a number), consider the infor-
mation provided in Section 11.3.7, "CSV", on page 165.

To import the log file to Microsoft®EXCEL

You can open the file in the application and convert the text format to a table format. As
Microsoft®EXCEL is a common PC application, we assume basic knowledge of han-
dling. The description shows only briefly how to set the separators to generate a table
from the measured values.

1. Connect the USB memory device to the PC.

2. Open the application.

3. In the "Data" tab, select "From text".

4. Select the *.csv log file.

5. Confirm with "Import".

The "Text import Wizard" opens leading you through the steps to be taken.

Data logging



Measurement modesR&S®NPA

92User Manual 1179.1664.02 ─ 05

6. Follow the instructions of the wizard.

When completed, you can adjust the formatting of the table as required and use
the graphical options of the application for analyzing and evaluating the measure-
ment series.

Figure 7-34: Graphical log file analysis

7.3  Limit

Instrument models R&S NPA501(-G) and R&S NPA701(-G) only

The limit measurement function allows you to define limit values for up to six parame-
ters. The available parameters are listed in Table 7-1. You can select up to 6 parame-
ters individually, and determine the minimum and maximum limit for each selected
parameter.
Table 7-1: List of parameters that can be limited

Parameter Description (unit)

P Active power (mW)

S Apparent power (VA)

Q Reactive power (var)

LAMBDA Power factor (λ)

PHI Phase shift (φ)

FU Frequency value for the voltage (Hz)

FI Frequency value for the current (Hz)

FPLL Phase locked loop synchronization frequency (Hz)

Urms Root mean square voltage (V)

UAVG Average voltage (V)

Irms: Root mean square current (mA)

IAVG Average current (mA)

Limit
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Parameter Description (unit)

UTHD Total harmonic distortion voltage (%)

ITHD Total harmonic distortion current (%)

Access:

1. Press the [MEAS] key on the front panel.

2. Press the "Limit" softkey.

Figure 7-35: Limit softkey menu

The remote commands required to define these settings are described in Section 13.5,
"CHANnel:LIMit subsystem", on page 213.

How to: "To configure the limits for parameters" on page 93

To configure the limits for parameters

E.g., select the Urms parameter, set the maximum and minimum values and enable the
limitation:

1. Press the [MEAS] key.

2. Press the "Limit" softkey.

3. In the limit softkey menu, press the "LIMIT" softkey to enable edit mode.

Figure 7-36: Limit softkey

4. Select, e.g., the 1st parameter you want to configure the limits for with the rotary
knob, e.g. "1".

5. Press the "SOURCE" softkey.

Limit
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Figure 7-37: Limit source settings

6. Select the parameter by turning rotary knob, e.g. select "Urms".

7. Confirm the selection by pressing the rotary knob.

8. Press the "HIGH" softkey.

Figure 7-38: Upper limit softkey

9. Turn the rotary knob to set the upper limit value.
Alternatively, you can enter the value, using the keypad:

a) Press the [SHIFT] key.
b) Enter the value with the numeric keys of the keypad.

While entering the digits, the R&S NPA displays a softkey menu for selecting
the unit, e.g., mV and V for voltage setting.

c) Press the corresponding unit softkey to confirm the setting.

10. Press the "LOW" softkey.

Figure 7-39: Lower limit softkey

11. Proceed the same way as described in step 9 to set the lower limit value.

12. Repeat step 5 to step 9 to determine the limit values of all other parameters.

13. Select the corresponding limit parameters for display as described in "To configure
the numeric view" on page 116.

14. Select "ACTIVATE" > "On".

Example of a measurement including limits display.

Limit
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Figure 7-40: Limit measurement readings

The R&S NPA shows the limit check result of the selected parameter in %, and the
limit ranging from -100% to 100% in a bar graph.

Settings

LIMIT............................................................................................................................. 95
ACTIVATE..................................................................................................................... 95
SOURCE.......................................................................................................................95
HIGH............................................................................................................................. 95
LOW.............................................................................................................................. 95

LIMIT
Selects the position number to assign a parameter and its limits.
Available settings: "1...6"
Remote command: 
n.a.

ACTIVATE
Turns on limitation for assigned parameters.
Remote command: 
CHANnel:LIMit<n>[:STATe] on page 216

SOURCE
Selects the measurement parameter for limitation.
See Table 7-1 for information on the available parameters.
Remote command: 
CHANnel:LIMit<n>:SOURce on page 216

HIGH
Sets the upper limit (maximum value) for the parameter selected with SOURCE.
Remote command: 
CHANnel:LIMit<n>:HIGH on page 215

LOW
Sets the lower limit (minimum value) for the parameter selected with SOURCE.

Limit
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Remote command: 
CHANnel:LIMit<n>:LOW on page 215

7.4  Standards

Instrument model R&S NPA701(-G) only

With standard measurements, the R&S NPA measures according to the measuring
and calculation methods specified in the standards, and the required accuracy auto-
matically.

Access:

1. Press the [MEAS] key on the front panel.

2. Press the "Standards" softkey.

Figure 7-41: Measurement standard softkey

Figure 7-42: Measurement standard softkey menu

The R&S NPA701(-G) does not support remote control in standard measurement
mode.

To configure a standard measurement

The verification wizard guides you through the steps to be taken for configuring a stan-
dard measurement.

► NOTICE! Risk of measurement deviations. The integrator function can falsify the
compliance test.
To achieve correct measurement results, make sure that you have turned off the
integrator function.

How to:
● Section 7.5, "Measuring power consumption with the R&S NPA701", on page 98
● Section 7.6, "Measuring current harmonics with the R&S NPA701", on page 107

Standards
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Settings

Standards......................................................................................................................97
REGION........................................................................................................................ 97
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POWER.........................................................................................................................98
CLASS.......................................................................................................................... 98
CREST FACT................................................................................................................98
RANGE......................................................................................................................... 98
PATTERN......................................................................................................................98
CYCLE.......................................................................................................................... 98

Standards
Selects the measurement standard.
"EN 50564" Standard for measuring the power consumption of electronic devices

in standby mode.
"IEC 62301" Standard for measuring the power consumption in extended standby

mode.
"IEC 61000-3-2"

Standard for measuring the harmonic current for EMC and CE appro-
val of electronic devices.

Remote command: 
n.a.

REGION
Selects the region you are testing for.
You can select from a list of provided regions or set a user defined. Selecting one of
the provided regions automatically sets the corresponding mains voltage and fre-
quency.
"Europe", "China", "AU & NZ"

Select the regions Europe, China or Australia and New Zealand.
"USA & CA", "E. Japan", "W. Japan"

(EN 50564 and IEC 62301 only)
Selects the regions United States of America and Canada, east
Japan or west Japan.

"Customize" User-defined region setting.
Remote command: 
n.a.

VOLTAGE
Sets nominal mains voltage.
Remote command: 
n.a.

FREQUENCY
Sets regional mains frequency.

Standards
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Remote command: 
n.a.

POWER
Sets the power consumption of the DUT. The R&S NPA uses this value to calculate the
limits.
Applies to harmonic current measurements according to IEC 6100-3-2 Standard.
Remote command: 
n.a.

CLASS
Selects electromagnetic compatibility class of the DUT.
Applies to harmonic current measurements according to IEC 6100-3-2 Standard.
Remote command: 
n.a.

CREST FACT
Selects the crest factor for the current measurement.
Available settings: "1", "3", "6"
Remote command: 
n.a.

RANGE
Selects the current range. The available range settings depend on the selected
CREST FACT, see Table 6-2.
Remote command: 
n.a.

PATTERN
Selects the consumption pattern.
"Non-Cyclic" Constant or irregular current consumption.
"Cyclic" Repeating current consumption in time intervals.
Remote command: 
n.a.

CYCLE
Sets the duration of the consumption pattern for PATTERN > Cyclic.
Remote command: 
n.a.

7.5  Measuring power consumption with the R&S NPA701

This measurement example requires an instrument of model R&S NPA701(-G) Compli-
ance Tester to meet the requirements of the standards.

Measuring power consumption with the R&S NPA701
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The measurement method refers to a standardized power measurement according to
IEC62301 and EN50564. It enables you to analyze the standby power consumption of
a DUT. The R&S NPA executes the measurement according to the measuring and cal-
culation methods specified in the standards, and the required accuracy automatically.

To configure a standardized power measurement

The verification wizard guides you through the steps to be taken for configuring a stan-
dard measurement.

1. NOTICE! Risk of measurement deviations. The integrator function can falsify the
compliance test.
To achieve correct measurement results, make sure that you have turned off the
integrator function.

2. Press the [MEAS] key on the front panel.

3. In the measurement menu, press the "Standards" softkey.

4. Select the standard, e.g. "IEC 62301".

5. Select the "REGION" softkey to set the mains voltage of your country.

Figure 7-43: Standard measurement region selection

6. Select the region by turning the rotary knob, e.g. select "Europe".

The R&S NPA provides the country-specific mains values, but you can set the val-
ues also manually.

7. Press the rotary knob to confirm the selection.

The R&S NPA displays the nominal voltage and frequency parameters of the
selected region. If necessary, select the corresponding parameter softkey to adjust
a parameter individually.

8. Select "Proceed" to continue.

The R&S NPA displays the menu for setting the current parameters.

Measuring power consumption with the R&S NPA701
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Figure 7-44: Standard measurement current parameters selection

9. Select the crest factor
Proceed the same way to set the crest factor and the expected RMS current range.
This specific measurement requires the maximum values.

a) Select the crest factor.

Figure 7-45: Standard measurement crest factor selection

b) Select the current range.

10. When completed, continue with "Proceed".

If known, you can select the type of current consumption in the next steps.
Note: A correctly selected consumption type speeds up the measurement. If the
setting does not match, the R&S NPA recognizes the deviating behavior, but still
measures correctly.

Measuring power consumption with the R&S NPA701
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11. If applicable, select the consumption pattern, e.g. "PATTERN" > "Cyclic" .

Figure 7-46: Standard measurement consumption pattern selection

Note: Use "Cyclic" for periodically repeating consumption patterns only. For all
other cases, select "Non Cyclic" .

12. For cyclic consumption pattern, select the "CYCLE" softkey to set the time interval
of the cycle.
The "Set Duration" dialog with a time entry field (defined in <hour>:<minute>:<sec-
ond>) opens.
The step shows how to set the parameters with the keypad:

a) Press the [◀] arrow key to enable, e.g. the <minute> entry field.
b) Press the [SHIFT] key.
c) Enter the value with the numeric keys of the keypad.
d) Confirm with [ENTER].
e) Repeat the steps for completing the duration entry.

As an alternative, you can use the navigation controls to select the entry field, set
the values and confirm your setting.

13. Select "Proceed" to continue.

The configuration is completed. The wizard displays the connection to the
R&S NPA-Zx test adapter graphically.

Figure 7-47: Standard measurement cabling

14. Check the test setup to make sure that the connections are correct.

Measuring power consumption with the R&S NPA701
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Section 3.1.10, "Connecting a device under test (DUT)", on page 27 describes,
how to connect the R&S NPA-Zx test adapter and the DUT in detail.

15. Continue with "Proceed".

The R&S NPA displays the configuration.

Figure 7-48: Standard measurement configuration completed

When you have completed the configuration and checked the test setup, you can
start the measurement, see "To start the measurement" on page 102.

To start the measurement

1. Select the "Start" softkey.

The R&S NPA constantly monitors and records all parameters automatically. Dur-
ing the measurement, the status display shows all values and their range of varia-
tion.

2. Wait until the measurement is completed.

Figure 7-49: Standard measurement running

Measuring power consumption with the R&S NPA701
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The R&S NPA displays the readings during the measurement.

Figure 7-50: Standard measurement finished

When completed, the display shows the measured values and value ranges, and
confirms that the measurement was successful. If deviations occur, the message
"Measurement not successful" confirms that there have been deviations. The
R&S NPA highlights the corresponding values in different color.

To repeat or complete the measurement

You can terminate a measurement, or continue a stopped one.

1. To repeat the measurement, press the "Restart" softkey.

2. To terminate the measurement and change the measurement mode:

a) Press the [VIEW] key.
b) Select, e.g. the "Numeric" softkey, to close the previous measurement mode.

To save and evaluate measurement results

You can save the test report to an external USB memory device, e.g. for analyzing and
evaluating the measurement.

The USB connector is on the front panel.

To save the test report:

1. Plug in a USB memory stick.

2. Press the "Proceed" softkey.

3. Select "Save HTML".

Measuring power consumption with the R&S NPA701
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The R&S NPA creates a generic file name and saves the test report on the memory
device with the extension *.html.

4. Press the "FINISH" softkey to finalize the measurement.

To view and customize the report of the compliance test

To view the test report, you can use any web browser that supports Java.

1. Open the *.html in the web browser.

Measuring power consumption with the R&S NPA701
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Figure 7-51: Compliance test report

When opened, you can edit specific entry fields of the report manually.

2. Select "EDIT" to enable edit mode.

Figure 7-52: Customized entry fields

In edit mode, the test report highlights the editable entry fields.

Measuring power consumption with the R&S NPA701
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3. Enter, e.g. the customer name, laboratory, type of the device under test, or informa-
tion in the notes panel at the end of the page.

4. Select "Edit" to exit the edit mode.

The R&S NPA saves the modifications in the *html file automatically.

To fill in customer-specific information automatically

As a specific feature, you have the option of filling in the fields "Customer", "Device
Under Test" and the "Test Lab" automatically.

Prerequisite is that you create text files with the predefined file names Customer.txt,
Lab.txt and Dut.txt before you start the standard measurement. You can add any
labeling you want in these text files.

1. Open a standard text file application to create text files for the fields you want to fill
in automatically.

a) Enter, e.g. the Customer designation.
b) Save the file with the file name Customer.txt.

Figure 7-53: Test report example customized content

c) Proceed the same way to create the Dut.txt and Lab.txt files accordingly.

2. Save the files on the USB stick.

3. Plug in the USB stick at the front panel.

Figure 7-54: Test report example file on USB stick

4. Configure and start the standardardized power measurement, as described under:
● "To configure a standardized power measurement" on page 99
● "To start the measurement" on page 102

5. When finished, save the test report, see "To save and evaluate measurement
results" on page 103

The R&S NPA701(-G) assigns the texts you entered into the test report automati-
cally, see also Figure 7-52.

Measuring power consumption with the R&S NPA701
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6. View the html file in a web browser.

The instrument then provides the customized entries in all following test reports.

7.6  Measuring current harmonics with the R&S NPA701

This measurement example requires an instrument of model R&S NPA701(-G) Compli-
ance Tester to meet the requirements of the standards.

The measurement method refers to a standardized measurement of harmonic current
emissions according to IEC61000-3-2. It enables you to analyze harmonics in the cur-
rent consumption of a DUT. The R&S NPA executes the measurement according to the
measuring and calculation methods specified in the standards and the required accu-
racy automatically.

The measurement of current harmonics requires an extremely low-distortion supply
voltage. Due to other loads, the power grid usually does not meet the requirements of
the standard. A special low-distortion grid simulation is required.
The measurement of the current harmonics fails, if the requirements of the standard
are not met. The R&S NPA displays the notification "Voltage harmonics out of specifi-
cation". You can analyze the voltage harmonics in detail using the harmonics view of
the R&S NPA, see Section 8.2, "Harmonics view", on page 117.

To configure a standardized current harmonics measurement

The verification wizard guides you through the steps to be taken for configuring the
measurement.

1. NOTICE! Risk of measurement deviations. The integrator function can falsify the
compliance test.
To achieve correct measurement results, make sure that you have turned off the
integrator function.

2. Press the [MEAS] key on the front panel.

3. In the measurement menu, press the "Standards" softkey.

4. Select "IEC 61000-3-2".

5. Select the "REGION" softkey to set the mains voltage of your country.

Measuring current harmonics with the R&S NPA701
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Figure 7-55: Standard measurement region selection

6. Select the region by turning the rotary knob, e.g. select "Europe".

The R&S NPA provides the country-specific mains values, but you can set the val-
ues also manually.

7. Press the rotary knob to confirm the selection.

The R&S NPA displays the nominal voltage and frequency parameters of the
selected region. If necessary, select the corresponding parameter softkey to adjust
a parameter individually.

8. Select "Proceed" to continue.
The R&S NPA displays the menu for selecting the equipment class.

Figure 7-56: Standard measurement equipment class selection

9. Select the equipment class.
● Class B comprises portable tools and non-professional arc welding equipment.
● Class C comprises lighting equipment.
● Class D comprises personal computers and personal computer monitors, tele-

vision receivers, and refrigerators and freezers with one or more variable-
speed drives to control compressor motors.

● Class A comprises all other equipment, for example other household applian-
ces, vacuum cleaners, high pressure cleaners, non-portable tools, independent
phase control dimmers, audio equipment and professional luminaires for stage
lighting and studios.

Measuring current harmonics with the R&S NPA701
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10. Continue with "Proceed".

Figure 7-57: Standard measurement current parameters softkey menu

The R&S NPA displays the dialog for setting the current parameters.

11. Proceed the same way to set the crest factor and the expected RMS current range.
This specific measurement requires the maximum values.

a) Select the crest factor.

Figure 7-58: Standard measurement crest factor selection

b) Select the current range.

Figure 7-59: Standard measurement current range selection

12. When completed, continue with "Proceed".

Measuring current harmonics with the R&S NPA701
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If known, you can select the type of current consumption in the next steps.
Note: A correctly selected consumption type speeds up the measurement. If the
setting does not match, the R&S NPA recognizes the deviating behavior, but still
measures correctly.

13. If applicable, select the consumption pattern, e.g. "PATTERN" > "Cyclic".

Figure 7-60: Standard measurement consumption pattern selection

Note: Use "Cyclic" for periodically repeating consumption patterns only. For all
other cases, select "Non Cyclic" .

14. For cyclic consumption pattern, select the "CYCLE" softkey to set the time interval
of the cycle.
The "Set Duration" dialog with a time entry field (defined in <hour>:<minute>:<sec-
ond>) opens.
The step shows how to set the parameters with the keypad:

a) Press the [◀] arrow key to enable, e.g. the <minute> entry field.
b) Press the [SHIFT] key.
c) Enter the value with the numeric keys of the keypad.
d) Confirm with [ENTER].
e) Repeat the steps for completing the duration entry.

As an alternative, you can use the navigation controls to select the entry field, set
the values and confirm your setting.

15. Select "Proceed" to continue.

The configuration is completed. The wizard displays the connection to the
R&S NPA-Zx test adapter graphically.

Measuring current harmonics with the R&S NPA701
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Figure 7-61: Standard measurement cabling

16. Check the test setup to make sure that the connections are correct.

Section 3.1.10, "Connecting a device under test (DUT)", on page 27 describes,
how to connect the R&S NPA-Zx test adapter and the DUT in detail.

17. Continue with "Proceed".

The R&S NPA displays the configuration.

Figure 7-62: Standard measurement configuration completed

When you have completed the configuration and checked the test setup, you can
start the measurement, see "To start the measurement" on page 111.

To start the measurement

1. Select the "Start" softkey.

The R&S NPA constantly monitors and records all parameters automatically. Dur-
ing the measurement, the status display shows all values and their range of varia-
tion.

2. Wait until the measurement is completed.

Measuring current harmonics with the R&S NPA701
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Figure 7-63: Standard measurement running

The R&S NPA displays the readings during the measurement.

Figure 7-64: Standard measurement finished

When completed, the display shows the measured values and value ranges, and
confirms that the measurement was successful. If deviations occur, the message
"Measurement not successful" confirms that there have been deviations. The
R&S NPA highlights the corresponding values in different color.

To repeat or complete the measurement

You can terminate a measurement, or continue a stopped one.

1. To repeat the measurement, press the "Restart" softkey.

2. To terminate the measurement and change the measurement mode:

a) Press the [VIEW] key.
b) Select, e.g. the "Numeric" softkey, to close the previous measurement mode.

To save and evaluate measurement results

You can save the test report to an external USB memory device, e.g. for analyzing and
evaluating the measurement.

The USB connector is on the front panel.

Measuring current harmonics with the R&S NPA701
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To save the test report:

1. Plug in a USB memory stick.

2. Press the "Proceed" softkey.

3. Select "Save HTML".

The R&S NPA creates a generic file name and saves the test report on the memory
device with the extension *.html.

4. Press the "FINISH" softkey to finalize the measurement.

For information on customizing the measurement report manually or automatically, see
"To view and customize the report of the compliance test" on page 104 and "To fill in
customer-specific information automatically" on page 106.

Measuring current harmonics with the R&S NPA701
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8  Display modes
The instruments of the R&S NPA power analyzers indicate the measurement results in
numeric mode by default. In addition, the R&S NPA501(-G) and R&S NPA701(-G)
instruments provide several graphical display modes. Each display mode covers spe-
cific display parameters you can configure according to your application.

The display modes are based on the continuously measured values. Using these val-
ues, the instrument calculates and derives the non-measurable parameters for the
graphical and tabular displays.

Access:

1. Press the [VIEW] key on the front panel.

Figure 8-1: View softkey menu

In the view menu, you can select the display mode.

Note: The available display modes depend on the instrument model, see Overview
of supported display modes.
For R&S NPA101 instruments, pressing the [VIEW] key switches between the four
pages (toggle function).

2. Select a view in the softkey menu.

If available, the softkey leads you to the corresponding setting parameters for con-
figuring the measurement result display.
Remote command:
VIEW on page 248

Table 8-1: Overview of supported display modes

Instrument model Numeric Harmonics Waveform Trendchart Inrush

R&S NPA101 x - - - -

R&S NPA501(-G) x x x x x

R&S NPA701(-G) x x x x x
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To leave the display mode

The  softkey does not close the view. To return to default (numeric) view:

1. Press the [VIEW] key on the front.

2. Select display mode "NUMERIC".

The remote commands required to define these settings are described in Sec-
tion 13.15, "VIEW subsystem", on page 243.

● Numeric view.........................................................................................................115
● Harmonics view.....................................................................................................117
● Waveform view......................................................................................................121
● Trendchart view.....................................................................................................123
● Inrush view............................................................................................................126
● Evaluating inrush data...........................................................................................132

8.1  Numeric view

The R&S NPA indicates the measurement results numerically.

The numeric view consists of four pages that indicate either 6 or 10 measurement
parameters. For each page, you can customize the measurement assignment sepa-
rately.

Access:

1. Press the [VIEW] key on the front panel.

2. Select the "Numeric" softkey.

Figure 8-2: Numeric view softkey

The R&S NPA displays the measurement results of the selected parameters.

Figure 8-3: Numeric view display with 6 measurement parameters

Numeric view
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To configure the numeric view

In a numeric page, you can toggle between six and 10 measurement parameters:

1. Press the [VIEW] key.

2. Press the "Numeric" softkey.

The numeric display shows the readings of six measurement parameters by
default.

3. Press the "1" softkey to display more parameters.

The screen display toggles to the window indicating 10 parameter fields, listed in
Ten parameters displayed in numeric view (default).

Figure 8-4: Numeric view display with 10 measurement parameters

Table 8-2: Ten parameters displayed in numeric view (default)

Parameter Description (unit) Parameter Description (unit)

"URMS" True RMS voltage (V) "IRMS" True RMS current (mA)

"P" Active power (mW) "FPLL" PLL source frequency (Hz)

"URange" Voltage range bar graph (V) "IRange" Current range bar graph (mA)

"S" Apparent power (W) "Q" Reactive power (VA)

"LAMBDA" Power factor λ "UTHD" Total harmonic distortion U (%)

To select parameters different from default display

The R&S NPA always measures all parameters, regardless of the parameters dis-
played on the screen. You can therefore select and display other parameters individu-
ally, by replacing the parameter in one of the displayed fields.

1. In numeric mode display, press the [rotary knob].

The first parameter field changes into edit mode, indicated by the blue background.

2. Select the field for indicating another parameter using the [rotary knob] or the
[arrow] keys.

3. Press the [rotary knob].

A menu list with all measurement parameters appears.

Numeric view
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4. Select the parameter you want to view.

5. Press the [rotary knob] to confirm the selection.

6. Repeat the steps until you have assigned the specific parameters on the screen
display.

The R&S NPA saves the customized settings in its non-volatile memory and retrieves
these settings at restart. In addition, you can save instrument settings for later reuse.
See Section 10, "File and data management", on page 146.

The remote commands required to define the numeric view settings are described in
Section 13.15, "VIEW subsystem", on page 243.

How to: "To configure the numeric view" on page 116

Settings

1, 2, 3, 4.......................................................................................................................117

1, 2, 3, 4
Selects the measurement page.
Using the rotary knob, you can select a cell within the display and assign the parame-
ter for display.
Remote command: 
VIEW:NUMeric[:SHOW] on page 251
VIEW:NUMeric:PAGE<n>:CELL<m>:FUNCtion on page 250
VIEW:NUMeric:PAGE<n>:SIZE on page 250

8.2  Harmonics view

Displays the magnitudes of the harmonics as a bar graph or in a table.

In the harmonics view, the R&S NPA calculates the RMS value and phase angle of the
harmonics using the FFT (Fast Fourier Transformation) method. It considers up to
50 harmonics (up to a maximum of 100 kHz), and displays their voltage level and cur-
rent level in a bar graph or in a table. This view represents the voltage and current val-
ues of the harmonics in percent or as absolute values.

The R&S NPA calculates the FTT continuously. Therefore, changes to the settings dur-
ing measurement and calculation only affect the display.

Access:

1. Press the [VIEW] key on the front panel.

2. Select the "Harmonics" softkey.

Harmonics view
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Figure 8-5: Harmonics view softkey

Figure 8-6: Harmonics view logarithmic display

The R&S NPA shows the voltage levels as blue bars in the diagram, and the cur-
rent levels in red. The yellow triangle (cursor) at the bottom of the diagram provides
navigation to select specific harmonics for evaluation, see "To select a specific har-
monic" on page 119. The logarithmic display of the harmonics enables you to
detect even the smallest signal details.

The remote commands required to define the harmonics view settings are described in
Section 13.15, "VIEW subsystem", on page 243.

How to: To configure the harmonics view

To configure the harmonics view

E.g., configure the current and voltage magnitudes of all harmonics, displayed as a bar
graph:

1. Press the [VIEW] key.

2. Press the "Harmonics" softkey.

Figure 8-7: Harmonics view softkey menu

3. In the harmonics softkey menu, select "Bar" using the "VIEW SELECT" softkey.

Harmonics view



Display modesR&S®NPA

119User Manual 1179.1664.02 ─ 05

4. Press the "SOURCE" softkey repeatedly until you have selected both, "U" and "I"
(toggle function).

5. Press the "NUMBER" softkey.

6. Set the number of harmonics included in FTT calculation by turning rotary knob,
e.g. set "10".

7. Select the scaling factor using the "SCALING" softkey, e.g. "%".

8. Select the harmonics included in FTT calculation. E.g., select the "SUBSET" soft-
key repeatedly until you have enabled both, "Even" and "Odd" (toggle function).

To select a specific harmonic

1. Configure the measurement, as described above.

2. Press the  key to fold down the harmonics softkey menu to a small menu bar.

The display mode remains active, and the measurement window displays the
results in full screen. The triangle at the bottom of the diagram appears, and the
navigation controls light up.

3. Select a harmonic by turning the rotary knob, e.g. the fifth harmonic.

Figure 8-8: Harmonics selection with rotary control knob

The R&S NPA highlights the selected bar, and indicates the measurement values
in the status bar.

To switch the display between bar graph and table

E.g., switch to tabular display:

1. In the harmonics softkey menu, select the "VIEW SELECT" softkey to enable
"Tab".

Harmonics view
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Figure 8-9: Harmonics view tabular display

The table shows the magnitude and phase of the selected parameters of the har-
monics.

2. To select a row for evaluating a specific harmonic, use the rotary knob.

3. To view further values, configure the corresponding parameters for display in the
softkey menu.

The remote commands required to define the harmonics view settings are described in
Section 13.15, "VIEW subsystem", on page 243.

How to: "To configure the harmonics view" on page 118

Settings

VIEW SELECT............................................................................................................ 120
SOURCE.....................................................................................................................120
NUMBER.....................................................................................................................121
SCALING.................................................................................................................... 121
SUBSET......................................................................................................................121

VIEW SELECT
Selects the harmonics display.
"Bar" Displays the amplitudes of the harmonics in a bar graph.
"Table" Lists the magnitude and phase shifts of the measured voltage and

current values in a table.
Remote command: 
VIEW:HARMonics:VIEW on page 249

SOURCE
Selects the parameter to be visualized in a bar graph.
You can select either voltage, current or both parameters.
Note: This setting only applies to the bar graph. The table view always displays both,
the voltage and the current values.
How to: see To configure the harmonics view > step 4
"U" Shows voltage harmonics in the bar graph.

Harmonics view
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"I" Shows current harmonics in the bar graph.
Remote command: 
VIEW:HARMonics:SOURce on page 248

NUMBER
Sets the number of harmonics to be shown in the bar graph and the table view. You
can select 5 to 50 harmonics for display.
Remote command: 
VIEW:HARMonics:NUMber on page 248

SCALING
Selects the scaling for the display of harmonics relative to the fundamental wave.
Depending on the selected view, the display of voltage and current refers to the har-
monics magnitudes in bar graph view, and to the numeric values in table view.
To select the view, see VIEW SELECT.
"Abs" Displays absolute values of the measured current and voltage.
"%" Displays the current and voltage values in percent.
Remote command: 
VIEW:HARMonics:SCALing on page 248

SUBSET
Selects the display of either the even, the odd or all harmonics in the selected range.
The setting applies to both, the bar graph and the table view.
Remote command: 
VIEW:HARMonics:SUBSET on page 249

8.3  Waveform view

In waveform view, the R&S NPA displays the voltage, current and power data simulta-
neously as traces on the screen. Triggered by a hardware signal (FPLL), the R&S NPA
automatically scales the diagram on the time axis to fit to a single signal cycle on the
screen. You can select the waveform parameters, and statistical values for display.

Access:

1. Press the [VIEW] key on the front panel.

2. Press the "Waveform" softkey.

Waveform view
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Figure 8-10: Waveform view softkey

Figure 8-11: Waveform view display

The R&S NPA displays the voltage trace in blue, the current in red and the power
in green. In the lower left corner, the graph shows the resolution of the vertical axis
used for voltage, current and power. The upper right corner shows the voltage and
measurement readings, the lower left corner shows the power readings and the
frequency of the FPLL signal.

To configure the waveform view

In the waveform view, you can show or hide the traces individually and retrieve statisti-
cal values of the measurement results. Initially, the display of all parameters is
enabled.

1. In the waveform softkey menu, press the  key to fold out the menu.

The expanded menu provides on and off switches for voltage, current and power
display, and switches to show or hide statistics for the power and FPLL source fre-
quency.

2. Press one of the softkeys "VOLTAGE", "CURRENT" or "POWER" to turn off the
display.

The R&S NPA hides the trace, the numerical measurement reading and the vertical
axis resolution of the selected parameter. To turn on the parameter display, press
the softkey again (toggle function).

3. Press the "READOUTS" softkey to turn off and on the statistics display.

4. Press the  key to minimize the waveform softkey menu.

The R&S NPA shows the parameters abbreviated in a small softkey menu. The dis-
play mode remains active, and the measurement window displays the results in full
screen.
The minimized softkey bar enables you to control the settings during the measure-
ment conveniently.

Waveform view
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The remote commands required to define the waveform view settings are described in
Section 13.15, "VIEW subsystem", on page 243.

How to: "To configure the waveform view" on page 122

Settings

VOLTAGE....................................................................................................................123
CURRENT...................................................................................................................123
POWER.......................................................................................................................123
READOUTS................................................................................................................ 123

VOLTAGE
Displays the trace of the voltage in the waveform diagram.
Remote command: 
VIEW:WAVeform:VOLTage on page 252

CURRENT
Displays the trace of the current in the waveform diagram.
Remote command: 
VIEW:WAVeform:CURRent on page 252

POWER
Displays the trace of the power in the waveform diagram.
Remote command: 
VIEW:WAVeform:POWer on page 252

READOUTS
Enables the display of the statistical values Urms, Irms and P, the synchronizing fre-
quency of the FPLL and the scaling of the x axis in the waveform diagram, see Sec-
tion 5.1, "Measurement parameters", on page 55.
Remote command: 
VIEW:WAVeform:READout on page 252

8.4  Trendchart view

In the trendchart view, the R&S NPA displays the traces of two parameters over time.
You can select the source parameters for trendchart display from the available parame-
ters individually, see Table 5-1.

The R&S NPA acquires the measurement values continuously. It clears the data of
both traces automatically when you change the timebase or one of the data sources.

For information on the available parameters in trendchart mode, see Table 5-1.

Access:

1. Press the [VIEW] key on the front panel.

Trendchart view



Display modesR&S®NPA

124User Manual 1179.1664.02 ─ 05

2. Press the "Trendchart" softkey.

Figure 8-12: Trendchart view display

The R&S NPA displays the trace of the first parameter ("SCR 1") in blue and the
second parameter ("SCRC 2") in red. The graph shows the corresponding min/max
values at the top and at the bottom, and indicates the resolution of the time axis in
the lower right corner.

To configure the trendchart view

In the trendchart view, you can show the traces and readings of the selected parame-
ters over time.

1. In the trendchart softkey menu, press the  key to fold out the menu.

The expanded menu provides two sources to select a parameter. You can restart
the measurement, select the time resolution of the vertical axis, and enable one or
both traces for display. Initially, the display of both parameters is enabled.

2. Select the "SRC1" softkey.

The menu list with the available parameters opens.

Figure 8-13: Trendchart view source selection

3. Select a parameter with the rotary knob or by repeatedly pressing the softkey.

4. Repeat step 2 and step 3 for the second source ("SCR2").

5. Press the "TIME BASE" softkey.

Trendchart view
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The menu list with the available time base settings opens.

Figure 8-14: Trendchart view time base selection

6. Select the time resolution for the display with the rotary knob or with the softkey.

7. Press the "CLEAR" softkey to clear all acquired data from the screen.

8. Press the "VISIBLE" softkey repeatedly until you have selected both, "1" and "2"
(toggle function).

9. Press the  key to minimize the trendchart softkey menu.

The R&S NPA shows the parameters abbreviated in a small softkey menu. The dis-
play mode remains active, and the measurement window displays the results in full
screen.

The remote commands required to define the waveform view settings are described in
Section 13.15, "VIEW subsystem", on page 243.

How to: "To configure the trendchart view" on page 124

Settings

SCR1, SCR2............................................................................................................... 125
CLEAR........................................................................................................................ 125
TIME BASE................................................................................................................. 126
VISIBLE.......................................................................................................................126

SCR1, SCR2
Selects the measurement parameter.
Using the rotary knob, you can assign the parameter for display.
Remote command: 
VIEW:TRENdchart:SOURce<n> on page 251

CLEAR
Deletes the trace data on the screen, and starts a new acquisition in the trendchart
view.
Remote command: 
VIEW:TRENdchart:CLEar on page 251

Trendchart view
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TIME BASE
Selects the time resolution for the trendchart view.
Using the rotary knob, you can select the time resolution per division.
Available settings are: "5 s/Div", "10 s/Div", "1 min/Div", "10 min/Div".
Remote command: 
VIEW:TRENdchart:TIMebase on page 251

VISIBLE
Selects the source for display in the trendchart diagram.
You can select either one or both sources.
How to: To configure the trendchart view > step 8.
Remote command: 
VIEW:TRENdchart:VISible<n> on page 252

8.5  Inrush view

In inrush mode, the R&S NPA creates a high-samplerate record for a defined duration.
An internal hardware buffer triggers the acquisition of the event and measures the cur-
rent and voltage trends. Recording of data can be triggered manually, or on certain
events in the voltage or current curve. This function allows you to capture rare events
automatically, e.g., you can use this function to detect and measure inrush currents on
loads.

You can acquire up to 8192 measured values each for current and voltage, save and
export the values for evaluation. At the full sampling rate, the acquisition runs for
16 ms. You can vary the sampling rate to acquire signal sequences of up to a minute,
as shown in Table 8-3.
Table 8-3: Overview of sampling rates

Sampling rate Acquisition time

500.00 kSamples/s 16 ms

250.00 kSamples/s 32 ms

125.00 kSamples/s 65 ms

62.50 kSamples/s 130 ms

31.25 kSamples/s 260 ms

15.63 kSamples/s 520 ms

7.81 kSamples/s 1 s

3.91 kSamples/s 2 s

1.95 kSamples/s 4 s

976.56 samples/s 8 s

488.28 samples/s 16 s

Inrush view
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Sampling rate Acquisition time

244.14 samples/s 33 s

122.07 samples/s 67 s

The trace in the inrush mode shows a single shot of a signal profile, triggered once. It
does not update automatically.

Access:

1. Press the [VIEW] key on the front panel.

2. Press the "Inrush" softkey.

Figure 8-15: Inrush view softkey

Figure 8-16: Inrush view display

The R&S NPA displays the trace of the voltage in blue and the current in red. The
graph shows the corresponding min/max values at the top and at the bottom, and
in the lower right corner, the selected acquisition time.

To configure the inrush view

In the inrush view, you can select the traces for voltage and current for display, set the
acquisition time and the trigger mode:

1. In the inrush softkey menu, press the  key to fold out the menu.

Inrush view
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Figure 8-17: Inrush view softkey menu

The expanded menu provides an on and off switch to activate the measurement.
Softkeys allow you to show or hide the traces and to save the measurement results
in a file. It leads you to a submenu to configure the acquisition time and trigger
mode.

2. Press the "VISIBLE" softkey repeatedly until you have selected both, "U" and "I"
(toggle function).

3. Select the "Settings" softkey.

Figure 8-18: Inrush settings softkey

The inrush settings softkey menu with the provided parameters opens.

4. Select "ACQ TIME".

The menu list of provided acquisition time intervals opens.

Inrush view



Display modesR&S®NPA

129User Manual 1179.1664.02 ─ 05

Figure 8-19: Inrush view acquisition time selection

5. Select the parameter with the rotary knob, e.g. "33s".

6. Select the "TRIGGER" softkey.

Figure 8-20: Inrush view trigger selection

7. Select the trigger mode, e.g. "Voltage" with the rotary knob.

8. Select "Level" to enable edit mode.

Figure 8-21: Inrush view level setting

9. Select the level value with the rotary knob.

10. Press the  key to fold down the inrush softkey menu to a small menu bar.

The display mode remains active, and the measurement window displays the
results in full screen.

11. Press the "ACT" softkey to start the acquisition.

The R&S NPA starts the measurement.

Inrush view
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Figure 8-22: Inrush view acquisition running

For longer acquisition times, a bar indicates the progression of the recorded mea-
surement.

12. Press the "CSV" to save recorded data acquisition.

The instrument creates a generic file name and saves the recorded acquisition
data in *.csv format.

Figure 8-23: Inrush view data saved in csv

The remote commands required to define the waveform view settings are described in
Section 13.15, "VIEW subsystem", on page 243.

How to: "To configure the inrush view" on page 127

Settings

ACTIVATE................................................................................................................... 131
VISIBLE.......................................................................................................................131
Settings....................................................................................................................... 131

└ ACTIVATE.....................................................................................................131
└ ACQ TIME.....................................................................................................131
└ TRIGGER......................................................................................................131
└ SLOPE..........................................................................................................132
└ LEVEL...........................................................................................................132

Export CSV................................................................................................................. 132

Inrush view
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ACTIVATE
"On" starts data acquisition in inrush view.
"Off" aborts a running measurement and discards the recorded data.
Remote command: 
CHANnel[:ACQuisition]:INRush:ACTivate on page 253

VISIBLE
Selects the source for display in the inrush diagram.
You can select either voltage, current or both parameters.
How to: see "To configure the inrush view" on page 127.
Remote command: 
VIEW:INRush:CURRent on page 249
VIEW:INRush:VOLTage on page 250

Settings
Accesses the softkey menu for setting the trigger parameters of the inrush measure-
ment.

ACTIVATE ← Settings
See ACTIVATE. The R&S NPA provides this function also in the inrush settings sub-
menu.

ACQ TIME ← Settings
Selects the time period for inrush measurement.
The time interval defines the duration of one inrush cycle.
Remote command: 
CHANnel[:ACQuisition]:INRush:TIME on page 253

TRIGGER ← Settings
Selects the trigger source for the inrush measurement.
The measurement starts when the configured trigger condition is met and you have
enabled the measurement with ACTIVATE ON.
To configure the trigger condition for voltage or current, set SLOPE and LEVEL.
When a measurement cycle is completed, the instrument sets ACTIVATE OFF auto-
matically.
"Manual" Initiates the inrush measurement manually by pressing the ACTIVATE

softkey.
"Voltage" The voltage trace triggers the measurement when the trigger condi-

tion is met.
"Current" The current trace triggers the measurement when the trigger condi-

tion is met.
Remote command: 
CHANnel[:ACQuisition]:INRush:TRIGger on page 254

Inrush view
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SLOPE ← Settings
Selects the polarity of the active trigger source for the inrush measurement.
"Rising" Triggers the measurement when the trigger signal passes the config-

ured level on a rising slope.
"Falling" Triggers the measurement when the trigger signal passes the config-

ured level on a falling slope.
Remote command: 
CHANnel[:ACQuisition]:INRush:CURRent:SLOPe on page 253
CHANnel[:ACQuisition]:INRush:VOLTage:SLOPe on page 254

LEVEL ← Settings
Sets the threshold value for the trigger signal, either TRIGGER Voltage or TRIGGER
Current.
The measurement is triggered when the signal passes this level. For setting the polar-
ity, see SLOPE.
Remote command: 
CHANnel[:ACQuisition]:INRush:CURRent:LEVel on page 253
CHANnel[:ACQuisition]:INRush:VOLTage:LEVel on page 254

Export CSV
Saves the acquired data to a CSV file. Exporting the file is only possible when you
have connected an external USB device to the instrument.
The R&S NPA assigns the filename automatically, composed of the trace designation
and a time stamp, e.g. IN163443.csv.

To use the measurement results for evaluation, e.g. export the file to a PC application,
see Section 8.6, "Evaluating inrush data", on page 132.
Remote command: 
n.a.

8.6  Evaluating inrush data

For the analysis of the measurement results, you can use any spreadsheet program
that supports *.csv file format and graphical representation also. For details on the
file format, see Section 11.3.7, "CSV", on page 165. The following example shows the
contents of a recorded inrush measurement file.

Example: Content and data format of an inrush measurement file
The content starts with meta data, which contains a unique identifier of the instrument,
information on date, and measuring and duration, and the settings of the measure-
ment. The following character string lists the measurement parameter names and the
corresponding measured values, separated by customizable separators.

#Manufacturer;Rohde&Schwarz
#Device;NPA701-G
#Serial No.;036338276

Evaluating inrush data
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#Version;01.403

#Acquisition time;67.108902
#Trigger;Manual
#Number of points;8192

Time[s];Voltage[V];Current[A]
0;0;9.35662e-06
0.008192;-0.0225271;1.87132e-06
0.016384;0;-1.87132e-06
0.024576;-0.0225271;-9.35662e-06
0.032768;0.0112636;-1.87132e-06
0.04096;0.00563179;3.74265e-06
0.049152;-0.0112636;-1.12279e-05
0.057344;-0.00563179;1.87132e-06
0.065536;-0.0112636;-1.87132e-06
0.073728;0.00563179;1.87132e-06
0.08192;-0.0168954;-7.4853e-06
0.090112;-0.00563179;-5.61397e-06
....

For description on how to load the file and how to represent the data using a PC appli-
cation, see the example for evaluating logging data "To import the log file to Micro-
soft®EXCEL" on page 91.

Evaluating inrush data
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9  External measurement modes
In addition to measurement setups using the measurement input connectors (A, V,
COM, or the sensor IN, COM connectors) on the front panel, the R&S NPA501(-G) and
R&S NPA701(-G) instruments provide analog and digital interfaces on the rear panel.
The two analog and two digital input and output interfaces are intended for signals that
you can assign, e.g., to define limit values, or perform pass/fail sorting.

Example: Validating the voltage of a measured DUT with an oscilloscope
R&S NPA measures the voltage of a connected 230 V DUT.
Settings on the R&S NPA:
● Crest factor: 3
● Measurement range: 300 V
● Analog output mode: "Voltage" (max. deflection of the analog output: +5 V referred

to the measurement input)
Calculation:
Urange = 300 V * 3 = 900 V (maximum measurement range).

Urms = (230 V / 900 V) *5 V = 1.278 V.

Figure 9-1: Example of the analog output signal displayed on an oscilloscope

The oscilloscope shows the sine wave with Urms = 1.278 V and Upp = 3.6 V.
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Access:

► Press the [EXT] key on the front panel.

Figure 9-2: External input and output softkey menu

The softkey menu provides access to the parameters and settings for configuring
the analog and digital input and output signals.

The remote commands required to define these settings are described in Section 13.4,
"CHANnel:EXTernal subsystem", on page 204.

9.1  Analog input and output settings

With the analog input, you can measure an analog input signal and display the read-
ings. The analog output signal enables you, to display the signal for evaluation on a
connected external measurement instrument, e.g. an oscilloscope.

To configure an analog input signal measurement

This example assumes, that the measurement is set up and ready for operation.
Before activating the measurement, select and assign the measurement parameters of
interest for display, e.g. select the analog input value AIN:

1. To select, e.g., the second measurement page, press the "2" softkey.

2. Press the rotary knob to activate the edit mode.

3. Select the field on the measurement page with the [rotary knob] or the arrow keys.

4. Press the rotary knob again to open the parameter list.

5. Select the parameter "AIN".

6. Confirm the selection with the rotary knob.

7. Repeat step 3 to step 6 until you have assigned all parameters for results display
on the screen.

8. Press the [EXT] key.

Analog input and output settings
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9. Press the [Analog In] softkey.

10. Turn on the measurement with "ACTIVATE" > "On".

The R&S NPA displays the analog input signal.

To configure an analog output signal

This example assumes, that the measurement is set up and ready for operation.
Before activating the measurement, select and assign the measurement parameters of
interest for display, e.g. select the voltage, current power and limits:

1. To select, e.g., the third measurement page, press the "3" softkey.

2. Press the rotary knob to activate the edit mode.

3. Select the field on the measurement page with the [rotary knob].

4. Press the rotary knob again to open the parameter list.

5. Select the parameter "URMS" using the [rotary knob] or the arrow keys.

6. Confirm the selection with the rotary knob.

7. Repeat step 3 to step 6 to assign the parameters "IRMS", "P", "S" and "Lim1/2" for
results display on the screen.

8. Press the [EXT] key.

9. Press the [Analog Out] softkey.

10. Turn on the measurement with "ACTIVATE" > "On".

The R&S NPA displays the settings of the analog output signal.

Settings

ACTIVATE................................................................................................................... 136
MODE......................................................................................................................... 136
LIMIT NO.....................................................................................................................137

ACTIVATE
Turns on the measurement of an analog input or output signal.
Remote command: 
CHANnel[:EXTern]:AINPut[:STATe] on page 209

MODE
Selects the analog output mode.
"Voltage" Selects voltage mode for the signal at the output. The voltage of the

output signal corresponds to the voltage at the measurement input
referred to ±5 V.

"Current" Selects current mode for the signal at the output. The current of the
output signal corresponds to the current at the measurement input
referred to ±5 V.

Analog input and output settings
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"Power" Selects power mode for the signal at the output. The output power of
the signal corresponds instantaneous power referred to ±5 V.

"Limit" Selects the limit function as output mode.
The modulation amplitude of the output signal is given in percent
referred to ±5 V.
To select the limit parameters, see Section 7.3, "Limit", on page 92.

Remote command: 
CHANnel[:EXTern]:AINPut[:STATe] on page 209
CHANnel[:EXTern]:AOUTput[:STATe] on page 210

LIMIT NO
Selects the position number to assign a parameter and its limits.
Available settings: "1...6"
Remote command: 
n.a.

9.2  Digital input and output settings

With the digital input, you can measure a digital input signal and display the readings.
The digital output signal allows you to assign a digital signal to the output, e.g. to pro-
vide information with logical true/false information on a parameter with defined limit val-
ues.

To configure a digital input signal measurement

This example assumes, that the measurement is set up and ready for operation.
Before activating the measurement, select and assign the measurement parameters
for display, e.g. select the analog input value DIN:

1. To select, e.g., the first measurement page, press the "1" softkey.

2. Press the rotary knob to activate the edit mode.

3. Select the measurement field with the [rotary knob] or the arrow keys.

4. Press the rotary knob again to open the parameter list.

5. Select the parameter "DIN".

6. Confirm the selection with the rotary knob.

7. Repeat step 3 to step 6 until you have assigned all parameters for results display
on the screen.

8. Press the [EXT] key.

9. Press the [Digital In] softkey.

10. Press the "MODE" softkey.

11. Select the mode, e.g., "State".

Digital input and output settings
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12. Activate inversion with "INVERT" > "On".

13. Turn on the measurement with "ACTIVATE" > "On".

The R&S NPA displays the readings of the digital input signal.

To configure a digital output signal

This instruction example assumes, that the measurement is set up and ready for oper-
ation. Before activating the measurement, select and assign the measurement param-
eters for display, e.g. select the voltage, current, frequency and limits:

1. To select the measurement page, press e.g., the "4" softkey.

2. Press the rotary knob to activate the edit mode.

3. Select the field on the measurement page with the [rotary knob].

4. Press the rotary knob again to open the parameter list.

5. Select the parameter "URMS" using the [rotary knob] or the arrow keys.

6. Confirm the selection with the rotary knob.

7. Repeat step 3 to step 6 to assign, e.g., the parameters "IRMS", "FU", "FPLL" and
"Lim1/2" for results display on the screen.

8. Press the [EXT] key.

9. Press the "Digital Out" softkey.

10. Turn on the measurement with "ACTIVATE" > "On".

ACTIVATE................................................................................................................... 138
MODE (Digital In)........................................................................................................ 138
INVERT (Digital In)......................................................................................................139
MODE (Digital Out)..................................................................................................... 139
LIMIT NO.....................................................................................................................139
INVERT (Digital Out)...................................................................................................139

ACTIVATE
Turns on the measurement of a digital input or output signal.
Remote command: 
CHANnel[:EXTern]:DINPut[:STATe] on page 211
CHANnel[:EXTern]:DOUTput[:STATe] on page 211

MODE (Digital In)
Selects the digital input mode.
"Frequency" Measures the frequency of the incoming digital signal.
"PWM" Measures the ratio of the high to low times of the signal.
"State" Measures the high and low levels of the signal.
Remote command: 
CHANnel[:EXTern]:DINput:MODE on page 210

Digital input and output settings
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INVERT (Digital In)
Turns the sign of the incoming digital signal.
Remote command: 
CHANnel[:EXTern]:DINPut:INVert on page 210

MODE (Digital Out)
Selects the digital output mode.
"Limit" Selects the limit function as output mode.

A high signal level refers to logically true, correspondingly low level
refers to logically false.
To select the limit parameters, see Section 7.3, "Limit", on page 92.

"FPLL" Provides the frequency of the selected source at the digital output.
Remote command: 
CHANnel[:EXTern]:DOUTput:MODE on page 211

LIMIT NO
Selects the position number to assign a parameter and its limits.
Available settings: "1...6"
Remote command: 
n.a.

INVERT (Digital Out)
Turns the sign of the provided digital signal.
Remote command: 
CHANnel[:EXTern]:DOUTput:INVert on page 211

9.3  Sensor settings

Access:

1. Press the [EXT] key on the front panel.

2. In the external menu, select the "Sensor" softkey.

Sensor settings
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Figure 9-3: Sensor softkey

Figure 9-4: Sensor softkey menus for external shunt and external current clamp

The "Sensor" softkey menu contains all parameters required to configure the mea-
surement using an external probe, e.g. the R&S HZC50 or R&S HZC51. Depending
on the selected probe, the available parameters vary.

The remote commands required to define these settings are described in Section 13.4,
"CHANnel:EXTernal subsystem", on page 204.

Settings

ACTIVATE................................................................................................................... 140
RANGE....................................................................................................................... 140
MODE......................................................................................................................... 141
RESISTANCE..............................................................................................................141
RATIO..........................................................................................................................141
USER.......................................................................................................................... 141

ACTIVATE
Starts the sensor measurement.
The function enables the sensor [IN] and [COM] connectors on the front panel. It auto-
matically turns off an active automatic current measurement.
Remote command: 
CHANnel[:EXTern]:SENSor[:STATe] on page 212

RANGE
Selects the maximum measurement range for the voltage measurement.
"100 mV" For measurements with shunts.

"1 V", "4 V" For measurements with current probes.

Remote command: 
CHANnel[:EXTern]:SENSor:RANGe on page 213

Sensor settings
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MODE
Selects the type of the external probe.
"Shunt" For measurements with shunts.
"CLAMP" For measurements with clamp-on current probes.
Remote command: 
CHANnel[:EXTern]:SENSor:MODE on page 212

RESISTANCE
Sets the resistance value for measurements with an external shunt in ohms.
To select the probe, set MODE > Shunt.
How to: see "To configure a measurement with an external shunt" on page 142.
Remote command: 
CHANnel[:EXTern]:SENSor:EXTShunt[:RESistance] on page 212

RATIO
Selects the voltage to current ratio for measurements with current probes in mV/A.
To select the current probe type, set MODE > Clamp.
The ratio determines the amount of voltage the sensor transmits at 1 A applied current.
Based on this value, the R&S NPA calculates all parameters derived from the mea-
sured current and power values automatically.
"1 mV/A", "10 mV/A"

For measurements with the current probes R&S HZC50 or
R&S HZC51.

"User" For measurements with current probes from other manufacturers.
How to: see "To configure a measurement with an external clamp-on
probe" on page 143.

Remote command: 
CHANnel[:EXTern]:SENSor:CCLamp[:RATio] on page 212

USER
Sets the voltage to current ratio for measurements with current probes in mV/A man-
ually.
To select the current probe type, set MODE > Clamp.
To switch to a user-definable setting, select RATIO > User.
How to: see "To configure a measurement with an external clamp-on probe"
on page 143.
Remote command: 
CHANnel[:EXTern]:SENSor:CCLamp[:RATio] on page 212

9.4  Measuring with an external probe or shunt

The external measurements clamp-on probes or shunts require that you select the
optimum measurement range, usually the maximum range referred to peak. I.e. the

Measuring with an external probe or shunt
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appropriate range for measurements with shunts is 100 mV, and 1 V or 4 V with current
clamp-on probes.

The examples assume that you have set up the measurement with an external probe,
as described in Section 4.4, "Connecting an external AC/DC shunt or clamp-on current
probe", on page 53.

To configure a measurement with an external shunt

For measurement setup, see Section 4.4, "Connecting an external AC/DC shunt or
clamp-on current probe", on page 53.

1. Press the [EXT] key on the front panel.

2. In the external softkey menu, press the "Sensor" softkey.

Figure 9-5: Sensor softkey

The sensor softkey menu opens.

Figure 9-6: Sensor softkey menus for shunt of current clamp settings

3. Press the "Mode" softkey.

4. Select "Shunt".

Figure 9-7: Sensor mode shunt selection

Measuring with an external probe or shunt
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The R&S NPA adjust the sensor menu to the parameters required for the measure-
ment with a shunt automatically. I.e. it provides "RESISTANCE" softkey for setting
the resistance of the shunt.

5. Press the "RESISTANCE" softkey to enable edit mode.

Figure 9-8: Sensor mode shunt resistance setting

6. To set the value, use the keypad:

a) Press the [SHIFT] key.
b) Enter the value using the keypad, e.g. set "2".
c) Select the unit with the softkey, e.g. "Ω".

The R&S NPA assigns the setting and returns to the sensor menu automatically.

Based on the shunt resistance, the instrument adjusts the measured current and
power values and calculates all derived parameters.

To configure a measurement with an external clamp-on probe

For measurement setup, see Section 4.4, "Connecting an external AC/DC shunt or
clamp-on current probe", on page 53.

1. Press the [EXT] key on the front panel.

2. Press the "Sensor" softkey.

Figure 9-9: Sensor softkey

3. Select "Mode".

4. Select "Clamp".

Measuring with an external probe or shunt
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Figure 9-10: Sensor mode clamp resistance setting

The R&S NPA adjust the sensor menu to the parameters required for the measure-
ment with a clamp-on probe. I.e. it provides the "RATIO" softkey for setting the con-
version factor.

5. Press the "RATIO" softkey to enable edit mode.

Figure 9-11: Sensor mode clamp ratio selection

6. Select the value, i.e. "1 mV/A".

7. To set a user-defined ratio value, select "User".

Figure 9-12: Sensor mode clamp ratio selection for user-defined settings

a) Press the [SHIFT] key.

Measuring with an external probe or shunt
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b) Enter the value using the keypad, e.g. set "1".
c) Confirm the setting with the "OK" softkey.

The R&S NPA assigns the setting and returns to the sensor menu.

Based on the shunt resistance, the instrument adjusts the measured current and
voltage values and calculates all derived parameters.

To select the parameter display and start an external measurement

1. Select the measurement readings page indicating the voltage and current range,
i.e. the parameters "URange" and "IRange".
How to: "To select parameters different from default display" on page 116.

Figure 9-13: Maximum voltage range of a sensor measurement with an external shunt

2. Start the measurement with "ACTIVATE" > "On".

Note: When the sensor measurement is enabled, the R&S NPA turns off an active
automatic current measurement ("AUTO").
The "ACTIVATE" softkey switches on the sensor inputs "IN" and "COM" on the
instrument front panel (hardware switch).

Figure 9-14: Sensor measurement disables automatic current measurement mode

Measuring with an external probe or shunt
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10  File and data management

10.1  Accessing, retrieving and handling data

Depending on the origin and content, this description distinguishes between the follow-
ing data types:
● Operational data
● Non-operational data

Operational data (data for intended use)

Your instrument uses and creates this data because of its intended use and according
to the settings and configuration you have made. Thus, this data makes up most of the
data that the R&S NPA creates, such as user files that contain user-defined configura-
tions or data, like instrument settings or measurement data.

The R&S NPA saves this data in the configuration file, see Section 10.3, "Save/recall
instrument states", on page 147.

You can access, retrieve and delete user files, see "Types of user data" on page 147.

Non-operational data (usage data)

The R&S NPA generates this data during and through its use. Such data is collected
e.g. for troubleshooting and to help our customer support center find solutions quickly.

The R&S NPA generates this data continuously and in real-time; this data is saved on
the product. The product is not capable of storing this data on a remote server.

The R&S NPA generates the following data:
● Environmental conditions
● Hardware component metadata

This data is stored in the configuration file, see Section 10.3, "Save/recall instrument
states", on page 147.

The R&S NPA displays this data on the screen, see Section 11.3.1, "Device informa-
tion", on page 157.

For additional information on the different memory types of your product and on how to
protect sensitive data, see the "Instrument security procedures" document.

10.2  About the file system

The R&S NPA enables you to save instrument configurations, settings and screen-
shots of the current screen. Depending on the type of data, you can use the internal
memory, or save data to an external USB memory device.

About the file system
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Types of user data

Data files include measurement configurations and records, screenshots and instru-
ment settings.

Depending on the content, user data is roughly categorized in the following data types:
● Settings: instrument settings of a measurement configuration saved for later reuse,

see "To save instrument settings" on page 40.
● Measurement readings: recorded measurement results saved for evaluation, see

Section 7.2, "Data logging", on page 81, and Section 8.5, "Inrush view",
on page 126.

● Screenshots: screen captures of settings or measurement mode windows, see
Section 10.4, "Screenshot", on page 150.

File memory location

The R&S NPA saves user files on the internal memory or, if connected, on a USB
memory stick, but screenshots only on an external USB. With the "File Manager" func-
tions, you can exchange files between the internal and an external memory, provided
you have connected a USB memory stick.

The memory locations on the internal memory are predefined, on an external USB
stick, you can create, define or delete directories as known from common file explor-
ers.

10.3  Save/recall instrument states

With the "Save/Recall" functions you can save a certain instrument configuration in a
file and reload it for later reuse.

Access:

► Press the [SAVE/RECALL] key on the front panel.

Figure 10-1: Save recall softkey menu

The save/recall softkey menu provides access to the system file for saving and
restoring instrument settings.

To save instrument settings

► For information on how to save a current instrument configuration, see Trying out
the instrument > "To save instrument settings" on page 40.

Save/recall instrument states
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To recall instrument settings

To load a settings configuration from a file, proceed the same way:

1. Press the [SAVE/RECALL] key on the front panel.

2. Press the "LOAD" softkey to open the system file manager dialog.

Figure 10-2: Load softkey

3. Select the memory location, e.g. "STORAGE" > "Front".

4. Select the file.

5. Upload the settings file with "Load".

The R&S NPA restores the instrument settings from the file.

To remove an instrument settings file

To remove a settings configuration file, proceed as follows:

1. Press the [SAVE/RECALL] key on the front panel.

2. Select the "Device Settings" softkey.

Figure 10-3: Device settings softkey

3. Select "LOAD" to open the file manager dialog.

4. Select the memory location, e.g. "STORAGE" > "Front".

5. Select the file with the rotary knob.

6. Delete the settings file with "Delete file".

The R&S NPA removes the instrument settings file from the memory. On the exter-
nal USB memory, you can also change or delete directories.

To recall instrument default settings

You can reset all instrument settings to factory default values, without affecting your
specific system settings.

1. Press the [SAVE/RECALL] key on the front panel.

2. Press the "Default settings" softkey.

Save/recall instrument states
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Figure 10-4: Default settings softkey

The R&S NPA resets current instrument settings to factory default.

Save............................................................................................................................ 149
Storage........................................................................................................................149
Filename..................................................................................................................... 149
Comment.....................................................................................................................149
Load............................................................................................................................ 149
Remove directory........................................................................................................ 149
Delete file.................................................................................................................... 149
Default Settings...........................................................................................................149

Save
Saves instrument settings.
Remote command: 
*SAV <Storage> on page 194

Storage
Selects the memory location.

Filename
Assigns the filename to an instrument settings file.

Comment
Sets comment on the filename for device settings.

Load
Restores instrument settings.
Remote command: 
*RCL <Storage> on page 194

Remove directory
Removes selected directory.

Delete file
Deletes selected file.

Default Settings
Resets device settings to factory default.

Save/recall instrument states
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10.4  Screenshot

With the screenshot function, you can capture the image of the current screen and
save it in a graphic file.

Aspects to screenshot files
● File storage location

Saving a screenshot file is only possible on an external USB stick.
● File format

Support formats are *.png (Portable Network Graphic) and *.bmp (Windows Bit-
map).

● File name
You can assign an individual user-defined name, otherwise the R&S NPA assigns a
unique, generic filename by default.

● Color
You can capture the display in the color of the screen, or converted to grayscale.

Access:

► Press and hold the [Save/Recall] key on the front panel.

Figure 10-5: Screenshot softkey menu

To configure screenshots

1. Press and hold the [SAVE/RECALL] key on the front panel.

The R&S NPA opens the screenshot softkey menu.

Note: Saving a screenshot is available only if you have a USB stick connected.

2. Select the "Filename SCR...0001" softkey.

Figure 10-6: Filename softkey

An on-screen keyboard opens.
For screenshots, the R&S NPA assigns the default filename SCRxxxx. "xxxx"
refers to an incremental index starting from "0001".

3. To assign a file name, you have the following options:

Screenshot
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a) To enter an individual file name using the keyboard, see "Entering alphanu-
meric data" on page 46.

b) To assign a generic file name, select the "Default" softkey.
The instrument generates the file name and closes the on-screen keyboard.

4. Select the "Color & Format" softkey.

Figure 10-7: Color format softkey

5. Select the file format for the screenshot file.

Figure 10-8: Screenshot select file format

6. Select the color mode for the screenshot file.

Figure 10-9: Screenshot select file format

7. Select "SAVE" to save the screenshot.

Figure 10-10: Save screenshot softkey

8. Press the  key to return leave the softkey menu.

Screenshot
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To create a screenshot

► Press and hold the [SAVE/RECALL] key.

The instrument confirms the created screenshot.

Figure 10-11: Screenshot saved

After a few seconds, the message closes automatically.

STORAGE...................................................................................................................152
FILENAME.................................................................................................................. 152
Color & Format............................................................................................................152

└ FORMAT....................................................................................................... 152
└ COLOR MODE............................................................................................. 152

SAVE...........................................................................................................................152

STORAGE
USB storage only.

FILENAME
Sets filename for screenshot.

Color & Format
Sets color and format for screenshot.

FORMAT ← Color & Format
Sets format for screenshot.
"BMP" Screenshot is saved as bitmap image file format.
"PNG" Screenshot is saved as portable network graphic format.
Remote command: 
HCOPy:FORMat on page 225

COLOR MODE ← Color & Format
Sets color mode for screenshot.
"Grayscale" Screenshot is saved in black and white color mode.
"Color" Screenshot is saved in the colors of the R&S NPA screen.

SAVE
Saves current display in screenshot.
Function is available only if USB stick is connected.

Screenshot
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Remote command: 
HCOPy:DATA? on page 224
HCOPy:SIZE:X? on page 225
HCOPy:SIZE:Y? on page 225

Screenshot
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11  General instrument settings
The general instrument settings include basic instrument settings and utility services,
regardless of the selected operating mode and measurement.

Access:

1. Press the [SETUP] key on the front panel.

Figure 11-1: Setup softkey menu

2. In the setup softkey menu, select a softkey to access the corresponding submenu.

● Update (firmware)................................................................................................. 154
● Interface................................................................................................................ 157
● Miscellaneous....................................................................................................... 157
● Power up...............................................................................................................168
● Default...................................................................................................................169

11.1  Update (firmware)

The update functionality provides information on the currently installed firmware ver-
sion, including the instrument help. Using the USB interface on the front panel, you can
update the firmware.

We recommend that you use the latest firmware version available on the product page
at www.rohde-schwarz.com/firmware/npa.

Required equipment
● Software:

Firmware update file RS_NPAxxx_Firmware_<version>.zip
● Hardware:

USB memory stick with at least 10 MB free space to save the update file.
The memory stick does not need to be bootable and previous data on the stick is
not affected. During the update procedure, the stick is not modified by the instru-
ment.

Update (firmware)

http://www.rohde-schwarz.com/firmware/npa
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Access:

1. Press the SETUP key on the front panel.

2. In the setup softkey menu, select the "Update" softkey.

Figure 11-2: Firmware update softkey menu

The "Device Firmware" dialog shows the currently installed firmware and enables
you to perform a firmware update. Messages inform you about the progress of the
update.

To update the instrument firmware

1. Download the latest version of the R&S NPA firmware from the Rohde & Schwarz
website.

2. Extract the compressed firmware *.zip file.

3. Copy the extracted file NPAx01.HFU to the root directory of the USB memory stick.

Note: Consider not to change the file name of the firmware, as the firmware update
only works when the file name is NPAx01.HFU. If you have several update files on
the stick in parallel, copying the file does not replace it, but rather rename the file
automatically.

4. Press the [SETUP] key.

5. Select the "Update" softkey.

Figure 11-3: Device firmware dialog

Update (firmware)
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If not yet connected, the instrument prompts you to attach a USB flash drive with
the firmware file.

6. Select the "Firmware" softkey.

7. Connect the USB memory stick to the USB interface on the front panel.

The R&S NPA scans the USB memory stick for firmware file types. If a
NPAx01.HFU file is on the USB stick, the R&S NPA automatically uploads the file
and indicates both, the currently installed and the newly loaded firmware versions,
including the build date. A message confirms the upload and that the checksum of
an internal check is correct.

Figure 11-4: Firmware uploaded

Note: If the new version is more recent than the installed version, the version infor-
mation is displayed in green, for the same or older versions in red.

Figure 11-5: Uploaded firmware is the same or older than the installed version

If the upload failed, see Section 14.2, "Problems during firmware update",
on page 255.

8. NOTICE! Risk of potential damage to the firmware. Disconnecting the power sup-
ply while an update is in progress leads to missing or faulty firmware. Take special
care not to disconnect the power supply while the update is in progress.
Interrupting the power supply during the firmware update can lead to an unusable
instrument which needs to be sent in for maintenance.
Start the update with the "Execute" softkey.

The installation process starts the update of the front controller first, followed by the
update of the interfaces. A progress bar provides information on the current state.

The R&S NPA reboots when the firmware update is completed.

Update (firmware)
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11.2  Interface

The R&S NPA provides several interfaces to establish a remote control connection.

See Section 12, "Network operation and remote control", on page 170, and Sec-
tion 12.2, "Remote access settings", on page 177.

11.3  Miscellaneous

The miscellaneous menu provides access to instrument information and to basic
instrument settings, e.g. to configure date and time, the screen display or CSV file set-
tings. You can individually adjust the settings according to personal preferences and
requirements.

Access:

1. Press the [SETUP] key on the front panel.

2. In the setup menu, press the "Misc" softkey.

Figure 11-6: Miscellaneous softkey menu

11.3.1  Device information

To get an overview on the configuration of your instrument, you can retrieve informa-
tion on the instrument model, its hardware components and interfaces using the device
information function.

Access:

1. Press the [SETUP] key on the front panel.

2. In the setup menu, press the "Misc" softkey.

Miscellaneous
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3. In the miscellaneous menu, select "Device Infos".

Figure 11-7: Instrument information

The "Device Information" window shows the characteristics of the instrument
assemblies. It also indicates the remaining available internal memory.

To return to the previous level

► Press the  key.

In menus, the back key returns to the previous level or folds it down to a small
menu (toggle function).

Settings

Device Information...................................................................................................... 158

Device Information
Displays the main instrument information.
"<instrument model> (<HW ID:xxx)"

Designation of the instrument and its hardware identification number.
"Serial No:" Serial number of the instrument.
"Version" Currently installed firmware version.

How to: see Section 11.1, "Update (firmware)", on page 154
"Build" Version of the firmware package with time stamp.
"Hardware IDs"

Installed hardware modules, software and firmware versions.
"Temperature" Current ambient temperature and operating temperature of the shunt.
"Interface" Information on the set remote control interface, including hardware ID

and software version.
"Available internal memory"

Available amount of memory.
Remote command: 
*IDN? on page 193
SYSTem:VERSion? on page 243

Miscellaneous
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11.3.2  Date and time

Using the "Date & Time" function, you can set the date and time of the internal instru-
ment clock.

During operation, the R&S NPA records the measurement and creates a time stamp
for printed outputs or saved datasets.

Access:

1. Press the [SETUP] key on the front panel.

2. In the setup menu, press the "Misc" softkey.

3. In the miscellaneous menu, select "Date & Time".

Figure 11-8: Date and time setting

The "Date & Time" entry field contains the date and time setting of the operating
system. You can update of modify this setting individually.
The required remote commands are described in Section 13.14, "SYSTem subsys-
tem", on page 237.
How to: see Section 3.1.12, "Configuring the initial instrument settings",
on page 30.

Settings

Date.............................................................................................................................159
Time............................................................................................................................ 159

Date
Sets the date in the format [yyyy.mm.dd].
Remote command: 
SYSTem:DATE on page 239

Time
Sets the time in the format [hh.mm.ss].
Remote command: 
SYSTem:TIME on page 242

11.3.3  Sound

The R&S NPA provides the option for issuing an acoustic signal if there is an error, or
as a control measure.

Miscellaneous
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Access:

1. Press the [SETUP] key on the front panel.

2. In the setup menu, press the "Misc" softkey.

3. In the miscellaneous menu, press the "Sound" softkey.

Figure 11-9: Sound settings

4. Enables the acoustic signals with "CTRL BEEP" and "ERROR BEEP" > "On" (tog-
gle function).

5. Return with the  key.

The required remote commands are described in Section 13.14, "SYSTem subsys-
tem", on page 237.

Settings

Error Beep...................................................................................................................160
CTRL Beep................................................................................................................. 160

Error Beep
Generates an acoustic signal when an error occurs.
"On" Beeps on error.
"Off" No beep.
Remote command: 
SYSTem:BEEPer:STATe on page 239

CTRL Beep
Beeps immediately when the instrument receives a remote control command.
"On" Beeps on received control command.
"Off" No beep.
Remote command: 
SYSTem:BEEPer[:IMMediate] on page 239

11.3.4  Display settings

The R&S NPA enables you to customize the appearance of the screen in brightness
and contrast. You can also adjust the grid intensity for graphical display.

Access:

1. Press the [SETUP] key on the front panel.

Miscellaneous
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2. In the setup menu, select the "Misc" softkey.

3. In the miscellaneous menu, press the "Display" softkey.

Figure 11-10: Display setttings

4. Continue with To customize the screen intensity and To customize the grid inten-
sity, if applicable.

The "Display" dialog contains the softkey menu for configuring the screen bright-
ness and contrast of the screen, and, optionally, the grid for graphical representa-
tion.

To customize the screen intensity

Access:

1. Select [SETUP] > "Misc" > "Display".

2. Select "BLACKLIGHT" to enable edit mode for the parameter.

Figure 11-11: Blacklight key

3. Turn the rotary knob to set the black light percentage.

Decreasing the percentage increases the black light.

4. Proceed the same way to adjust the "CONTRAST" and "BRIGHTNESS" of the
screen display.

To customize the grid intensity

Instrument models R&S NPA501(-G) / R&S NPA701(-G)

Access:

1. Select [SETUP] > "Misc" > "Display".

2. In the display menu, press the "GRID INTENS." softkey to enable edit mode.

3. Turn the rotary knob to set the intensity in percent.

Miscellaneous



General instrument settingsR&S®NPA

162User Manual 1179.1664.02 ─ 05

To return to the previous level

► Press the  key.

In menus, the back key returns to the previous level or folds it down to a small
menu (toggle function).

Settings

Brightness................................................................................................................... 162
Contrast.......................................................................................................................162
Grid Intensity............................................................................................................... 162

Brightness
Sets the brightness of the display in percent.
Range: 10 % to 100 %
Remote command: 
n.a.

Contrast
Sets the contrast of the display in percent.
Range: 10 % to 100 %
Remote command: 
n.a.

Grid Intensity
Sets the intensity of the display for the graphical representation in percent.
Range: 10 % to 100 %
Remote command: 
n.a.

11.3.5  Key brightness

The R&S NPA enables you to customize the brightness of the keys. You can also
determine the fallback time. When this time has expired, the instrument accepts a
changed value and exits the setting dialog automatically.

Access:

1. Press the [SETUP] key on the front panel.

2. Select the "Misc" softkey.

3. Select "PAGE 1|2" to access the second page of the softkey menu.

Miscellaneous
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Figure 11-12: Key settings

4. To set the key brightness, proceed as described in To set the key brightness.

5. To set the fallback time, see To set the fallback time.

To set the key brightness

Access:

1. Select [SETUP] > "Misc" > "PAGE 1/2".

2. Press the "Key" softkey.

3. Press the "KEY BRIGHT." softkey to enable edit mode.

Figure 11-13: Brightness key

4. Turn the rotary knob to set the brightness in percent.

5. To confirm the setting, press the rotary knob.

To set the fallback time

Access:

1. Select [SETUP] > "Misc" > "PAGE 1/2".

2. Press the "Key" softkey.

3. Press the "FALLBACK" softkey to enable edit mode.

Figure 11-14: Fallback key

4. Select the fallback time with the rotary knob.

Miscellaneous
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5. To confirm the settings, press the rotary knob or wait until R&S NPA closes the list
automatically.

To return to the previous level

► Press the  key.

In menus, the back key returns to the previous level or folds it down to a small
menu (toggle function).

Settings

KEY BRIGHT...............................................................................................................164
FALLBACK.................................................................................................................. 164

KEY BRIGHT.
Sets the intensity of the key illumination in percent.
Range: 10 % to 100 %
Remote command: 
n.a.

FALLBACK
Sets the "Key Fallback Time". This parameter determines the time period the instru-
ment waits before it automatically assigns a changed value. If you confirm the setting
manually before the fallback time expires, the setting has no effect.
"5s", "10s", "20s"

Sets the corresponding time period.
"Off" Disables the function.
Remote command: 
n.a.

11.3.6  Device name

Access:

1. Press the SETUP key on the front panel.

2. In the setup menu, press the "Misc" softkey.

3. In the miscellaneous menu, select "Device name".

The R&S NPA opens a keypad to assign a name to the instrument.

To assign a name to the instrument

Access:

1. Select [SETUP] > "Misc" > "Device name".

Miscellaneous
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Figure 11-15: Device name softkey

2. In the "Enter the device name" window, select a character with the rotary knob.

Figure 11-16: Device name

3. Confirm with the "Press [ENTER] to select an element" button.

4. Repeat the steps until you have completed the name.

5. For navigation, use the "CURSOR" softkeys.

6. For corrections, use the "Backspace" and "CLEAR ALL" softkeys.

7. Complete the entry with the "Accept" softkey.

The "Device name" is assigned. The R&S NPA indicates the assigned device name
in the device information window, see Section 11.3.1, "Device information",
on page 157.

Settings

Device name............................................................................................................... 165

Device name
Sets device name.
Remote command: 
n.a.

11.3.7  CSV

The "CSV" softkey provides access to the standard "CSV" softkey menu, see Sec-
tion 11.3.7.2, "CSV settings", on page 166. In this menu, you can define the table sepa-
rators and decimal floating point for the data, saved in standard *.csv or .txt file for-
mat.

Miscellaneous
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11.3.7.1  About CSV

The R&S NPA enables you to record measurement readings and save the data in a file
for subsequent evaluation and validation. Recorded data consists of character strings
that list general metadata, as, e.g., date, device name, etc., the parameter names and
the acquired measurement values.

The standard file formats *.csv or .txt the R&S NPA saves the data, allow you to
use a spreadsheet application program for analysis and evaluation. A spreadsheet pro-
gram displays the data either as numerals and text, or in graphical form.

Consideration on data content depending on the used application

During a measurement, gaps can occur due to high process load, measurement speed
or exceeding file size. It can also occur that a measured parameter was not displayed
caused by configuration or exceeded ranges. The gaps result in empty cells designa-
ted as "nan" (not a number).

Consider, that not all spreadsheet applications can evaluate "nan" as a 0, which leads
to erroneous results, shown in the example.

Figure 11-17: "nan"- with correct and erroneous empty cell evaluation

Therefore, the R&S NPA provides a correction function that fills empty cells with 0.
Consider the capability of the application you use, and set the function correction cor-
respondingly, see "ERROR VAL." on page 167.

11.3.7.2  CSV settings

Access:

1. Press the [SETUP] key on the front panel.

Miscellaneous
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2. In the setup menu, press the "Misc" softkey.

3. In the miscellaneous menu, press the "PAGE 1|2" softkey.

4. Press the "CSV" softkey.

Figure 11-18: CSV softkey

The instrument opens a softkey menu for configuring the data separators in the
*.csv file.

Figure 11-19: CSV softkey menu

Settings

CSV.............................................................................................................................167
FIELD DELIM.............................................................................................................. 167
DEC. SEP....................................................................................................................167
ERROR VAL................................................................................................................167

CSV
Opens the "CSV" softkey menu for setting the data separators.

FIELD DELIM.
Selects the line separator between individual parameters or values.
"Semicolon" Separates the data entries by a semicolon.
"Comma" Uses a comma.
Remote command: 
n.a.

DEC. SEP.
Selects the decimal separator for values.
"Dot" Sets a decimal point.
"Comma" Uses a comma.
Remote command: 
n.a.

ERROR VAL.
Selects whether an empty cell is filled with 0.
"IEE Float" Fills empty cells with 0.

Miscellaneous
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"Empty" Leaves empty cells.
Remote command: 
n.a.

11.4  Power up

The power up function enables you to select the start up behaviour of the instrument in
the event of a power failure.

Access:

1. Press the [SETUP] key on the front panel.

2. In the setup menu, select "Misc" > "Page 1/2".

3. Select "Power up".

Figure 11-20: Power up menu

The R&S NPA opens a selection list for setting the power up behavior of the instru-
ment.

Settings

Power up..................................................................................................................... 168

Power up
Sets the power up mode after accidental loss of AC power.
Last state Default setting. When the AC power supply is restored, the R&S NPA

restarts when it was switched on before the AC power loss. Other-
wise, it switches to standby mode.

On The R&S NPA restarts when AC power is supplied.

Off The R&S NPA switches to standby mode when AC power is supplied.
Remote command: 
n.a.

Power up
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11.5  Default

The R&S NPA resets all the miscellaneous settings to default settings with the excep-
tion of date and time and device name settings.

Access:

1. Press the [SETUP] key on the front panel.

Figure 11-21: Setup softkey menu

2. In the setup softkey menu, select "Default Settings".

Figure 11-22: Default settings softkey

The R&S NPA resets all miscellaneous settings except of the settings date, time
and device name.

The remote commands required to define these settings are described in Section 13.2,
"Common commands", on page 192.

Settings

Default Settings...........................................................................................................169

Default Settings
Resets the miscellaneous settings to default except of date and time and device name.
Remote command: 
*RST on page 194

Default
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12  Network operation and remote control
As an alternative to operating the instrument directly from the front panel, you can
operate the R&S NPA remotely, for example from a controller PC.

The interfaces of the R&S NPA provide flexible access to the instrument. Figure 12-1
shows the possibilities of the physical connection (interfaces) for remote access..

The following descriptions provide information required for operating the R&S NPA
remotely. The information applies to all applications and operating modes supported by
the instrument. Definitions specified in the SCPI standard are not provided.
For basic knowledge on remote control operation and additional information, see the
following documents available from the Rohde & Schwarz website:
● Remote control via SCPI
● 1MA171: How to use Rohde & Schwarz Instruments in MATLAB
● 1SL374: How to communicate with R&S devices using VISA
● Rohde-Schwarz - Remote control examples

Ethernet
Socket

GPIB

USBTMCUSB

LAN

CDC

R&S Instrument

R&S Instrument

R&S Instrument

Controller

Application 
Program

Figure 12-1: Supported remote connections

● Remote control interfaces and protocols...............................................................170
● Remote access settings........................................................................................177
● Connecting the R&S NPA for remote access........................................................184
● Adjusting the interface addresses.........................................................................185
● Starting and stopping remote control.................................................................... 189

12.1  Remote control interfaces and protocols

The R&S NPA comes with the following interfaces for remote control:
● USB TMC and USB VDC interface
● Ethernet (LAN) interface

Remote control interfaces and protocols

http://www.rohde-schwarz.com/rc-via-scpi
http://www.rohde-schwarz.com/appnote/1MA171
http://www.rohde-schwarz.com/appnote/1SL374
https://github.com/Rohde-Schwarz/Examples
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● IEE-488 bus interface (GPIB) (instrument models R&S NPA501-G and
R&S NPA701-G)

You can only communicate with the instrument over one of the available interfaces at a
time.

You need a connection between the R&S NPA and the controller PC. An application
software that supports communication over the used interfaces must be installed on
the controller PC. Table 12-1 gives an overview on the connectivity:

Table 12-1: Remote control interfaces and protocols

Interface Protocols, VISA*) address string and library Remarks

Local area network
(LAN)

● Socket communication (Raw Ethernet, simple
Telnet)
TCPIP::host address[::
LAN device name]::<port>::SOCKET
VISA or socket controller

The LAN connector is on the rear panel of the
instrument.

The interface is based on TCP/IP, see Sec-
tion 12.1.1, "LAN interface", on page 171.

USB ● USBTMC
USB::<vendor ID>::<product ID>::
<serial number>[::INSTR]
VISA

● CDC
(communications device class, corresponds to
VCP (virtual COM port))

The USB B connector is on the front panel.

For a description of the interface, refer to Sec-
tion 12.1.2, "USB interface", on page 173

GPIB (IEC/IEEE Bus
Interface)

(instrument models
R&S NPA501-G),
R&S NPA701-G)

● –
GPIB::<address>[::INSTR] (no secondary
address)
VISA (optional)

The GPIB bus interface according to standard
IEC 625.1/IEEE 488.1 is on the rear panel.

For a description of the interface, see Sec-
tion 12.1.3, "GPIB interface (IEC/IEEE bus
interface)", on page 174.

*) VISA (Virtual Instrument Software Architecture) is a standardized software interface library providing input and output functions to
communicate with instruments. A VISA installation on the controller is a prerequisite for remote control over LAN and USB inter-
face. For remote control over socket communication VISA installation is optional. When using socket communication or the GPIB
interface, VISA installation is optional. For basic information, see Remote control via SCPI.

Rohde & Schwarz provides the standardized I/O software library R&S VISA for down-
load on the Rohde & Schwarz website http://www.rohde-schwarz.com/rsvisa.

● LAN interface........................................................................................................ 171
● USB interface........................................................................................................173
● GPIB interface (IEC/IEEE bus interface)...............................................................174
● Status reporting system........................................................................................ 175

12.1.1  LAN interface

For remote control via a network, the PC and the instrument must be connected over
the LAN interfaces to a common network with TCP/IP network protocol. The instru-
ments are connected with a commercial RJ45 cable, see "Cable selection and electro-
magnetic interference (EMI)" on page 22.

Remote control interfaces and protocols
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The TCP/IP network protocol and the associated network services are preconfigured
on the instrument. Software for instrument control and (for specified protocols only) the
VISA program library must be installed on the controller.

Identifying instruments in a network
If several instruments are connected to the network, each instrument has its own IP
address and associated resource string. The controller identifies these instruments by
the resource string.

12.1.1.1  VISA resource strings

The VISA resource string is required to establish a communication session between
the controller and the instrument in a LAN. The resource string is a unique identifier,
composed of the specific IP address of the instrument and some network and VISA-
specific keywords.

TCPIP::<host address>[::<LAN device name>][::INSTR]

TCPIP = designates the network protocol
host address = designates the IP address or hostname of the instrument
[::LAN device name] = defines the protocol and the instance number of a subinstrument
[::INSTR] = indicates the instrument resource class (optional)

The IP address (host address/computer name) is used by the programs to identify and
control the instrument. It is automatically assigned by the DHCP server the first time
the device is registered on the network.

The R&S NPA indicates the IP address in the "Ethernet Settings" dialog, see Sec-
tion 12.2.2, "Ethernet settings", on page 179, which also provides to adjust the IP
address manually.

Socket communication

TCPIP::<host address>::<port>::SOCKET

TCPIP = designates the network protocol
host address = designates the IP address or hostname of the instrument
port = determines the used port number
SOCKET = indicates the raw network socket resource class

Socket communication requires the specification of the port (commonly referred to as
port number) and of "SOCKET" to complete the VISA resource string with the associ-
ated protocol used.

The registered port for socket communication is port 5025.

Example: 
TCPIP::192.1.2.3::5025::SOCKET

Remote control interfaces and protocols
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To assign the address, see Section 12.4.1, "How to configure the Ethernet settings",
on page 185.

12.1.2  USB interface

For remote control over the USB connection, the PC and the instrument must be con-
nected over the USB B interface.

The USB B connector is on the rear panel of the instrument.

On the controller, you need to install any application for instrument control, for example
the R&S HMExplorer, and if available, a VISA program library. VISA detects and con-
figures the Rohde & Schwarz instrument automatically when the USB connection is
established.

You can communicate with the instrument over the USB TMC class or the CDC class
protocols:
● CDC

(Communications Device Class, also known as VCP virtual COM port) is a protocol
used for emulating serial ports over USB. Using the CDC protocol, you have to
install the USB VCP driver and activate it in the PC device explorer. The driver is
available for download on the Rohde & Schwarz product site at www.rohde-
schwarz.com/driver/npa/. For installation of the driver, you need administrator
rights.
To select the USB class, see Section 12.2.1, "USB settings", on page 178..

● USBTMC
(USB Test & Measurement Class Specification) is a protocol that is built on top of
USB for communication with USB devices, like GPIB. It defines class code informa-
tion of the instrument, that identifies its functionality to load the respective device
driver. Using VISA library, it supports service request, triggers, and other specific
operations, similar to GPIB.
For control, you can use the SCPI terminal function of the R&S HMExplorer soft-
ware. This software also provides logging of measurement values, or graphical dis-
play.

USB resource string

The resource string represents an addressing scheme that is used to establish a com-
munication session with the instrument. It is based on the instrument address and
some instrument- and vendor-specific information.

The USB resource string syntax is as follows:

USB::<vendor ID>::<product ID>::<serial number>[::INSTR]

USB = denotes the used interface
<vendor ID> = is the manufacturer ID for Rohde & Schwarz
<product ID> = is the product identification of the instrument
<serial number> = is the individual serial number on the rear of the instrument
[::INSTR] = indicates the instrument resource class (optional)

Remote control interfaces and protocols
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Example: 
USB::0x0AAD::0x01DD::100001
0x0AAD is the vendor ID for Rohde & Schwarz.
0x01DD is the product ID for the R&S NPA
100001 is the serial number of the particular instrument.

See Section 12.4.3, "How to configure the USB connection", on page 188.

12.1.3  GPIB interface (IEC/IEEE bus interface)

R&S NPA-G models are equipped with a GPIB interface. The GPIB interface is on the
rear panel.

To control the instrument over the GPIB bus interface, the instrument and the controller
must be connected with a GPIB bus cable. A GPIB bus card, the card drivers and the
program libraries for the programming language used must be provided in the control-
ler.

See Remote control via SCPI for additional information on the characteristics, control
commands and messages of the GPIB interface.

GPIB address

The controller addresses the instrument within the GPIB bus channel. GPIB provides
channel addresses from 0 to 30. The GPIB address is preset to 1 (factory-set), but you
can adjust it according to your network environment, see Section 12.2.3, "GPIB set-
tings", on page 182. An instrument preset or setting to default does not affect the GPIB
address.

GPIB:://<channel>[::INSTR]

GPIB = denotes the used interface
<channel address> = the used channel
[::INSTR] = indicates the instrument resource class (optional)

If the VISA implementation supports the GPIB interface, you can optionally define the
VISA Instrument Control Resource (INSTR). It is used to define the basic operations
and attributes for a device, such as reading, writing, or triggering.

Example: 
GPIB::28
28 is the selected GPIB bus channel.

To change the GPIB address, see Section 12.2.3, "GPIB settings", on page 182.

Remote control interfaces and protocols
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12.1.4  Status reporting system

The status reporting system saves all information on the current operating state of the
instrument, and on errors which have occurred. This information is saved in the status
registers and in the error queue. You can query the status of the registers remotely, i.e.
over the USB, GPIB or LAN interfaces with the commands of the Section 13.13, "STA-
Tus subsystem", on page 234.

12.1.4.1  Overview of the R&S NPA status registers

Figure 12-2: Graphical overview of the status registers

Remote control interfaces and protocols
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The following sections describe the instrument-specific bit assignments of the opera-
tion status and the questionable status registers.
For more information, see:
● Remote control via SCPI: provides general information on the status reporting sys-

tem of Rohde & Schwarz instruments. This document also provides information on
the standard event status register and the error queue.

● Section 13.13, "STATus subsystem", on page 234: describes the corresponding
remote control commands of the status register

● SCPI standard documentation for comprehensive information on the standard

12.1.4.2  Instrument-specific status questionable register

This status register contains information on questionable instrument states. Questiona-
ble states occur when the instrument is not operated in compliance with its specifica-
tions.

To read the register, use the commands STATus:QUEStionable:CONDition? and
STATus:QUEStionable[:EVENt]?. The remote commands for the status question-
able register are described in Section 13.13.2, "Status questionable register",
on page 236.
Table 12-2: Assignment of the bits used in the questionable status register

Bit No. Meaning

0 VOLTage
This bit is set when voltage overrange occurs.

1 CURRent
This bit is set when current overrange occurs.

2 to 3 Not used

4 TEMPerature overrange
This bit is set when the temperature is exceeded.

5 FREQuency
This bit is set when frequency overrange occurs.

6 to 7 Not used

8 CALibrating

9 STORage
This bit is set when instrument stores data.

10 OCP
This bit is set when the over current protection is enabled.

11 EXPCalibration
This bit is set when calibration is no longer valid.

12 to 15 Not used

Remote control interfaces and protocols
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See the schematic representation Figure 12-2.

12.1.4.3  Instrument-specific status operation register

The condition part contains information on currently executed actions. The event part
covers information on the actions performed since the last readout of the register.

To read the register, use the query commandsSTATus:OPERation:CONDition?
STATus:OPERation:CONDition? and STATus:OPERation[:EVENt]?. The
remote commands for the status operation register are described in Section 13.13.1,
"Status operation register", on page 235.
Table 12-3: Assignment of the bits used in the operation status register

Bit No. Meaning

0 CALibrating
The bit is set during the calibration phase (for service department only).

1 SETTing

2 RANGing

3 UPDate

4 Not used

5 TRIGger
This bit is set while the instrument is waiting for the trigger.

6 to 7 Not used

8 LIMit

9 INTegrating

10 LOGGing

11 LOCKed
Instrument locked (RWLock)

12 INRush

13 to 15 Not used

See the schematic representation Figure 12-2.

12.2  Remote access settings

The "Interface" softkey menu provides access to the settings that address the instru-
ment, including its specific identification parameters and parameters required for the
corresponding interfaces.

Remote access settings
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Access:

► Select [SETUP] > "Interface".

Figure 12-3: Interface softkey menu

The "Interface" softkey menu enables you to access the setting parameters of the
interfaces the instrument is equipped with.

To return to the previous level

► Press the  key.

In menus, the back key returns to the previous level or folds it down to a small
menu (toggle function).

12.2.1  USB settings

For remote control over USB, you can address the R&S NPA over the USB TMC class,
or the virtual COM port CDC (VCP).

Access:

1. Select [SETUP] > "Interface".

2. In the "Interface" softkey menu, select the "USB" port, e.g. "USB VCP".

Figure 12-4: USB VCP selection

The R&S NPA enables the connection and indicates the selected USB interface in
the status bar.

Remote access settings
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Figure 12-5: USB VCP display on the screeen

Note: If you have establishecd the USB connection to the controller PC, and the
required VCP driver or the VISA interface library is missing, the PC operating sys-
tem displays the "Found New Hardware Wizard" notification.

If a connection between PC and the instrument has been established and no R&S NPA
USB-VCP driver is installed, the PC operating system displays a "Found New Hard-
ware" wizard. In this case, the R&S NPA USB-VCP driver must be installed.

See Section 12.1.2, "USB interface", on page 173.

How to: Section 12.4.3, "How to configure the USB connection", on page 188

USB VCP.................................................................................................................... 179
USB TMC.................................................................................................................... 179

USB VCP
Selects the CDC protocol for controlling the R&S NPA remotely over the USB VCP
interface.

USB TMC
Selects the USBTMC connection for remote control over USB.
Remote command: 
SYSTem:INTerface on page 241

12.2.2  Ethernet settings

Access:

1. Select [SETUP] > "Interface".

2. In the "interface" softkey menu, select the "Ethernet" softkey.

Figure 12-6: Ethernet selection

Remote access settings
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3. Select the "Parameter" softkey to access the "Ethernet Settings" dialog.

Figure 12-7: Ethernet settings dialog

In this dialog, you can configure the settings of the general network environment
and specific identification parameters of the instrument in the network. The
R&S NPA displays the VISA resource strings and additional parameters for infor-
mation on the LAN interface, and the status of the connection.

By default, the R&S NPA is configured to use dynamic TCP/IP configuration and to
obtain the whole address information automatically. If the network does not support
DHCP, you can assign the IP address manually.

How to: "To assign the IP addresses for the LAN interface manually" on page 185.

ETHERNET.................................................................................................................180
MAC............................................................................................................................ 181
IP Mode.......................................................................................................................181
IP.................................................................................................................................181
Subnet mask............................................................................................................... 181
Gateway...................................................................................................................... 181
RAW-Port.................................................................................................................... 181
VXI-11-Port..................................................................................................................181
Transfer.......................................................................................................................182
Link..............................................................................................................................182
IP-Status..................................................................................................................... 182
Reset...........................................................................................................................182
Save............................................................................................................................ 182

ETHERNET
Selects the LAN interface for controlling the R&S NPA remotely.
Remote command: 
SYSTem:INTerface on page 241

Remote access settings
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MAC
Indicates the MAC (Media Access Control) address, a unique identifier of the network
adapter in the R&S NPA.
Remote command: 
n.a.

IP Mode
Selects the mode for assigning the IP address.
How to: Section 12.4, "Adjusting the interface addresses", on page 185.
"Auto (DCHP)"

Assigns the IP address automatically, provided the network supports
DCHP.

"MAN" Enables you to assign the IP address manually.
Remote command: 
n.a.

IP
Displays the IP address of the instrument in the network.
To assign the IP address manually, select IP Mode > MAN.
Remote command: 
n.a.

Subnet mask
Displays the bit group of the subnet in the host identifier.
To assign the subnet mask manually, select IP Mode > MAN.
Remote command: 
n.a.

Gateway
Displays the gateway address.
This address identifies the router on the same network as the instrument that is used to
forward traffic to destinations beyond the local network.
To assign the "Gateway" manually, select IP Mode > MAN.
Remote command: 
n.a.

RAW-Port
Displays the visa resource string for remote control over LAN, using TCP/IP socket
protocol.
To assign the socket port manually, select IP Mode > MAN.
Remote command: 
n.a.

VXI-11-Port
Displays the visa resource string for Ethernet instruments.

Remote access settings
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Remote command: 
n.a.

Transfer
Selects the mode to determine the parameters of the communication channel.
Auto Determines the parameters automatically.
"Manual 10/100Mbps Half Duplex"

Sets 10/100Mbps data transfer in one direction on the communication
channel.

"Manual 10/100Mbps Full Duplex"
Sets 10/100 Mbps data transfer in both directions on the communica-
tion channel.

Remote command: 
n.a.

Link
Displays the status of the LAN connection. "Yes" in geen letters denotes that the over
LAN is active.
Remote command: 
n.a.

IP-Status
Indicates whether the LAN connection is active (green color), and displays the setting
of the IP mode.
Remote command: 
n.a.

Reset
Restores the LAN settings to factory default.
"Confirm" Confirm the factory default settings.
"Abort" Aborts the factory default settings.

Save
Saves the static IP settings.

12.2.3  GPIB settings

Instrument models R&S NPA501-G and R&S NPA701-G are equipped with an integra-
ted GPIB IEEE488 bus interface.

Access:

1. Select [SETUP] > "Interface".

2. In the interface menu, select "IEEE488".

Remote access settings
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Figure 12-8: IEEE488 selection

3. Select "PARAMETER" to access the "IEEE488" softkey menu.

Figure 12-9: IEEE488 softkey menu

4. Select the "Address" softkey.

5. Enter the address with the rotary knob or the numeric keypad.

6. Confirm with "Save".

The controller must address the instrument with the GPIB bus address.
How to: Section 12.4.2, "How to change the GPIB address", on page 188.

To return to the previous level

► Press the  key.

In menus, the back key returns to the previous level or folds it down to a small
menu (toggle function).

IEEE488...................................................................................................................... 183
PARAMETER.............................................................................................................. 183
Address....................................................................................................................... 184
Save............................................................................................................................ 184

IEEE488
Selects the GPIB bus interface for reemote control of the R&S NPA.
Remote command: 
SYSTem:INTerface on page 241

PARAMETER
Selects the GPIB interface parameter.
Remote command: 
n.a.
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Address
Sets the GPIB address.
Remote command: 
n.a.

Save
Confirms the setting.
Remote command: 
n.a.

12.3  Connecting the R&S NPA for remote access

12.3.1  Connecting to LAN

For remote control of the R&S NPA in a LAN, connect the instrument as described in
Section 3.1.8, "Connecting to LAN", on page 25.

12.3.2  Connecting the R&S NPA to the USB interface

You can use the USB B interface for remote control and data transfer from a controller
PC. Remote control over USB requires the VISA library.

The USB B connector is on the rear panel.

To connect the R&S NPA to the USB B interface:

► Connect the USB B connector using a double-shielded USB cable to the controller
PC.

VISA detects and configures the instrument automatically when the USB connec-
tion is established. You do not have to enter an address string or install a separate
driver.

12.3.3  Connecting the R&S NPA to the IEC 625/IEEE 488 interface

Instrument models R&S NPA501-G R&S NPA701-G provide the GPIB bus interface,
you can use for controlling the instrument remotely.

The USB B connector is on the rear panel.

To connect the R&S NPA to the controller PC:

1. Connect the IEC 625/IEEE 488 connector of the R&S NPA to the controller PC with
a double-shielded GPIB bus interface cable.

Connecting the R&S NPA for remote access



Network operation and remote controlR&S®NPA

185User Manual 1179.1664.02 ─ 05

2. Enable the remote control connection as described in Section 12.2.3, "GPIB set-
tings", on page 182.

The controller must address the instrument with the GPIB bus address, see Sec-
tion 12.1.3, "GPIB interface (IEC/IEEE bus interface)", on page 174.

12.4  Adjusting the interface addresses

12.4.1  How to configure the Ethernet settings

Depending on the network capabilities, the TCP/IP address information for the instru-
ment can be obtained in different ways.
● If the network supports DHCP (dynamic host configuration protocol), this protocol

assigns the IP address automatically (default setting). DCHP mode enables you to
establish a physical connection to the LAN without any additional instrument con-
figuration. Regardless of the automatic address configuration, the instrument
allows to adjust the interface addresses of the raw socket and the VX-11 ports.

● If the network does not support DHCP or if the instrument is set to use alternate
TCP/IP configuration, you must set the addresses manually.

To assign the IP addresses for the LAN interface manually

The following instructions lead you through the steps for setting the IP address man-
ually.

Access:

1. Select [SETUP] > "Interface".

2. Select the "Ethernet" softkey to enable the ethernet connection.

Figure 12-10: ETHERNET softkey

3. Select the "PARAMETER" softkey to access the interface settings dialog.

The R&S NPA displays the information on the LAN interface, and the status of the
connection.

Adjusting the interface addresses
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Figure 12-11: Ethernet settings

In this dialog, you can configure the settings of the general network environment
and specific identification parameters of the instrument in the network.
The MAC address is assigned statically and cannot be modified.

4. NOTICE! Risk of network failure. Connecting to the network with an incorrectly
configured interface can cause failures that affect the entire network.
Consult your network administrator before performing the following tasks:
● Connecting the instrument to the network
● Configuring the network
● Changing IP addresses

5. Select "IP-MODE" > "MAN" to enable edit mode.

Figure 12-12: IP mode setting

6. Select the "DOWN" softkey repeatedly up to the "IP" address field.
The IP address consists of four blocks separated by dots. Every block contains 3
numbers at a maximum.

a) Set the first number of the address.
b) Select "NEXT" with the rotary knob to step to the following block.
c) Set the number.
d) Proceed the same way to to complete the address.

7. Select "Down" to continue with the next setting.

8. Set the "Subnet mask" and "Gateway" in the same way as described above.

9. Select the "RAW Port" entry field, to set the port number for SCPI socket communi-
cation.

10. Select the "Transfer" mode using the rotary knob.

Adjusting the interface addresses
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"Auto" assigns the transfer parameters automatically, or you can set the baudrate
and duplex mode ("HALF" / "FULL") manually.

11. "SAVE" the settings.

The "Link" and "IP-Status" information at the bottom of the dialog indicates whether
a LAN connection is established successfully.

To check the LAN connection

You have several possibilities, to validate if the LAN connection is established and
working properly:

1. Check the LAN connection using ping: ping <IP address>.

2. If the PC can access the instrument, enter the IP address of the instrument into the
Internet browser on your computer: http//:xxx.yyy.zzz.xxx
The "Device Information" page appears. It provides information on the instrument
and the LAN connection.

Figure 12-13: Browser interface Device information

Adjusting the interface addresses
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12.4.2  How to change the GPIB address

The controller addresses the instrument within the GPIB bus channel, providing
addresses from 0 to 30. The R&S NPA has the factory-set address of 1, which you can
adjust according to your environment.

To assign the GPIB (IEE488) address manually

Access:

1. Press the [SETUP] key on the front panel.

2. Select the "Interface" softkey.

3. Select "IEEE488" in the softkey menu.

Figure 12-14: IEEE488 softkey

4. Select the "PARAMETER" softkey to access the settings of the IEEE488 interface.

5. Select "ADDRESS" to enable edit mode for the address setting.

Figure 12-15: Address enabled for editing

6. Set the required address with the rotary knob.

7. Select the "SAVE" softkey to confirm the setting.

8. Return with the  key.

12.4.3  How to configure the USB connection

For remote control over the USB interface, the controller PC and the instrument must
be connected over the USB type B interface. The USB B connector is on the front
panel. Depending on the used USB port, the connection requires the VISA library or a
USB VCP driver to be installed.

To select the USB VDC communication port

Communication over the virtual COM port requires that you have installed a USB VCP
driver on the controller PC.

Access:

1. Select [SETUP] > "Interface".

2. Select the "USB VCP" softkey to enable the communication.
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Figure 12-16: USB VCP softkey

You do not have to enter an address string, therefore the "PARAMETER" is grayed
out.

3. Return with the  key.

To select the USB TMC communication port

Communication over USB TMC requires that you have installed the VISA library on the
controller PC.

Access:

1. Select [SETUP] > "Interface".

2. Select the "USB TMC" softkey to enable communication.

Figure 12-17: USB TMC softkey

Communication over USB TMC does not require further address settings, therefore
the "PARAMETER" is grayed out.

3. Return with the  key.

12.5  Starting and stopping remote control

When you switch on the instrument, it is always in manual operation state (local state).
You can operate it using the controls on the front panel. To switch to remote control
operation, proceed as described as follows.

To start a remote control session

You have the following options to switch to remote control:

1. Send a remote control command from the controller.

2. LAN or USB interface: send the interface message &GTR.

Starting and stopping remote control
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3. Send the command SYSTem:REMote.

The instrument switches to remote control.
On the screen, a status symbol indicates that remote control is active. The display
remains on and you can still operate it manually with the front panel controls.

To lock manual control

To prevent unauthorized access, you can explicitly block the front panel controls.

1. Send the command SYSTem:RWLock.

Locks the front panel controls except for the  (local) softkey. You can control the
instrument remotely only.

2. Send command 

3. To release the front panel controls again, see To return to manual control.

To return to manual control

The instrument switches back to manual operation when the remote connection is
closed. But you can return to manual operation either manually or remotely.

1. Select  (local) softkey.

2. LAN or USB interface: send the message &GTL.

The instrument switches to manual control.

Starting and stopping remote control
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13  Remote control commands
In the following, all remote-control commands are presented in detail with their param-
eters and the ranges of numerical values.

For an introduction to remote control and the status registers, see:
● Section 12, "Network operation and remote control", on page 170
● Section 12.1.4, "Status reporting system", on page 175

See also the list of commands in alphabetical order at the end of this user manual.

The channel suffix is irrelevant for all measurement commands and is therefore not
mentioned in the following commands.

13.1  Conventions used in SCPI command descriptions

Note the following conventions used in the remote command descriptions:
● Command usage

Unless otherwise specified, you can set and query a parameter with a command.
If you can only set or query a parameter with a command, or if a command triggers
an event, the use is explicitly specified.

● Parameter usage
Unless otherwise specified, you can set and query a value of a parameter.
Parameters that only set a value are indicated as Setting parameters.
Parameters that refine a value are indicated as Query parameters.
Parameters that are only returned as the result of a query are indicated as Return
values.

● Conformity
Commands that are taken from the SCPI standard are indicated as SCPI con-
firmed. All commands used by the R&S NPA follow the SCPI syntax rules.

● Asynchronous commands
A command which does not automatically finish executing before the next com-
mand starts executing (overlapping command), is indicated as an Asynchronous
command.

● Reset values (*RST)
Default parameter values that are used directly after resetting the instrument (*RST
command) are indicated as *RST values, if available.

● Default unit
The default unit is used for numeric values if no other unit is provided with the
parameter.

● Manual operation
If the result of a remote command can also be achieved in manual operation, a link
to the description is inserted.

Conventions used in SCPI command descriptions
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13.2  Common commands

Common commands are described in the IEEE 488.2 (IEC 625-2) standard. These
commands have the same effect and are employed in the same way on different devi-
ces. The headers of these commands consist of "*" followed by three letters. Many
common commands are related to the Status Reporting System.

Rohde & Schwarz recommend to start a program by *RST (see *RST on page 194) in
order to set the instrument to a defined status prior to starting a program.
The R&S NPA does not support parallel processing of remote commands. If the query
*OPC? (see *OPC on page 193) returns a „1“, the device is able to process new com-
mands.

Available common commands:

*CLS.............................................................................................................................192
*ESE.............................................................................................................................192
*ESR?...........................................................................................................................193
*IDN?............................................................................................................................193
*LRN?...........................................................................................................................193
*OPC............................................................................................................................193
*PSC............................................................................................................................ 193
*RCL <Storage>............................................................................................................ 194
*RST.............................................................................................................................194
*SAV <Storage>.............................................................................................................194
*SRE............................................................................................................................ 194
*STB?...........................................................................................................................194
*TRG............................................................................................................................ 195
*TST?........................................................................................................................... 195
*WAI.............................................................................................................................195

*CLS

Clear status

Sets the status byte (STB), the standard event register (ESR) and the EVENt part of
the QUEStionable and the OPERation registers to zero. The command does not
alter the mask and transition parts of the registers. It clears the output buffer.

Usage: Setting only

*ESE <Value>

Event status enable

Sets the event status enable register to the specified value. The query returns the con-
tents of the event status enable register in decimal form.

Parameters:
<Value> Range: 0 to 255

Common commands
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*ESR?

Event status read

Returns the contents of the event status register in decimal form and then sets the reg-
ister to zero.

Return values: 
<Contents> Range: 0  to  255

Usage: Query only

*IDN?

Returns the instrument identification.

Return values: 
<ID> ROHDE&SCHWARZ,‹device type›,‹serial number›,‹hardware›,

‹firmwareversion›

Example: Rohde&Schwarz,NPA701,00000000,HW42000000,
SW01.000

Usage: Query only

Manual operation: See "Device Information" on page 158

*LRN?

Returns the currrent instrument state in a block of binary settings.

Usage: Query only

*OPC

Operation complete

Sets bit 0 in the event status register when all preceding commands have been execu-
ted. This bit can be used to initiate a service request. The query writes a "1" into the
output buffer when all preceding commands have been executed, which is useful for
command synchronization.

*PSC <Action>

Power on status clear

Determines whether the contents of the ENABle registers are preserved or reset when
the instrument is switched on. Thus a service request can be triggered when the instru-
ment is switched on, if the status registers ESE and SRE are suitably configured. The
query reads out the contents of the "power-on-status-clear" flag.

Parameters:
<Action> 0 | 1
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0
The contents of the status registers are preserved.
1
Resets the status registers.

*RCL <Storage>

Recalls the current instrument state from the specified memory location.

Parameters:
<Storage> 0 | 1 | 2 | 3 | 4 | 5 | 6 | 7 | 8 | 9

Manual operation: See "Load" on page 149

*RST

Reset

Sets the instrument to a defined default status. The default settings are indicated in the
description of commands.

Usage: Setting only

Manual operation: See "Default Settings" on page 169

*SAV <Storage>

Saves the current instrument state in the specified memory location. The command
overwrites any previously saved state in the same memory location without erro notifi-
cation.

Parameters:
<Storage> 0 | 1 | 2 | 3 | 4 | 5 | 6 | 7 | 8 | 9

Manual operation: See "Save" on page 149

*SRE <Contents>

Service request enable

Sets the service request enable register to the indicated value. This command deter-
mines under which conditions a service request is triggered.

Parameters:
<Contents> Contents of the service request enable register in decimal form.

Bit 6 (MSS mask bit) is always 0.
Range: 0  to  255

*STB?

Status byte query
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Reads the contents of the status byte in decimal form.

Usage: Query only

*TRG

Trigger

Triggers all actions waiting for a trigger event. In particular, *TRG generates a manual
trigger signal. This common command complements the commands of the TRIGger
subsystem.

*TRG corresponds to the INITiate:IMMediate command.

Usage: Event

*TST?

Self-test query

Initiates self-tests of the instrument and returns an error code.

Return values: 
<ErrorCode> integer > 0 (in decimal format)

An error occurred.
0
No errors occurred.

Usage: Query only

*WAI

Wait to continue

Prevents servicing of the subsequent commands until all preceding commands have
been executed and all signals have settled (see also command synchronization and
*OPC).

Usage: Event

13.3  CHANnel:ACQuisition subsystem

The subsystem contains the commands for configuring data acquisition.

CHANnel:ACQuisition subsystem
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Example: ACQuisition settings
The example represents the remote control commands for configuring the settings for
the channel data acquisition.
****************************************
// Acquisition functions and parameter settings
****************************************

****************************************
// AC mode 
***************************************
// Configure the parameters:
// select synchronization frequency, e.g. 
// select voltage as reference
// activate the freq and bandwidth filters
CHANnel[:ACQuisition]:MODE AC
CHANnel[:ACQuisition]:MODE[:AC]:PLL VOLTage
CHANnel[:ACQuisition]:MODE[:FILTer]:ANALog ON
CHANnel[:ACQuisition]:MODE[:FILTer]:DIGital OFF
CHANnel[:ACQuisition]:MODE[:FILTer]:FREQuency ON

****************************************
// Query the settings:
CHANnel[:ACQuisition]:MODE?
// Response: AC
CHANnel[:ACQuisition]:MODE[:AC]:PLL?
// Response: VOLTage
CHANnel[:ACQuisition]:MODE[:FILTer]:ANALog?
// Response: 1
CHANnel[:ACQuisition]:MODE[:FILTer]:DIGital?
// Response: 0
CHANnel[:ACQuisition]:MODE[:FILTer]:FREQuency?
// Response: 1

****************************************
// DC mode
****************************************
CHANnel[:ACQuisition]:MODE DC

****************************************
// Query the settings:
CHANnel[:ACQuisition]:MODE?
// Response: DC

****************************************
// AUTO mode 
****************************************
// Configure the parameters:
// activate all filters

CHANnel:ACQuisition subsystem
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CHANnel[:ACQuisition]:MODE AUTO
CHANnel[:ACQuisition]:MODE[:FILTer]:ANALog 1
CHANnel[:ACQuisition]:MODE[:FILTer]:DIGital 1
CHANnel[:ACQuisition]:MODE[:FILTer]:FREQuency 1

****************************************
// Query the settings:
CHANnel[:ACQuisition]:MODE?
// Response: AUTO
CHANnel[:ACQuisition]:MODE[:FILTer]:ANALog?
// Response: 1
CHANnel[:ACQuisition]:MODE[:FILTer]:DIGital?
// Response: 1
CHANnel[:ACQuisition]:MODE[:FILTer]:FREQuency?
// Response: 1

****************************************
// External mode
****************************************
CHANnel[:ACQuisition]:MODE EXTern

****************************************
// Query the settings:
CHANnel[:ACQuisition]:MODE?
// Response: EXT

****************************************
// Voltage acquistion settings
****************************************
// Configure the parameters:
// deactivate autorange 
// select the voltage range, crest factor
// deactivate invert function

CHANnel[:ACQuisition]:VOLTage:RANGe:AUTO 0
CHANnel[:ACQuisition]:VOLTage:RANGe 15
CHANnel[:ACQuisition]:VOLTage:CFACtor 3
CHANnel[:ACQuisition]:VOLTage:INVert 0

****************************************
// Query the settings:
CHANnel[:ACQuisition]:VOLTage:RANGe:AUTO?
// Response: 0
CHANnel[:ACQuisition]:VOLTage:RANGe?
// Response: 15
CHANnel[:ACQuisition]:VOLTage:CFACtor?
// Response: 3
CHANnel[:ACQuisition]:VOLTage:INVert?
// Response: 0

CHANnel:ACQuisition subsystem
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****************************************
// Current acquistion settings
****************************************
// Configure the parameters:
// deactivate autorange 
// select the current range and crest factor
// activate invert function

CHANnel[:ACQuisition]:CURRent:RANGe:AUTO 0
CHANnel[:ACQuisition]:CURRent:RANGe 0.005
CHANnel[:ACQuisition]:CURRent:CFACtor 3
CHANnel[:ACQuisition]:CURRent:INVert 1

****************************************
// Query the settings:
CHANnel[:ACQuisition]:CURRent:RANGe:AUTO?
// Response: 0
CHANnel[:ACQuisition]:CURRent:RANGe?
// Response: 0.005
CHANnel[:ACQuisition]:CURRent:CFACtor?
// Response: 3
CHANnel[:ACQuisition]:CURRent:INVert?
// Response: 1

****************************************
// Configure the peakhold function
****************************************
// activate peakhold and reset the value 
// query the peakhold state

CHANnel[:ACQuisition]:PEAKhold:ACTivate 1
CHANnel[:ACQuisition]:PEAKhold:RESet
CHANnel[:ACQuisition]:PEAKhold:ACTivate?
// Respnse: 1

****************************************
// Configure the peakhold function
****************************************
// Query the overcurrent protection state.
// Reset the overcurrent protection state.

CHANnel[:ACQuisition]:CURRent:PROTection?
// Response: 1
CHANnel[:ACQuisition]:CURRent:PROTection:RESet

CHANnel:ACQuisition subsystem
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CHANnel[:ACQuisition]:CURRent:CFACtor.......................................................................199
CHANnel[:ACQuisition]:CURRent:INVert.......................................................................... 199
CHANnel[:ACQuisition]:CURRent:PROTection:RESet........................................................199
CHANnel[:ACQuisition]:CURRent:PROTection?................................................................ 200
CHANnel[:ACQuisition]:CURRent:RANGe........................................................................ 200
CHANnel[:ACQuisition]:CURRent:RANGe:AUTO.............................................................. 200
CHANnel[:ACQuisition]:MODE........................................................................................ 201
CHANnel[:ACQuisition]:MODE[:AC]:PLL.......................................................................... 201
CHANnel[:ACQuisition]:MODE[:FILTer]:ANALog................................................................201
CHANnel[:ACQuisition]:MODE[:FILTer]:DIGital..................................................................202
CHANnel[:ACQuisition]:MODE[:FILTer]:FREQuency.......................................................... 202
CHANnel[:ACQuisition]:PEAKhold:ACTivate..................................................................... 202
CHANnel[:ACQuisition]:PEAKhold:RESet......................................................................... 202
CHANnel[:ACQuisition]:VOLTage:CFACtor....................................................................... 203
CHANnel[:ACQuisition]:VOLTage:INVert...........................................................................203
CHANnel[:ACQuisition]:VOLTage:RANGe.........................................................................203
CHANnel[:ACQuisition]:VOLTage:RANGe:AUTO...............................................................203

CHANnel[:ACQuisition]:CURRent:CFACtor <CrestFactor>

Selects the crest factor for current measurement.

Parameters:
<CrestFactor> 1 | 3 | 6

Value of the crest factor.

Example: See Example "ACQuisition settings" on page 196.

Manual operation: See "CREST FACT" on page 69

CHANnel[:ACQuisition]:CURRent:INVert <State>

Inverts the current measurement reading.

Parameters:
<State> 1 | 0 ON | OFF

ON | 1
Inverts the current value.
OFF | 0
Turns off the inversion of the current value.

Example: See Example "ACQuisition settings" on page 196.

Manual operation: See "INVERT" on page 69

CHANnel[:ACQuisition]:CURRent:PROTection:RESet

Resets the overcurrent protection state.

Example: See Example "ACQuisition settings" on page 196.

Usage: Event

CHANnel:ACQuisition subsystem
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CHANnel[:ACQuisition]:CURRent:PROTection?

Queries the overcurrent protection state.

Return values: 
<PROTection> 1 | 0

1
The overcurrent protection has tripped.
0
The overcurrent protection has not tripped.

Example: See Example "ACQuisition settings" on page 196.

Usage: Query only

CHANnel[:ACQuisition]:CURRent:RANGe <RmsValue>

Selects the current range.

Setting the value manually deactivates the automatic measurement current range , set
with command CHANnel[:ACQuisition]:CURRent:RANGe:AUTO on page 200.

Parameters:
<RmsValue> 0.0025 | 0.005 | 0.01 | 0.015 | 0.02 | 0.25 | 0.03 | 0.05 | 0.06 |

0.1 | 0.15 | 0.2 | 0.25 | 0.3 | 0.5 | 0.6 | 1 | 1.5 | 2 | 2.5 | 3 | 5 | 6 |
10 | 15 | 20 | 30 | 60
The available setting depends on the crest factor, selected with
CHANnel[:ACQuisition]:CURRent:CFACtor.
See Table 6-2.
Range: 0.0025  to  60
Default unit: A

Example: See Example "ACQuisition settings" on page 196.

Manual operation: See "RANGE" on page 68

CHANnel[:ACQuisition]:CURRent:RANGe:AUTO <State>

Activates the automatic current measurement range setting.

Parameters:
<State> 1 | 0 ON | OFF

ON | 1
Selects the current measurement range automatically.
OFF | 0
Turns off the automaitc current measurement range.

Example: See Example "ACQuisition settings" on page 196.

Manual operation: See "AUTORANGE" on page 68

CHANnel:ACQuisition subsystem
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CHANnel[:ACQuisition]:MODE <Mode>

Selects the acquisition mode.

Parameters:
<Mode> AC | DC | AUTO | EXTern

AC
Measures the average voltage or current AC (synchronization on
period duration).
DC
Measures pure DC loads.
AUTO
Sels the acquisition mode automatically.
EXTern
Measures external signals.

Example: See Example "ACQuisition settings" on page 196.

Manual operation: See "Mode" on page 70

CHANnel[:ACQuisition]:MODE[:AC]:PLL <Ref_Value>

Selects the reference value of the synchronization frequency (Phase Locked Loop
Source).

Parameters:
<Ref_Value> VOLTage | CURRent

VOLTage
Uses the voltage value as reference source.
CURRent
Uses the current value as reference source.

Example: See Example "ACQuisition settings" on page 196.

Manual operation: See "PLL SRC" on page 70

CHANnel[:ACQuisition]:MODE[:FILTer]:ANALog <State>

Activates the low-pass filter function.

Parameters:
<State> 1 | 0

ON | 1
Active lowpass filter function.
OFF | 0
Disabled lowpass filter function.

Example: See Example "ACQuisition settings" on page 196.

Manual operation: See "BWL 1KHZ" on page 71

CHANnel:ACQuisition subsystem
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CHANnel[:ACQuisition]:MODE[:FILTer]:DIGital <State>

Enables the digital filter function.

Parameters:
<State> 1 | 0 | ON | OFF

ON | 1
Turns on the digital filter.
OFF | 0
Turns off the digital filter.

Example: See Example "ACQuisition settings" on page 196.

Manual operation: See "DIG. FILTER" on page 71

CHANnel[:ACQuisition]:MODE[:FILTer]:FREQuency <State>

Enables the frequency filter function.

Parameters:
<State> 1 | 0 ON | OFF

ON | 1
Activates the frequency filter.
OFF | 0
Turns off the frequency filter.

Example: See Example "ACQuisition settings" on page 196.

Manual operation: See "FREQ FILTER" on page 70

CHANnel[:ACQuisition]:PEAKhold:ACTivate <State>

Activates the peak hold function.

Parameters:
<State> 1 | 0 | ON | OFF

*RST: OFF | 0

Example: See Example "ACQuisition settings" on page 196.

Manual operation: See "Activate" on page 71

CHANnel[:ACQuisition]:PEAKhold:RESet

Resets the saved peak value.

To monitor maximum peak values, activate the peak hold function with command
CHANnel[:ACQuisition]:PEAKhold:ACTivate on page 202.

Example: See Example "ACQuisition settings" on page 196.

Usage: Event

Manual operation: See "Reset" on page 72
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CHANnel[:ACQuisition]:VOLTage:CFACtor <CrestFactor>

Selects the crest factor for voltage measurement.

Parameters:
<CrestFactor> 1 | 3 | 6

Value of the crest factor.

Example: See Example "ACQuisition settings" on page 196.

Manual operation: See "CREST FACT" on page 67

CHANnel[:ACQuisition]:VOLTage:INVert <State>

Inverts the voltage measurement reading.

Parameters:
<State> 1 | 0 | ON | OFF

ON | 1
Inverts the voltage value.
OFF | 0
Turns off the inversion of the voltage value.

Example: See Example "ACQuisition settings" on page 196.

Manual operation: See "INVERT" on page 67

CHANnel[:ACQuisition]:VOLTage:RANGe <RmsValue>

Selects the voltage range.

Setting the value manually deactivates the automatic measurement voltage range, set
with command CHANnel[:ACQuisition]:VOLTage:RANGe:AUTO on page 203.

Parameters:
<RmsValue> 2.5 | 5 | 7.5 | 15 | 30 | 45 | 60 | 75 | 150 | 300 | 450 | 600 | 900 |

1800
The available setting depends on the crest factor, selected with
CHANnel[:ACQuisition]:VOLTage:CFACtor.
See Table 6-1.
Range: 2.5  to  1800
Default unit: V

Example: See Example "ACQuisition settings" on page 196.

Manual operation: See "RANGE" on page 67

CHANnel[:ACQuisition]:VOLTage:RANGe:AUTO <State>

Enables the automatic voltage measurement range setting.

Parameters:
<State> 1 | 0 ON | OFF
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ON | 1
Selects the voltage measurement range automatically.
OFF | 0
Turns off the automaitc voltage measurement range.
*RST: ON | 1

Example: See Example "ACQuisition settings" on page 196.

Manual operation: See "AUTORANGE" on page 67

13.4  CHANnel:EXTernal subsystem

The CHANnel:EXTernal subsystem contains the commands for configuring the
external interfaces.

CHANnel:EXTernal subsystem
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Example: Input and output settings
The example represents the remote control commands for configuring the settings for
measurements of input or output signals.
****************************************
// Configure an analog input signal
****************************************
// Configure the parameters:
// Assign the analog input value
// to the display, e.g. measurement page 2
// field 1
// activate the measurement
****************************************
VIEW:NUMeric:PAGE2:CELL1:FUNCtion AIN
CHANnel[:EXTern]:AINPut[:STATe] 1

****************************************
// Query the settings 
VIEW:NUMeric:PAGE2:CELL1:FUNCtion?
// Response: AIN
CHANnel[:EXTern]:AINPut[:STATe]?
// Response: 1

****************************************
// Measuring an analog output signal
****************************************
// Configure the parameters:
// configure the measurement window, 
// e.g. display voltage, current, power 
// and limit parameters on page 3
// select the analog output mode
// activate analog signal output
****************************************
VIEW:NUMeric:PAGE3:SIZE 6
VIEW:NUMeric:PAGE3:CELL1:FUNCtion URMS
VIEW:NUMeric:PAGE3:CELL2:FUNCtion IRMS
VIEW:NUMeric:PAGE3:CELL3:FUNCtion P
VIEW:NUMeric:PAGE3:CELL4:FUNCtion S
VIEW:NUMeric:PAGE3:CELL5:FUNCtion LIM1
VIEW:NUMeric:PAGE3:CELL6:FUNCtion LIM2
CHANnel[:EXTern]:AOUTput:MODE VOLTage

// alternative current or power output modes
// CHANnel[:EXTern]:AOUTput:MODE CURRent
// CHANnel[:EXTern]:AOUTput:MODE POWer
// additional settings for limit output mode
// CHANnel:LIMit2:SOURce URMS
// CHANnel:LIMit2:HIGH 60
// CHANnel:LIMit2:LOW 10
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// CHANnel[:EXTern]:AOUTput:MODE LIMit2
CHANnel[:EXTern]:AOUTput[:STATe] 1

****************************************
// Query the settings 
CHANnel[:EXTern]:AOUTput:MODE?
// Response: VOLTage
CHANnel[:EXTern]:AOUTput[:STATe]?
// Response: 1

****************************************
// Configure a digital input signal
****************************************
// Configure the parameters:
// Assign the digital input value
// to the display, e.g. measurement page 1
// field 1
// select the parameter to be measured
// invert the incoming signal
// activate the measurement
****************************************
VIEW:NUMeric:PAGE1:CELL1:FUNCtion DIN
CHANnel[:EXTern]:DINput:MODE STATe
CHANnel[:EXTern]:DINPut:INVert 1
CHANnel[:EXTern]:DINPut[:STATe] 1

****************************************
// Query the settings 
VIEW:NUMeric:PAGE1:CELL1:FUNCtion?
// Response: DIN
CHANnel[:EXTern]:DINput:MODE?
// Response: STATe
CHANnel[:EXTern]:DINPut:INVert?
// Response: 1
CHANnel[:EXTern]:DINPut[:STATe]?
// Response: 1

****************************************
// Configure a digital output signal
****************************************
// Configure the parameters:
// configure the measurement window, 
// e.g. display voltage, current, frequency 
// and limit parameters on page 4
// select the digital output mode

// activate digital signal output
****************************************
VIEW:NUMeric:PAGE4:SIZE 6
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VIEW:NUMeric:PAGE4:CELL1:FUNCtion URMS
VIEW:NUMeric:PAGE4:CELL2:FUNCtion IRMS
VIEW:NUMeric:PAGE4:CELL3:FUNCtion FU
VIEW:NUMeric:PAGE4:CELL4:FUNCtion FPLL
VIEW:NUMeric:PAGE4:CELL5:FUNCtion LIM1
VIEW:NUMeric:PAGE4:CELL6:FUNCtion LIM2
CHANnel:LIMit2:SOURce URMS
CHANnel:LIMit2:HIGH 60
CHANnel:LIMit2:LOW 10
// CHANnel[:EXTern]:DOUTput:MODE LIMit2
CHANnel[:EXTern]:DOUTput:MODE LIMit
// alternative output mode
// CHANnel[:EXTern]:DOUTput:MODE FPLL

CHANnel[:EXTern]:DOUTput[:STATe] 1

****************************************
// Query the settings 
CHANnel[:EXTern]:DOUTput:MODE?
// Response: LIMit
CHANnel[:EXTern]:DOUTput[:STATe]?
// Response: 1
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Example: SENsor settings
The example represents the remote control commands for configuring the settings for
measurements with external probes.
****************************************
// Configure a voltage based measurement
// with an external shunt
****************************************
// Configure the parameters:
// set the measurement mode for the external shunt 
// set the voltage range to 100 mV
// and the resistance to 1 Ohm
// start the measurement
****************************************
CHANnel[:EXTern]:SENSor:MODE EXTShunt
CHANnel[:EXTern]:SENSor:EXTShunt[:RESistance] 1
CHANnel[:EXTern]:SENSor:RANGe 0.1
CHANnel[:EXTern]:SENSor[:STATe] 1

****************************************
// Query the settings 
CHANnel[:EXTern]:SENSor:MODE?
// Response: EXTShunt
CHANnel[:EXTern]:SENSor:EXTShunt[:RESistance]?
// Response: 1
CHANnel[:EXTern]:SENSor:RANGe?
// Response: 0.1
CHANnel[:EXTern]:SENSor[:STATe]?
// Response: 1

****************************************
// Configure a currrent based measurement 
// with an external clamp-on probe 
****************************************
// Configure the parameters:
// set the measurement mode for the current probe 
// set the voltage range to 1 V
// and the current to voltage ratio to 10 mVA
// start the measurement
****************************************
CHANnel[:EXTern]:SENSor:MODE CCLamp
CHANnel[:EXTern]:SENSor:CCLamp[:RATio] 0.01
CHANnel[:EXTern]:SENSor:RANGe 1
CHANnel[:EXTern]:SENSor[:STATe] 1

****************************************
// Query the settings 
CHANnel[:EXTern]:SENSor:MODE?
// Response: CCLamp
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CHANnel[:EXTern]:SENSor:CCLamp[:RATio]?
// Response: 0.01
CHANnel[:EXTern]:SENSor:RANGe?
// Response: 1
CHANnel[:EXTern]:SENSor[:STATe]?
// Response: 1

CHANnel[:EXTern]:AINPut[:STATe].................................................................................. 209
CHANnel[:EXTern]:AOUTput:MODE................................................................................ 209
CHANnel[:EXTern]:AOUTput[:STATe]............................................................................... 210
CHANnel[:EXTern]:DINPut:INVert.................................................................................... 210
CHANnel[:EXTern]:DINput:MODE....................................................................................210
CHANnel[:EXTern]:DINPut[:STATe].................................................................................. 211
CHANnel[:EXTern]:DOUTput:INVert................................................................................. 211
CHANnel[:EXTern]:DOUTput:MODE................................................................................ 211
CHANnel[:EXTern]:DOUTput[:STATe]............................................................................... 211
CHANnel[:EXTern]:SENSor[:STATe].................................................................................212
CHANnel[:EXTern]:SENSor:CCLamp[:RATio]....................................................................212
CHANnel[:EXTern]:SENSor:EXTShunt[:RESistance]..........................................................212
CHANnel[:EXTern]:SENSor:MODE.................................................................................. 212
CHANnel[:EXTern]:SENSor:RANGe.................................................................................213

CHANnel[:EXTern]:AINPut[:STATe] <State>

Activates the measurement of an externally supplied analog signal.

Parameters:
<State> 1 | 0 | (ON | OFF)

Example: See Example "Input and output settings" on page 205.

Manual operation: See "ACTIVATE" on page 136
See "MODE" on page 136

CHANnel[:EXTern]:AOUTput:MODE <Mode>

Selects the external mode for the analog output signal.

Parameters:
<Mode> LIMit<n> | VOLTage | CURRent | POWer

VOLTage
Selects the voltage of the output signal standardized to +-5V of
the input signal.
CURRent
Selects the current of the output signal standardized to +-5V of
the input signal.
POWer
Selects the power of the output signal standardized to +-5V of
the instantaneous power.
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LIMit<n>
Selects the parameter with an assigned limit, selected with com-
mand CHANnel:LIMit<n>:SOURce on page 216. The suffix
<n> selects the position of the parameter in the limit list.

Example: See Example "Input and output settings" on page 205.

CHANnel[:EXTern]:AOUTput[:STATe] <State>

Activates the analog signal output.

Parameters:
<State> 1 | 0 | (ON | OFF)

Example: See Example "Input and output settings" on page 205.

Manual operation: See "MODE" on page 136

CHANnel[:EXTern]:DINPut:INVert <State>

Inverts the digital input signal.

Parameters:
<State> 1 | 0 ON | OFF

ON | 1
Inverts the signal.
OFF | 0
Turns off the inversion.

Example: See Example "Input and output settings" on page 205.

Manual operation: See "INVERT (Digital In)" on page 139

CHANnel[:EXTern]:DINput:MODE <Mode>

Selects the measurement parameter of the digital input signal.

Parameters:
<Mode> FREQuency | PWM | STATe

FREQuency
Measures the frequency.
PWM
Acquires the ratio of the high to low times.
STATe
Measures the high and low levels.

Example: See Example "Input and output settings" on page 205.

Manual operation: See "MODE (Digital In)" on page 138

CHANnel:EXTernal subsystem



Remote control commandsR&S®NPA

211User Manual 1179.1664.02 ─ 05

CHANnel[:EXTern]:DINPut[:STATe] <State>

Activates the measurement of an externally supplied digital signal.

Parameters:
<State> 1 | 0 | (ON | OFF)

Example: See Example "Input and output settings" on page 205.

Manual operation: See "ACTIVATE" on page 138

CHANnel[:EXTern]:DOUTput:INVert <State>

Inverts the digital output signal.

Parameters:
<State> 1 | 0 ON | OFF

ON | 1
Inverts the signal.
OFF | 0
Turns off the inversion.

Example: See Example "Input and output settings" on page 205.

Manual operation: See "INVERT (Digital Out)" on page 139

CHANnel[:EXTern]:DOUTput:MODE <Mode>

Selects the parameter for the digital output.

Parameters:
<Mode> LIMIT<n> | FPLL

LIMit<n>
Provides limit readings of parameter, selected with command
CHANnel:LIMit<n>:SOURce on page 216. The suffix <n>
selects the position of the parameter in the limit list.
FPLL
Provides the frequency of the selected parameter.

Example: See Example "Input and output settings" on page 205.

Manual operation: See "MODE (Digital Out)" on page 139

CHANnel[:EXTern]:DOUTput[:STATe] <State>

Activates the digital signal output.

Parameters:
<State> 1 | 0 | (ON | OFF)

Example: See Example "Input and output settings" on page 205.

Manual operation: See "ACTIVATE" on page 138
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CHANnel[:EXTern]:SENSor[:STATe] <State>

Activates the measurement with an external probe.

Enabled sensor measurement disables automatic current measurement.

Parameters:
<State> 1 | 0 | (ON | OFF)

Example: See Example "SENsor settings" on page 208.

Manual operation: See "ACTIVATE" on page 140

CHANnel[:EXTern]:SENSor:CCLamp[:RATio] <Value>

Sets the ratio of current to voltage for measurements with current probes. To select the
corresponding mode set CHANnel[:EXTern]:SENSor:MODE > CCLamp.

Parameters:
<Value> MIN | MAX | DEV

Range: 0.001 to 1
Default unit: VA

Example: See Example "SENsor settings" on page 208.

Manual operation: See "RATIO" on page 141
See "USER" on page 141

CHANnel[:EXTern]:SENSor:EXTShunt[:RESistance] <Value>

Sets the resistance of the external shunt. To select the corresponding mode set
CHANnel[:EXTern]:SENSor:MODE >EXTShunt.

Parameters:
<Value> MIN | MAX | DEV

Range: 0.999 to 1
Default unit: Ω

Example: See Example "SENsor settings" on page 208.

Manual operation: See "RESISTANCE" on page 141

CHANnel[:EXTern]:SENSor:MODE <Mode>

Selects the measurement mode according to the external probe.

Parameters:
<Mode> EXTShunt | CCLamp

Example: See Example "SENsor settings" on page 208.

Manual operation: See "MODE" on page 141
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CHANnel[:EXTern]:SENSor:RANGe <Voltage_peak>

Selects the voltage measurement range.

Parameters:
<Voltage_peak> 0.1 | 1 | 4

Default unit: V

Example: See Example "SENsor settings" on page 208.

Manual operation: See "RANGE" on page 140

13.5  CHANnel:LIMit subsystem

The subsystem contains the commands for configuring limit values for measurment
parameters.
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Example: LIMit settings
The example represents the remote control commands for confiruging the measure-
ment limits.
****************************************
// Configure the parameters:
// e.g. select 3 parameters, e.g. active power P
// root mean square voltage Urms and phase shift PHI
// set the minimum and maximum values
// activate limitation
// ****************************************

CHANnel:LIMit1:SOURce P
CHANnel:LIMit1:HIGH 1
CHANnel:LIMit1:LOW 0.5
CHANnel:LIMit2:SOURce URMS
CHANnel:LIMit2:HIGH 60
CHANnel:LIMit2:LOW 10
CHANnel:LIMit3:SOURce PHI
CHANnel:LIMit3:HIGH 4.8
CHANnel:LIMit3:LOW -0.2
CHANnel:LIMit1:STATe 1
CHANnel:LIMit2:STATe 1
CHANnel:LIMit3:STATe 1

****************************************
// Query the settings 
CHANnel:LIMit1:SOURce?
// Response: P
CHANnel:LIMit1:HIGH?
// Response: 1
CHANnel:LIMit1:LOW?
// Response: 0.5
CHANnel:LIMit2:SOURce?
// Response: URMS
// ....

****************************************
// Query limit progress and result 

CHANnel:LIMit1:RESult[:STATe]?
// Response: 1
CHANnel:LIMit1:PERCent?
// Response: 35

CHANnel:LIMit<n>:HIGH................................................................................................ 215
CHANnel:LIMit<n>:LOW.................................................................................................215
CHANnel:LIMit<n>:PERCent?......................................................................................... 215
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CHANnel:LIMit<n>RESult[:STATe]................................................................................... 216
CHANnel:LIMit<n>:SOURce............................................................................................216
CHANnel:LIMit<n>[:STATe]............................................................................................. 216

CHANnel:LIMit<n>:HIGH <Value>

Sets the maximum value for the selected parameter.

The cell index determines the position of the parameter in the list of limits.

Suffix: 
<n>

.
1 to 6
Selects the position of the limited parameter.

Parameters:
<Value> numeric

Range: depends on parameter
Default unit: depends on parameter

Example: See Example "LIMit settings" on page 214.

Manual operation: See "HIGH" on page 95

CHANnel:LIMit<n>:LOW <Value>

Sets the minimum value for the selected parameter.

The cell index determines the position of the parameter in the list of limits.

Suffix: 
<n>

.
1 to 6
Selects the position of the limited parameter.

Parameters:
<Value> numeric

Range: depends on parameter
Default unit: depends on parameter

Example: See Example "LIMit settings" on page 214.

Manual operation: See "LOW" on page 95

CHANnel:LIMit<n>:PERCent? <Value>

Queries the result of limit calculation between min and max values

Parameters:
<State> numeric

Default unit: %

Example: See Example "LIMit settings" on page 214.

Usage: Query only
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CHANnel:LIMit<n>RESult[:STATe] <State>

Queries the result of the limit check.

Parameters:
<State> 1 | 0 | ON | OFF

Example: See Example "LIMit settings" on page 214.

CHANnel:LIMit<n>:SOURce <Name>

Selects the measurement parameter for configuring the limits.

The cell index determines the position of the parameter in the list of limits.

Suffix: 
<n>

.
1 to 6
Selects the position of the limited parameter.

Parameters:
<Name> EMPTy | FI | FPLL | FU | IAVG | IRMS | ITHD | LAMBda | P |

PHI | Q | S | UAVG | URMS | UTHD
See Table 7-1 for the list of parameters.

Example: See Example "LIMit settings" on page 214.

Manual operation: See "SOURCE" on page 95

CHANnel:LIMit<n>[:STATe] <State>

Activates the limit functon for the selected parameter.

Parameters:
<State> 1 | 0 | ON | OFF

Example: See Example "LIMit settings" on page 214.

Manual operation: See "ACTIVATE" on page 95

13.6  CHANnel:MEASurement subsystem

The CHANnel:MEASurement subsystem contains the commands for configuring the
external interfaces.
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Example: MEASurement settings
The example represents the remote control commands for configuring the settings for
measurements with external probes.
****************************************
// Set the format of the measurement value.
// Define the measurement function list.
****************************************
CHANnel:MEASurement:FORMat BIN
CHAN:MEAS:FUNCtions P,S,Q,LAMB,PHI

****************************************
// Query the readings and settings:
// measurement value of all activated cells
// measurement function list 
// number of defined functions

CHANnel:MEASurement:DATA?
// Response: 0.0114444,5.12711E-05,-2.34079E-07,NAN,5,0.005,NAN
CHANnel:MEASurement:FORMat?
// Response: BIN
CHANnel:MEASurement:FUNCtions?
// Response: P,S,Q,LAMB,PHI
CHANnel:MEASurement:FUNCtions? 3
// Response: Q
CHANnel:MEASurement:FUNCtions:COUNt?
//Response: 5

****************************************
// Query the voltage and current values 
// measured in inrush and waveform views

CHANnel:MEASurement:INRush:CURRent[:DATA]?
// Response: -5.49333e-05,-4.39467e-05,-5.67644e-05,...
CHANnel:MEASurement:INRush:VOLTage[:DATA]?
// Response: 6.48213,6.20746, 6.15253,...
CHANnel:MEASurement:WAVeform:CURRent[:DATA]?
// Response: -5.49333e-05,-4.39467e-05,-5.67644e-05,...
CHANnel:MEASurement:WAVeform:VOLTage[:DATA]?
// Response: 6.48213,6.20746, 6.15253,...

CHANnel:MEASurement:DATA?......................................................................................218
CHANnel:MEASurement:FORMat....................................................................................218
CHANnel:MEASurement:FUNCtions................................................................................ 218
CHANnel:MEASurement:FUNCtions:COUNt??................................................................. 219
CHANnel:MEASurement:INRush:CURRent[:DATA]??........................................................219
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CHANnel:MEASurement:INRush:VOLTage[:DATA]??........................................................ 219
CHANnel:MEASurement:WAVeform:CURRent[:DATA]??....................................................219
CHANnel:MEASurement:WAVeform:VOLTage[:DATA]??.................................................... 220

CHANnel:MEASurement:DATA? [<Cell>]

Queries the measurement value of all or a single measurements cell.

Query parameters: 
[<Cell>] Selects the measurement cell.

1 to 6 or 1 to 10, depending on the selected page size, see
VIEW:NUMeric:PAGE<n>:SIZE on page 250.

Return values: 
<Data> Comma-separated list of values.

If "NAN" is displayed (measurement format = ASCII), either the
measurement cell was empty (EMPTY) or the measured value
could not be displayed due to the chosen settings.

Example: See Example "MEASurement settings" on page 217.

Usage: Query only

CHANnel:MEASurement:FORMat <Format>

Sets the data format for querying the measured values.

Parameters:
<Format> BINary | ASCii

BINary
Binary format (4 bytes IEEE float)
ASCii
ASCII format

Example: See Example "MEASurement settings" on page 217.

CHANnel:MEASurement:FUNCtions <Function>{,<Function>}
CHANnel:MEASurement:FUNCtions? [<Index>]

Sets the list of measurement function names for CHANnel:MEASurement:DATA?
on page 218. The measurement function list is independent from the displayed mea-
surement cells.

Parameters:
<Function>
{,<Function>}

Available functions are listed in VIEW:NUMeric:PAGE<n>:
CELL<m>:FUNCtion on page 250.

Query parameters: 
[<Index>] Selects the measurement index.

Range: 1 to 6 or 1 to 10, depending on the selected page
size.
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Example: See Example "MEASurement settings" on page 217.

CHANnel:MEASurement:FUNCtions:COUNt??

Queries the number of measurement functions which are defined with the command
CHANnel:MEASurement:FUNCtions on page 218.

Return values: 
<Count> Range: 1  to  250

Example: See Example "MEASurement settings" on page 217.

Usage: Query only

CHANnel:MEASurement:INRush:CURRent[:DATA]?? <Value>

Queries the values of the current trace in the inrush view.

To set the output format, use the command CHANnel:MEASurement:FORMat
on page 218.

Parameters:
<value>

Example: See Example "View settings" on page 244.

Usage: Query only

CHANnel:MEASurement:INRush:VOLTage[:DATA]?? <Value>

Queries the values of the voltage trace in inrush view.

To set the output format, use the command CHANnel:MEASurement:FORMat
on page 218.

Parameters:
<value>

Example: See Example "View settings" on page 244.

Usage: Query only

CHANnel:MEASurement:WAVeform:CURRent[:DATA]?? <Value>

Queries the values of the current trace in the waveform view.

To set the output format, use the command CHANnel:MEASurement:FORMat
on page 218.

Parameters:
<value>

Example: See Example "View settings" on page 244.

Usage: Query only
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CHANnel:MEASurement:WAVeform:VOLTage[:DATA]?? <Value>

Queries the values of the voltage trace in the waveform view.

To set the output format, use the command CHANnel:MEASurement:FORMat
on page 218.

Parameters:
<value>

Example: See Example "View settings" on page 244.

Usage: Query only

13.7  CHANnel:NAME subsystem

The CHANnel:NAME subsystem contains the commands for configuring the .

Example: NAME settings
The example represents the remote control commands for configuring the .
****************************************
// Define the channel name.
****************************************
CHANnel:NAME 'channel5'

****************************************
// Query the channel name
CHANnel:NAME?
// Response: 'channel5'

CHANnel:NAME............................................................................................................ 220

CHANnel:NAME <String>

Defines or queries the channel name.

Parameters:
<String> String with up to 8 characters.

Example: See Example "NAME settings" on page 220.

13.8  DATA subsystem

The DATA subsystem contains the commands for .
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Example: DATA settings
The example represents the remote control commands for .
****************************************
// Return the logging data values of the selected storage location and file name.
// Delete the logging file data values of the selected storage location and file name.

****************************************
DATA:DATA? 'LOG0001.CSV',EXT
// Response: URMS[V];IRMS[A];P[W];FU[Hz];EMPTY;EMPTY;S[VA];Q[var]; LAMBDA[]
;UTHD[%];Timestamp 
231.27E+00;45.0E-03;6.63E+00;50.0E+00;10.38E+00; 7.98E+00 
DATA:DEL 'LOG0001.CSV',EXT

****************************************
// Query all saved logging files of the selected storage location. 
DATA:LIST? EXT
// Response: 'LOG0001.CSV', 'LOG0002.CSV', 'LOG0003.CSV'
// Query the number of log file values of the selected storage location and file name.
DATA:POIN? 'LOG0001.CSV',EXT
// Response: 5

DATA:DATA?................................................................................................................. 221
DATA:DELete................................................................................................................ 222
DATA:LIST?...................................................................................................................222
DATA:POINts?...............................................................................................................222

DATA:DATA? <Filename>,[<Location>]

Returns the logging file data values of the selected storage location and file name. If no
logging file is found, the message „No Logging Files found“ is displayed. If no storage
location is selected, the instrument queries the internal memory. Please notice that the
logging function has to be activated, if you want to use the manual trigger mode (trig-
ger via TRIG button). Without activating the logging function in manual trigger mode,
the instrument is not able to save a logging file internally or on the USB stick.

Return values: 
<Filename> String parameter to specify the name and directory of the log-

ging file.

[<Location>] INT
Internal memory
EXT
USB stick
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Example: Filename: "LOG0029.CSV"
External logging file (USB stick), count = 3
DATA:DATA? 'LOG0001.CSV'“,EXT
URMS[V];IRMS[A];P[W];FU[Hz];EMPTY;EMPTY;S[VA];Q[var]; LAMBDA[]
;UTHD[%];Timestamp 
231.27E+00;45.0E-03;6.63E+00;50.0E+00;10.38E+00; 7.98E+00 
231.38E+00;45.0E-03;6.64E+00;50.0E+00;+00;7.98E+00; 639E-03 
231.35E+00;45.0E-03;6.63E+00;50.0E+00;10.38E+00; 7.98E+00

Example: See Example "DATA settings" on page 221.

Usage: Query only

DATA:DELete <Filename>,[<Location>]

Deletes the logging file data values of the selected storage location and file name. If no
storage location is selected, the instrument uses the internal memory.

Parameters:
<Filename> String parameter to specify the name and directory of the log-

ging file.

<Location> INT | EXT
INT
Internal memory
EXT
USB stick

Example: See Example "DATA settings" on page 221.

DATA:LIST? [<Location>]

Queries all saved logging files of the selected storage location. If no storage location is
selected, the instrument queries the internal memory. If you store the logging file on the
USB stick, the query returns all files.

Parameters:
[<Location>] INT | EXT

INT
Internal memory
EXT
USB stick

Example: See Example "DATA settings" on page 221.

Usage: Query only

DATA:POINts? <Filename>,[<Location>]

Queries the number of log file values of the selected storage location and file name. If
no storage location is selected, the instrument queries the internal memory.
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Query parameters: 
<Filename> String parameter to specify the name and directory of the log-

ging file.

[<Location>] INT | EXT

Return values: 
<Count> Number of log file values, depending on the log file.

Example: External logging file (USB stick), count = 5
DATA:POIN? 'LOG0001.CSV',EXT
<-- 5

Example: See Example "DATA settings" on page 221.

Usage: Query only

13.9  DISPlay subsystem

The DISPlay subsystem contains the commands for configuring the .

Example: DISPlay settings
The example represents the remote control commands for configuring .
// ****************************************
// Display a text message box on the front display.
// Clear the text message box on the front display.
// Turn on the screen blacklight
// ****************************************
DISPlay:TEXT 'NPA101'
// Response: 'NPA101' shown on the front display
DISPlay:TEXT:CLEar
DISPLay:STATe 1

DISPlay[:STATe].............................................................................................................223
DISPlay:TEXT:CLEar......................................................................................................223
DISPlay:TEXT[:DATA].....................................................................................................224

DISPlay[:STATe] <String>

Activates the blacklight of the screen.

Parameters:
<State> 1 | 0 | ON | OFF

Example: See Example "DISPlay settings" on page 223.

DISPlay:TEXT:CLEar

Clears the text message box on the front display.

Example: See Example "DISPlay settings" on page 223.
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Usage: Setting only

DISPlay:TEXT[:DATA] <String>

Displays a text message box on the front display.

Example: See Example "DISPlay settings" on page 223.

13.10  HardCOPy Subsystem

The HardCOPy subsystem contains the commands for configuring hardcopies.

Example: HardCOPy settings
The example represents the remote control commands for prints of the screen.
****************************************
// Select the data format for the screenshot.
****************************************
HCOPy: FORMat PNG

****************************************
// Query the screenshot parameters 
HCOPy FORMat?
// Response: PNG
HCOPy:SIZE:X?
// Response: 320
HCOPy:SIZE:Y?
// Response: 240
HCOPy:DATA?
// Response: screenshot data in binary format

HCOPy:DATA?.............................................................................................................. 224
HCOPy:FORMat............................................................................................................ 225
HCOPy:SIZE:X?............................................................................................................ 225
HCOPy:SIZE:Y?............................................................................................................ 225

HCOPy:DATA?

Returns the current display content (screenshot data) in binary format.

Example: See Example "HardCOPy settings" on page 224.

Usage: Query only

Manual operation: See "SAVE" on page 152
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HCOPy:FORMat <Format>

Selects or queries the data format of the screenshot.

Parameters:
<Format> BMP | PNG

BMP
Windows Bitmap Format
PNG
Portable Network Graphic
*RST: BMP

Example: See Example "HardCOPy settings" on page 224.

Manual operation: See "FORMAT" on page 152

HCOPy:SIZE:X?

Returns the horizontal dimension of the screenshots.

Example: See Example "HardCOPy settings" on page 224.

Usage: Query only

Manual operation: See "SAVE" on page 152

HCOPy:SIZE:Y?

Returns the vertical dimension of the screenshots.

Example: See Example "HardCOPy settings" on page 224.

Usage: Query only

Manual operation: See "SAVE" on page 152

13.11  INTegrator subsystem

The INTegrator subsystem contains the commands for setting up the integrator
mode.
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Example: Integrator settings
The example represents the remote control commands for configuring the integrator
mode.
****************************************
// Integrator measurements

****************************************
// Manual mode
****************************************
// Activate manual integrator mode
// start and stop measurement
// reset the integrator values
INTegrator:MODe MAN
INTegrator[:STATe] ON
INTegrator:STARt
INTegrator:STOP
INTegrator:RESet

****************************************
// Query the settings
INTegrator:MODe?
// Response: MAN
INTegrator[:STATe]?
// Response: 1

****************************************
// Span mode
****************************************
INTegrator:MODe SPAN
INTegrator[:STATe] ON
INTegrator:STIMe 2020,5,1,13,30,00
INTegrator:DURation 150

****************************************
// Query the settings 
INT?
// Response: 1
INTegrator:MODe?
// Response: SPAN
INTegrator:STIMe?
// Response: 2020,5,1,13,30,00 // 2020-05-01, 13:30 pm 
INTegrator:DURation?
// Response: 150 // 2 h 30 min,0 s

****************************************
// Duration mode
****************************************
INTegrator[:STATe] ON
INTegrator:MODe DURation
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INTegrator:DURation 150

****************************************
// Query the settings 
INT?
// Response: 1
INTegrator:MODe?
// Response: 'DUR'
INTegrator:DURation?
// Response: 150 // 2 h 30 min,0 s

****************************************
// External mode
****************************************
INTegrator[:STATe] ON
INTegrator:MODe EXTernal
INTegrator:RESet

****************************************
// Query the settings 
INT?
// Response: 1
INTegrator:MODe?
// Response: 'EXT'

INTegrator:DURation...................................................................................................... 227
INTegrator:MODE...........................................................................................................228
INTegrator:RESet...........................................................................................................228
INTegrator:STARt...........................................................................................................228
INTegrator:STIMe...........................................................................................................229
INTegrator:STOP........................................................................................................... 229
INTegrator[:STATe]......................................................................................................... 229

INTegrator:DURation <Duration>

Sets the time interval of the integrator function for the span and duration mode. To set
the mode, use the command INTegrator:MODE on page 228.

Parameters:
<Duration> integer

Numeric value in seconds.
Range: 0  to  349199 (96 h)
Default unit: s

Example: See Example "Integrator settings" on page 226.

Manual operation: See "Duration" on page 81
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INTegrator:MODE <Mode>

Selects the integrator mode.

Parameters:
<Mode> MANual | DURation | SPAN | EXTernal

MANual
Selects manual triggering of the integrator measurement.
To start and stop the measurement, use the commands
INTegrator:STARt on page 228 and INTegrator:STOP
on page 229.
DURation
Selects a defined time interval for the integrator measurement.
The measurement starts automatically when INTegrator[:
STATe]= 1.
To set the time interval, use command INTegrator:DURation
on page 227.
SPAN
Selects a defined start time and time interval for the integrator
measurement.
To set the start time and duration, use the commands
INTegrator:STARt on page 228 and INTegrator:
DURation on page 227.
EXTernal
Enables an external trigger signal for the integrator measure-
ment.

Example: See Example "Integrator settings" on page 226.

Manual operation: See "Mode" on page 79

INTegrator:RESet

Resets the integration time.

Example: See Example "Integrator settings" on page 226.

Usage: Event

Manual operation: See "Reset" on page 80

INTegrator:STARt

Starts the manual integrator mode, if the integration funtionality is activated with the
command :INTegrator:STATe 1.

Example: See Example "Integrator settings" on page 226.

Usage: Event

Manual operation: See "Start Stop" on page 80
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INTegrator:STIMe <Year>,<Month>,<Day>,<Hour>,<Minute>,<Second>

Sets the integration start time.

Parameters:
<Year> integer

<Month> integer
Range: 1  to  12

<Day> integer
Range: 1  to  365

<Hour> integer
Range: 0  to  23
Default unit: h

<Minute> integer
Range: 0  to  59
Default unit: min

<Second> integer
Range: 0  to  59
Default unit: s

Example: See Example "Integrator settings" on page 226.

Usage: SCPI confirmed

Manual operation: See "Start Time" on page 80
See "Set to curr. time" on page 80
See "Set Date & Time" on page 81

INTegrator:STOP

Stops the manual integrator mode, when the integration funtionality is running.

Set :INTegrator:STATe 1 and :INTegrator:STARt 1 to activate and start the
measurement.

Example: See Example "Integrator settings" on page 226.

Usage: Event

Manual operation: See "Start Stop" on page 80

INTegrator[:STATe] <State>

Activates the integrator functionality.

Parameters:
<State> 1 | 0 | ON | OFF

Example: See Example "Integrator settings" on page 226.

Manual operation: See "Activate" on page 79
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13.12  LOG subsystem

The LOG subsystem contains the commands for setting the parameters of the data log-
ging function.
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Example: Logging data settings
The example represents the remote control commands for configuring the logging
mode.
****************************************
// Configure the data logging function.
// Deactivate logging mode to set the parameters:
// Select or create a log file: enter the filename and storage location,
// e.g. an external USB stick.
****************************************
LOG:STATe OFF
LOG:FNAMe "LogTest01.csv",EXT

****************************************
// Select the measurement data page
LOG:PAGE 2

****************************************
// Configure the parameters:
// select 10 min time interval, SPAN mode, start time and duration.
LOG:INTerval 300
LOG:MODE SPAN
LOG:STIMe 2020,5,1,13,30,00
LOG:DURation 150

// :LOG:MODE COUNt
// :LOG:COUNt 100

****************************************
// Query the data logging settings 
LOG:PAGE?
// Response: 2
LOG:FNAME?
// Response: 'LogTest01.CSV',EXT

LOG:INTerval?
/// Response 300
LOG:MODE?
// Respone: SPAN
LOG:STIMe?
// Response: 2020,5,1,13,30,00 // 2020-05-01, 13:30 pm 
LOG:DURation?
// Response: 150 // 2 h 30 min,0 s
LOG:COUNt?
// Response: 100

****************************************
// Start and stop logging data
LOG[:STATe] ON
LOG[:STATe]?
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// Response: 1  // logging data is activated
LOG:STARt
LOG:STOP

LOG:COUNt.................................................................................................................. 232
LOG:DURation.............................................................................................................. 232
LOG:FNAMe..................................................................................................................232
LOG:INTerval.................................................................................................................233
LOG:MODE...................................................................................................................233
LOG:PAGE....................................................................................................................233
LOG:STIMe...................................................................................................................234
LOG[:STATe]................................................................................................................. 234

LOG:COUNt <Measurements>

Sets the number of measurement readings in count mode. To set the mode, use the
command LOG:MODE on page 233 to be captured.

Parameters:
<Measurements> integer

Range: 1  to  100000000

Example: See Example "Logging data settings" on page 231.

Manual operation: See "COUNT" on page 88

LOG:DURation <Log_Duration>

Defines the duration of logging for the measurement in span and duration mode. To set
the mode, use the command LOG:MODE on page 233.

Parameters:
<Log_Duration> integer

Numeric value in seconds.
Range: 0  to  349199 (96h)

Example: See Example "Logging data settings" on page 231.

Manual operation: See "Duration" on page 88

LOG:FNAMe <FileName>,[<Location>]

Sets the file name and path for the storing the data recorded during data logging.

The query retunrs the file name and path. You can query the information also when
data logging is running.

Parameters:
<FileName> String with the filename.

[<Location>] INT | EXT
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INT
Internal memory
EXT
USB stick

Example: See Example "Logging data settings" on page 231.

LOG:INTerval <Interval>

Selects the logging measurement interval. The measurement interval describes the
time between the recorded measurements.

Parameters:
<Interval> Numeric value seconds, assignable in rounded steps:

0.1|1|5|10|60|300|600
Range: 0.1  to  600
Default unit: s

Example: See Example "Logging data settings" on page 231.

Manual operation: See "INTERVAL" on page 87

LOG:MODE <Log_Mode>

Selects the data logging mode.

Parameters:
<Log_Mode> UNLimited | COUNt | DURation | SPAN

UNLimited
No specified limit of measurement readings.
COUNt
Determines the number of measurement readings.
DURation
Sets a time interval between the measurement readings.
SPAN
Defines start time and time span for the measurement readings.
*RST: UNL

Example: See Example "Logging data settings" on page 231.

Manual operation: See "MODE" on page 87

LOG:PAGE <Page>

Selects the measurement page index to be logged.

Parameters:
<Page> integer

Range: 1  to  4

Example: See Example "Logging data settings" on page 231.
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Manual operation: See "LOG PAGE" on page 87

LOG:STIMe <Year>,<Month>,<Day>,<Hour>,<Minute>,<Second>

Sets the logging start time.

Parameters:
<Year> integer

Four-digit number, including the century and millenium informa-
tion.

<Month> Range: 1  to  12

<Day> Range: 1  to  365

<Hour> Range: 0  to  23
Default unit: h

<Minute> Range: 0  to  59
Default unit: min

<Second> Range: 0  to  59
Default unit: s

Example: See Example "Logging data settings" on page 231.

Usage: SCPI confirmed

Manual operation: See "Start Time" on page 88
See "Set to curr. time" on page 88
See "Set Date & Time" on page 89

LOG[:STATe] <State>

Activates the data logging function.

Parameters:
<State> ON | OFF | 1 | 0

*RST: OFF | 0

Example: See Example "Logging data settings" on page 231.

Manual operation: See "ACTIVATE" on page 87

13.13  STATus subsystem

This system contains the commands for the status reporting system. See also Sec-
tion 12.1.4, "Status reporting system", on page 175 for detailed information. *RST has
no effect on the status registers.
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13.13.1  Status operation register

This system contains the commands for controlling the STATus:OPERation register
of the status reporting system.

The configuration commands set the corrsponding register. They determine which sta-
tus changes of the R&S NPA cause changes in the status registers.

Value range: Decimal values in the range 0 to 32767 (=215-1)

STATus:OPERation:CONDition?......................................................................................235
STATus:OPERation:ENABle............................................................................................235
STATus:OPERation:NTRansition..................................................................................... 235
STATus:OPERation:PTRansition......................................................................................235
STATus:OPERation[:EVENt]?..........................................................................................236

STATus:OPERation:CONDition?

Queries the CONDition part of the operational status register.

Return values: 
<CONDition> Condition bits in decimal representation.

Range: 1  to  65535

Usage: Query only

STATus:OPERation:ENABle <Enable_value>

Enables or queries the bits in the enable register for the Standard Operation Register
group.

Parameters:
<Enable_Value> Range: 1  to  65535

STATus:OPERation:NTRansition <Value>

Sets or queries the negative transition filter. If a bit is set, a 1 to 0 transition in the cor-
responding bit of the condition register causes a 1 to be written in the corresponding bit
of the status register.

Parameters:
<Value> Range: 1  to  65535

STATus:OPERation:PTRansition <Value>

Sets or queries the positive transition filter. If a bit is set, a 0 to 1 transition in the corre-
sponding bit of the condition register causes a 1 to be written in the corresponding bit
of the status register.

Parameters:
<Value> Range: 1  to  65535
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STATus:OPERation[:EVENt]?

Queries the actions the instrument has executed since the last reading.

Return values: 
<OPERation> Range: 1  to  65535

Usage: Query only

13.13.2  Status questionable register

This system contains the commands for controlling the STATus:QUEStionable reg-
ister of the status reporting sytem.

Queries return the current value of the corresponding register, which permits a check
of the device status.

STATus:QUEStionable:CONDition?..................................................................................236
STATus:QUEStionable:ENABle....................................................................................... 236
STATus:QUEStionable:ENABle?......................................................................................236
STATus:QUEStionable:NTRansition................................................................................. 237
STATus:QUEStionable:PTRansition................................................................................. 237
STATus:QUEStionable[:EVENt]?......................................................................................237

STATus:QUEStionable:CONDition?

Returns the contents of the CONDition part of the status register to check for question-
able instrument or measurement states. Reading the CONDition registers does not
delete the contents.

Return values: 
<Condition> Condition bits in decimal representation

Range: 1  to  65535

Usage: Query only

STATus:QUEStionable:ENABle <Enable_value>

Sets the enable mask that allows true conditions in the EVENt part to be reported in
the summary bit. If a bit in the enable part is set to 1 and its associated event bit transi-
tions to true, a positive transition occurs in the summary bit and is reported to the next
higher level.

Parameters:
<Enable_value> Bit mask in decimal representation

Range: 1  to  65535

STATus:QUEStionable:ENABle?

Queries the enable register and returns a decimal value which corresponds to the
binary-weighted sum.
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Usage: Query only

STATus:QUEStionable:NTRansition <Value>

Sets or queries the negative transition filter. If a bit is set, a 1 to 0 transition in the cor-
responding bit of the condition register causes a 1 to be written in the corresponding bit
of the event register.

Parameters:
<Value> Bit mask in decimal representation

Range: 1  to  65535

STATus:QUEStionable:PTRansition <Value>

Sets or queries the positive transition filter. If a bit is set, a 0 to 1 transition in the corre-
sponding bit of the condition register causes a 1 to be written in the corresponding bit
of the event register.

Parameters:
<Value> Bit mask in decimal representation

Range: 1  to  65535

STATus:QUEStionable[:EVENt]?

Queries the contents of the EVENt part of the status register to check whether an
event has occurred since the last reading. Reading an EVENt register deletes its con-
tents.

Return values: 
<QUEStionable> Event bits in decimal representation

Range: 1  to  65535

Usage: Query only

13.14  SYSTem subsystem

The SYSTem subsystem contains the commands for general functions which do not
directly affect instrument operation.
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Example: General instrument settings
The example represents the remote control commands for general settings.
// Request information on the instrument configuration.
SYSTem:DEV?
// Response: 'NPA101' // instrument model
SYSTem:HARDware?
// Response: #H40000000 // hardware version
SYSTem:SNUM?
// Response: 
SYSTem:VERsion?
// Response: 0x3

// Enable the instrument to create a time stamp
SYSTem:DATE 2020,02,20
SYSTem:DATE?
Response: 2020,2,20
SYSTem:TIME 10,08,41
SYSTem:TIME?
Response: 10,8,41

// Set the sound functionality of the beeper.
//Enable the sound to beep when an error occurs
SYSTem:BEEP:STAT On
SYSTem:BEEP:STATe?
Response: 1

// Disable the sound to beep when the instrument receives a remote control command.
SYSTem:BEEP Off
SYSTem:BEEP?
Response: 0

// Select the interface for remote control.
SYSTem:INTerface LAN
SYSTem:INTerface?
Response: LAN

SYSTem:BEEPer:STATe................................................................................................. 239
SYSTem:BEEPer[:IMMediate]......................................................................................... 239
SYSTem:DATE.............................................................................................................. 239
SYSTem:DEVice?.......................................................................................................... 240
SYSTem:ELISt?............................................................................................................. 240
SYSTem:ERRor:ALL?.....................................................................................................240
SYSTem:ERRor[:NEXT]?................................................................................................240
SYSTem:HARDware?.....................................................................................................241
SYSTem:INTerface.........................................................................................................241
SYSTem:LOCal..............................................................................................................241
SYSTem:NAME............................................................................................................. 241
SYSTem:REMote........................................................................................................... 242
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SYSTem:RWLock...........................................................................................................242
SYSTem:SET................................................................................................................ 242
SYSTem:SHUTdown...................................................................................................... 242
SYStem:SNUMber?....................................................................................................... 242
SYSTem:SOFTware?..................................................................................................... 242
SYSTem:TIME...............................................................................................................242
SYSTem:TREE?............................................................................................................ 243
SYSTem:VERSion?........................................................................................................243

SYSTem:BEEPer:STATe <Mode>

Activates the beeper to create an acoustic signal on error.

The query returns the current state.

Parameters:
<boolean> 1 | 0 | ON | OFF

*RST: ON | 1

Example: See Example "General instrument settings" on page 238.

Manual operation: See "Error Beep" on page 160

SYSTem:BEEPer[:IMMediate]

Activates the beeper to create an acoustic signal when a setting is done over remote
control.

The query returns the current state.

Parameters:
<boolean> 1 | 0 | ON | OFF

*RST: ON | 1

Example: See Example "General instrument settings" on page 238.

Usage: Setting only

Manual operation: See "CTRL Beep" on page 160

SYSTem:DATE <Year>,<Month>,<Day>

Sets or queries the date for the instrument-internal calendar.

Parameters:
<Year> integer

<Month> integer
Range: 1 to 12

<Day> integer
Range: 1 to 31

Example: See Example "General instrument settings" on page 238.
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Usage: SCPI confirmed

Manual operation: See "Date" on page 159

SYSTem:DEVice?

Queries the instrument model.

Example: See Example "General instrument settings" on page 238.

Usage: Query only

SYSTem:ELISt?

Queries the error/event queue for all unread items and removes them from the queue.

See also SYSTem:ERRor:ALL?.

Usage: Query only

SYSTem:ERRor:ALL?

Queries the error/event queue for all unread items and removes them from the queue.
The response is a comma separated list of error number and a short description of the
error in FIFO order. Positive error numbers are instrument-dependent. Negative error
numbers are reserved by the SCPI standard.

Return values: 
<ERRor> List of:

Error/event_number,“Error/event_description>[;Devicedepend-
ent info]“
If the queue is empty, the response is 0,“No error”

Usage: Query only
SCPI confirmed

SYSTem:ERRor[:NEXT]?

Queries an error and removes it from the queue. Positive error numbers are instru-
ment-dependent. Negative error numbers are reserved by the SCPI standard. If the
queue is empty, the response is 0, “No error“.

Return values: 
<ERRor> 0, "No error"

-100, "Command error"
-102, "Syntax error"
-104, "Data type error"
-350, "Queue overflow"

Usage: Query only
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SYSTem:HARDware?

Queries the instrument hardware version.

Example: See Example "General instrument settings" on page 238.

Usage: Query only

SYSTem:INTerface <interface>

Selects the interface for remote control.

Parameters:
<Interface> LAN | GPIB | USBCDC | USBTMC

LAN
Selects the Ethernet (LAN) interface for remote control.
GPIB
Selects the IEEE488 interface for remote control.
USBCDC
Selects the USB interface for remote control over the VCP port
with CDC protocol (requires USB-VCP driver).
USBTMC
Selects the USB interface for remote control with TMC protocol
(requires VISA library).

Example: See Example "General instrument settings" on page 238

Usage: SCPI confirmed

Manual operation: See "USB TMC" on page 179
See "ETHERNET" on page 180
See "IEEE488" on page 183

SYSTem:LOCal

Sets the system to front panel control. The front panel control is unlocked. If the front
panel control was locked with SYSTem:RWLock, the message box of the locked front
panel on the display is closed.

Usage: Setting only

SYSTem:NAME <Name>

Defines or queries the instrument name.

Parameters:
<Name> String with max. 20 characters.

Example: SYSTem:NAME 'TEST UNIT'
SYSTem:NAME?
<-- TEST UNIT
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SYSTem:REMote

Sets the system to remote state. The front panel control is locked.

To enable the front panel control, use the  (local) softkey.

Usage: Setting only

SYSTem:RWLock

Sets the system to remote state. The front panel control is locked and a message box
is shown on the instrument display.

To unlock the front panel control, use SYSTem:LOCal.

Usage: Setting only

SYSTem:SET <block data>

Sets the current instrument state in form of definite binary block data.

Example: See Example "General instrument settings" on page 238

Usage: SCPI confirmed

SYSTem:SHUTdown

Turns off the instrument and sets it in standby mode. The instrument cannot be
enabled remotely.

Usage: Setting only

SYStem:SNUMber?

Queries the instrument serial number.

Example: See Example "General instrument settings" on page 238.

Usage: Query only

SYSTem:SOFTware?

Queries the instrument firmware version.

Example: See Example "General instrument settings" on page 238.

Usage: Query only

SYSTem:TIME <Hour>,<Minute>,<Second>

Sets or queries the time for the instrument-internal clock.

The R&S NPA indicates the time also in the status bar.
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Parameters:
<Hour> integer

Range: 0 to 23
Default unit: h

<Minute> integer
Range: 0 to 59
Default unit: min

<Second> integer
Range: 0 to 59
Default unit: s

Example: See Example "General instrument settings" on page 238.

Usage: SCPI confirmed

Manual operation: See "Time" on page 159

SYSTem:TREE?

Returns a list of implemented remote commands.

Usage: Query only

SYSTem:VERSion?

Returns the firmware version and the version of the SCPI standard.

Usage: Query only

Manual operation: See "Device Information" on page 158

13.15  VIEW subsystem

The subsystem contains the commands for configuring the parameters of the display
modes.
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Example: View settings
The example represents the remote control commands for configuring the display of
the measurement results.
****************************************
// Numeric mode
****************************************
// Configure the parameters:
// select numeric display and set the number 
// of cells for display, the measurement 
// parameters and position.
// activate display of measurement page 1
****************************************
VIEW NUMeric
VIEW:NUMeric:PAGE1:SIZE 6
VIEW:NUMeric:PAGE1:CELL1:FUNCtion P
VIEW:NUMeric:PAGE1:CELL2:FUNCtion S
VIEW:NUMeric:PAGE1:CELL3:FUNCtion Q
VIEW:NUMeric:PAGE1:CELL4:FUNCtion LAMBda
VIEW:NUMeric:PAGE1:CELL5:FUNCtion PHI
VIEW:NUMeric:PAGE1:CELL6:FUNCtion FU
VIEW:NUMeric[:SHOW] 1

****************************************
// Query the settings:
VIEW?
// Response: NUM
VIEW:NUMeric:PAGE1:SIZE?
// Response: 6
VIEW:NUMeric:PAGE1:CELL5:FUNCtion?
// Response: PHI

****************************************
// Harmonics mode
****************************************
// Configure the parameters:
// select harmonics bar graph display 
// set number of harmonics and the type of
// harmonics to be included in FTT calculation
// select the source and scaling factor.
****************************************
VIEW HARMonics
VIEW:HARMonics:VIEW BAR
VIEW:HARMonics:SOURce VOLTage
VIEW:HARMonics:NUMBer 15
VIEW:HARMonics:SCALing ABSolut
VIEW:HARMonics:SUBSet ALL

****************************************
// Query the settings:
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VIEW?
// Response: HARmonics
VIEW:HARMonics:VIEW?
// Response: BAR
VIEW:HARMonics:SOURce?
// REsponse: VOLTage
VIEW:HARMonics:NUMBer?
// Repsonse: 15
VIEW:HARMonics:SCALing?
// Repsonse: ABSolut
VIEW:HARMonics:SUBSet?
// Response: ALL

// Query the maximum number of harmonics
VIEW:HARMonics:NUMBer? MAX
// Response: 50

****************************************
// Waveform mode
****************************************
// Configure the parameters:
// select waveform display mode
// set all parameters visible on the screen
****************************************

VIEW WAVEform
VIEW:WAVeform:VOLTage 1
VIEW:WAVeform:CURRent 1
VIEW:WAVeform:POWer 1
VIEW:WAVeform:READout 1

****************************************
// Query the settings:
VIEW?
// Response: WAVeform
VIEW:WAVeform:VOLTage?
// Response: 1
VIEW:WAVeform:CURRent?
// Response: 1
VIEW:WAVeform:POWer?
// Response: 1
VIEW:WAVeform:READout?
// Response: 1

****************************************
// Trendchart mode
****************************************
// Configure the parameters:
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// select trendchart display 
// select the source parameters and the
// time scaling of the display 
// activate the graphical display 
// of both sources
// reset the screen and restart the trace.
****************************************

VIEW TRENdchart
VIEW:TRENdchart:SOURce 1
VIEW:TRENdchart:TIMebase 60
VIEW:TRENdchart:VISible1 1
VIEW:TRENdchart:VISible2 1
VIEW TRENdchart:CLEar

****************************************
// Query the settings:
VIEW?
// Response: TRENdchart
VIEW:TRENdchart:SOURce?
// Response: 1
VIEW:TRENdchart:TIMebase?
// Response: 60
VIEW:TRENdchart:VISible1?
// Response: 1
VIEW:TRENdchart:VISible2?
// Response: 1

****************************************
// Inrush mode
****************************************
// Configure the parameters:
// select inrush display mode
// set voltage and current visible
****************************************

VIEW INRush
VIEW:INRush:CURRent 1
VIEW:INRush:VOLTage 1
CHANnel[:ACQuisition]:INRush:TRIGger MANual
CHANnel[:ACQuisition]:INRush:TIME 2.0
CHANnel[:ACQuisition]:INRush:ACTivate 1

****************************************
// Example for settings triggered by the voltage trace 
// CHANnel[:ACQuisition]:INRush:TRIGger VOLTage
// CHANnel[:ACQuisition]:INRush:VOLTage:SLOPe RISing
// CHANnel[:ACQuisition]:INRush:VOLTage:LEVel 0.5
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****************************************
// Example for settings triggered by the current trace 
// CHANnel[:ACQuisition]:INRush:TRIGger CURRent
// CHANnel[:ACQuisition]:INRush:CURRent:SLOPe FALLing
// CHANnel[:ACQuisition]:INRush:CURRent:LEVel 0.1

****************************************
// Query the settings:
VIEW?
// Response: INRush
VIEW:INRush:VOLTage?
// Response: 1
VIEW:INRush:CURRent?
// Response: 1
CHANnel[:ACQuisition]:INRush:TRIGger?
// Response: MANual
CHANnel[:ACQuisition]:INRush:TIME?
// Response: 2.0
CHANnel[:ACQuisition]:INRush:ACTivate?
// Response: 1

13.15.1  Display mode commands

VIEW............................................................................................................................248
VIEW:HARMonics:NUMber............................................................................................. 248
VIEW:HARMonics:SCALing............................................................................................ 248
VIEW:HARMonics:SOURce............................................................................................ 248
VIEW:HARMonics:SUBSET............................................................................................ 249
VIEW:HARMonics:VIEW.................................................................................................249
VIEW:INRush:CURRent..................................................................................................249
VIEW:INRush:VOLTage.................................................................................................. 250
VIEW:NUMeric:PAGE<n>:CELL<m>:FUNCtion.................................................................250
VIEW:NUMeric:PAGE<n>:SIZE....................................................................................... 250
VIEW:NUMeric[:SHOW]..................................................................................................251
VIEW:TRENdchart:CLEar............................................................................................... 251
VIEW:TRENdchart:SOURce<n>...................................................................................... 251
VIEW:TRENdchart:TIMebase.......................................................................................... 251
VIEW:TRENdchart:VISible<n>.........................................................................................252
VIEW:WAVeform:CURRent............................................................................................. 252
VIEW:WAVeform:POWer.................................................................................................252
VIEW:WAVeform:READout..............................................................................................252
VIEW:WAVeform:VOLTage..............................................................................................252
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VIEW <Mode>

Selects the display mode.

Parameters:
<Mode> NUMeric | HARMonics | TRENdchart | WAVeform | INRush

NUMeric
Displays the measurement results numerically.
HARMonics
Displays the harmonics of current and voltage.
TRENdchart
Displays current or voltage as a signal profile.
WAVeform
Displays the waveform for one cycle of voltage, current or power
data.
INRush
Displays a single shot of a signal profile.
*RST: NUMeric

Example: See Example "View settings" on page 244.

VIEW:HARMonics:NUMber <Number>

Sets the number of harmonics for FFT calculation.

Parameters:
<Number> integer

Range: 5  to  50

Example: See Example "View settings" on page 244.

Manual operation: See "NUMBER" on page 121

VIEW:HARMonics:SCALing <Scaling>

Selects the scaling factor for the harmonics view.

Parameters:
<View> ABSolut | PERCent

Example: See Example "View settings" on page 244.

Manual operation: See "SCALING" on page 121

VIEW:HARMonics:SOURce <Source>

Selects the parameter for FTT calculation.

Parameters:
<Source> VOLTage | CURRent | BOTH
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VOLTage
Uses the voltage for FTT calculation.
CURRent
Uses the current for FTT calculation.
BOTH
Uses both parameters.

Example: See Example "View settings" on page 244.

Manual operation: See "SOURCE" on page 120

VIEW:HARMonics:SUBSET <View>

Selects the harmonics for display.

Parameters:
<View> EVEN | ODD | ALL

EVEN
Displays the even harmonics.
ODD
Displays the odd harmonics.
ALL
Displays the all harmonics.

Example: See Example "View settings" on page 244.

Manual operation: See "SUBSET" on page 121

VIEW:HARMonics:VIEW <View>

Selects the display of the measurement results in the harmonics mode.

Parameters:
<View> BAR | TABle

BAR
Displays the harmonics of current or voltage in a bar graph.
TABLe
Displays the measurement results of the harmonics in a table.

Example: See Example "View settings" on page 244.

Manual operation: See "VIEW SELECT" on page 120

VIEW:INRush:CURRent <State>

Displays the trace of the current in the inrush diagram.

Parameters:
<State> 1 | 0 | ON | OFF

Example: See Example "View settings" on page 244.
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Manual operation: See "VISIBLE" on page 131

VIEW:INRush:VOLTage <State>

Displays the trace of the voltage in the inrush diagram.

Parameters:
<State> 1 | 0 | ON | OFF

Example: See Example "View settings" on page 244.

Manual operation: See "VISIBLE" on page 131

VIEW:NUMeric:PAGE<n>:CELL<m>:FUNCtion <Parameter>

Selects the measurement parameter for display in numeric mode. The page index and
cell index assign the measurement page and position to the parameter.

Suffix: 
<n>

.
1 to 4
Selects the configuration page.

<m> 1 to 6 or 1 to 10, depending on the page size.
Selects the configuration cell.
To set the page size, use the command VIEW:NUMeric:
PAGE<n>:SIZE.

Parameters:
<Parameter> AH | AHM | AHP | | EMPTy | FI | FPLL | FU | IAVG | IRANge |

IRMS | ITHD | LAMBda | P | PHI | Q | S | TIME | UAVG |
URANge | URMS | UTHD | WH | WHM | WHP
See Section 5.1, "Measurement parameters", on page 55 for the
list of parameters including designation and units.

Example: See Example "View settings" on page 244.

Manual operation: See "1, 2, 3, 4" on page 117

VIEW:NUMeric:PAGE<n>:SIZE <Size>

Selects the number of measurement cells for the selected configuration page in
numeric mode.

Suffix: 
<n>

.
1 to 4
Selects the configuration page.

Parameters:
<Size> 6 | 10

Sets the number of measurement cells of the selected page for
display.

Example: See Example "View settings" on page 244.
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Manual operation: See "1, 2, 3, 4" on page 117

VIEW:NUMeric[:SHOW] <Page>

Selects the configuration page in numeric mode.

Parameters:
<Page> 1 | 2 | 3 | 4

Range: 1  to  4

Example: See Example "View settings" on page 244.

Manual operation: See "1, 2, 3, 4" on page 117

VIEW:TRENdchart:CLEar

Deletes the trace data and restarts acquisition.

Example: See Example "View settings" on page 244.

Usage: Setting only

Manual operation: See "CLEAR" on page 125

VIEW:TRENdchart:SOURce<n> <Parameter>

Selects the source for the trendchart display mode.

Suffix: 
<n>

.
1 to 2
Selects the source.

Parameters:
<Parameter> AIN | DIN | ITHD | FI | FPLL | FU | IAVG | IRMS | P | PHI | Q | S |

UAVG | URMS | UTHD

Example: See Example "View settings" on page 244.

Manual operation: See "SCR1, SCR2" on page 125

VIEW:TRENdchart:TIMebase <Timebase>

Sets the time grid of the trendchart diagram.

Parameters:
<Timebase> 5 | 10 | 60 | 600

Default unit: s/Div

Example: See Example "View settings" on page 244.

Manual operation: See "TIME BASE" on page 126

VIEW subsystem
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VIEW:TRENdchart:VISible<n> <State>

Displays the trace of the source in the trendchart diagram.

Suffix: 
<n>

.
1|2
Source index.

Parameters:
<State> 1 | 0 | ON | OFF

Example: See Example "View settings" on page 244.

Manual operation: See "VISIBLE" on page 126

VIEW:WAVeform:CURRent <State>

Activates the display of the current trace.

Parameters:
<State> 1 | 0 | ON | OFF

Example: See Example "View settings" on page 244.

Manual operation: See "CURRENT" on page 123

VIEW:WAVeform:POWer <State>

Activates the display of the power trace.

Parameters:
<State> 1 | 0 | ON | OFF

Example: See Example "View settings" on page 244.

Manual operation: See "POWER" on page 123

VIEW:WAVeform:READout <State>

Displays statistical vaules in the waveform diagram.

Parameters:
<State> 1 | 0 | ON | OFF

Example: See Example "View settings" on page 244.

Manual operation: See "READOUTS" on page 123

VIEW:WAVeform:VOLTage <State>

Activates the display of the voltage trace.

Parameters:
<State> 1 | 0 | ON | OFF

Example: See Example "View settings" on page 244.

VIEW subsystem
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Manual operation: See "VOLTAGE" on page 123

13.15.2  Inrush acquisition commands

CHANnel[:ACQuisition]:INRush:ACTivate......................................................................... 253
CHANnel[:ACQuisition]:INRush:CURRent:LEVel............................................................... 253
CHANnel[:ACQuisition]:INRush:CURRent:SLOPe............................................................. 253
CHANnel[:ACQuisition]:INRush:TIME...............................................................................253
CHANnel[:ACQuisition]:INRush:TRIGger..........................................................................254
CHANnel[:ACQuisition]:INRush:VOLTage:LEVel................................................................254
CHANnel[:ACQuisition]:INRush:VOLTage:SLOPe..............................................................254

CHANnel[:ACQuisition]:INRush:ACTivate <State>

Activates the inrush measurement.

Parameters:
<State> 1 | 0 | ON | OFF

ON
Starts the measurement.
OFF
Stops the measurement and discardes the recorded data.

Example: See Example "View settings" on page 244.

Manual operation: See "ACTIVATE" on page 131

CHANnel[:ACQuisition]:INRush:CURRent:LEVel <Value>

Sets the level of the current trace to generate the trigger event.

Parameters:
<Value> Default unit: V

Example: See Example "View settings" on page 244.

Manual operation: See "LEVEL" on page 132

CHANnel[:ACQuisition]:INRush:CURRent:SLOPe <Slope>

Sets the polarity of the edge for the current signal that triggers the measurement.

Parameters:
<Slope> RISing | FALLing

Example: See Example "View settings" on page 244.

Manual operation: See "SLOPE" on page 132

CHANnel[:ACQuisition]:INRush:TIME <Acquisition_time>

Selects the time period for inrush measurement.

VIEW subsystem
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Parameters:
<Acquisition_time> 0.016 | 0.032 | 0.064 | 0.130 | 0.260 | 0.520 | 1.0 | 2.0 | 4.0 | 8.0 |

16.0 | 33.0 | 67.0
Default unit: s

Example: See Example "View settings" on page 244.

Manual operation: See "ACQ TIME" on page 131

CHANnel[:ACQuisition]:INRush:TRIGger <Trigger>

Selects the trigger mode for the inrush view.

Parameters:
<Trigger> MANual | VOLTage | CURRent

Example: See Example "View settings" on page 244.

Manual operation: See "TRIGGER" on page 131

CHANnel[:ACQuisition]:INRush:VOLTage:LEVel <Value>

Sets the level of the voltage trace to generate the trigger event.

Parameters:
<Value> Default unit: V

Example: See Example "View settings" on page 244.

Manual operation: See "LEVEL" on page 132

CHANnel[:ACQuisition]:INRush:VOLTage:SLOPe <Slope>

Sets the polarity of the edge for the voltage signal that triggers the measurement.

Parameters:
<Slope> RISing | FALLing

Example: See Example "View settings" on page 244.

Manual operation: See "SLOPE" on page 132

VIEW subsystem
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14  Troubleshooting and notifications
● Displaying status information and notifications..................................................... 255
● Problems during firmware update......................................................................... 255
● Problems with remote control over LAN................................................................256
● Contacting customer support................................................................................ 256

14.1  Displaying status information and notifications

The R&S NPA displays notifications to inform you on current settings and states. It dis-
tinguishes between status, information and error notifications and warnings.

Some information and notfications are entered in the error/event queue of the status
reporting system, see Section 12.1.4, "Status reporting system", on page 175.

14.2  Problems during firmware update

The firmware update is described in Section 11.1, "Update (firmware)", on page 154.

Solutions for potential problems that can occur during firmware update are described in
the following sections.

Firmware update was interrupted

If for example, a power cut happened during the firmware update, problems can occur.

1. Perform the firmware update again. Sometimes, a further update fixes the prob-
lems.

2. If you nevertheless cannot update the R&S NPA, contact the local service repre-
sentative, see Section 14.4, "Contacting customer support", on page 256.

Firmware update was aborted

If there is not enough free memory space, the firmware update aborts. The instrument
displays an error message.

► Start the firmware update again.

Problems during firmware update
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14.3  Problems with remote control over LAN

14.3.1  Cannot establish a LAN connection

If you have problems to establish a LAN connection as described in Section 3.1.8,
"Connecting to LAN", on page 25:

1. Check if the TCP/IP address information is valid.

2. Assign the IP address manually, e.g. if the network does not support DHCP config-
uration, see Section 12.4, "Adjusting the interface addresses", on page 185.

14.3.2  Cannot communicate over LAN

If you have problems to establish the LAN communication:

1. Refer to the application note 1SL374: How to communicate with R&S devices
using VISA, that provides comprehensive information on configuring the interfaces,
required drivers, and testing the communication.

2. If you still have problems, contact the customer support.

14.4  Contacting customer support

Technical support – where and when you need it

For quick, expert help with any Rohde & Schwarz product, contact our customer sup-
port center. A team of highly qualified engineers provides support and works with you
to find a solution to your query on any aspect of the operation, programming or applica-
tions of Rohde & Schwarz products.

Contact information

Contact our customer support center at www.rohde-schwarz.com/support, or follow this
QR code:

Contacting customer support

http://www.rohde-schwarz.com/appnote/1SL374
http://www.rohde-schwarz.com/appnote/1SL374
https://www.rohde-schwarz.com/support
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Figure 14-1: QR code to the Rohde & Schwarz support page

Contacting customer support
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15  Transporting
For safety information, see:
● "Lifting and carrying the product" on page 10
● .Section 3.1.1, "Lifting and carrying", on page 19

Packing

Use the original packaging material. It consists of antistatic wrap for electrostatic pro-
tection and packing material designed for the product.

If you do not have the original packaging, use similar materials that provide the same
level of protection. You can also contact your local Rohde & Schwarz service center for
advice.

Securing

When moving the product in a vehicle or using transporting equipment, make sure that
the product is properly secured. Only use items intended for securing objects.

Transport altitude

The maximum transport altitude without pressure compensation is specified in the spe-
cifications document.
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16  Maintenance, storage and disposal
We advise to check the nominal data from time to time.

16.1  Cleaning

How to clean the product is described in "Cleaning the product" on page 13.

Do not use any liquids for cleaning. Cleaning agents, solvents, acids and bases can
damage the front panel labeling, plastic parts and display.

16.2  Changing fuses

If the R&S NPA does not start, it is possible that a blown fuse is the cause. Proceed as
described in Preparing for mains voltage > "To change the fuse" on page 23.

16.3  Storage

Protect the product against dust. Ensure that the environmental conditions, e.g. tem-
perature range and climatic load, meet the values specified in the specifications docu-
ment.

16.4  Disposal

Rohde & Schwarz is committed to making careful, ecologically sound use of natural
resources and minimizing the environmental footprint of our products. Help us by dis-
posing of waste in a way that causes minimum environmental impact.

Disposing of electrical and electronic equipment

A product that is labeled as follows cannot be disposed of in normal household waste
after it has come to the end of its life. Even disposal via the municipal collection points
for waste electrical and electronic equipment is not permitted.

Figure 16-1: Labeling in line with EU directive WEEE

Rohde & Schwarz has developed a disposal concept for the eco-friendly disposal or
recycling of waste material. As a manufacturer, Rohde & Schwarz completely fulfills its

Disposal
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obligation to take back and dispose of electrical and electronic waste. Contact your
local service representative to dispose of the product.

Disposal
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Glossary: List of often used terms and
abbreviations

C
CDC: Communications device class: protocol used for emulating serial ports over
USB.

Computer name: An unambiguous indication of the instrument a LAN that uses a
DNS server.
The default computer name follows the syntax <instrument>-<serial number>,
e.g. NPA701-112233.
Synonym: Hostname
See Serial number.

D
DHCP: Dynamic host configuration protocol

DNS: Domain name system server

E
e.g.: For example

F
FFT: "Fast Fourier Transformation"
A mathematial algorithm to convert a signal, e.g. from the time domain to the frequency
domain and vice versa. You can use this method to represent the time-dependent
behaviour of the the signal power.

G
Glossary: List of the often used terms and abbreviations

GPIB: General purpose interface bus: digital interface system, used to control an
instrument remotely or transfer data between two or more instruments.

GUI: Graphical user interface

H
Hostname: Computer name

I
i.e.: That is

IEC 625/IEEE 488: GPIB
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L
Line voltage: AC voltage of the network.
Synonyms: Mains voltage

O
OSA: Open source acknowledgment documentation embedded in the instrument firm-
ware.

P
PC: Personal computer

product page: A designation of the R&S NPA product page.

R
Remote control: The operation of the R&S NPA by remote control commands or pro-
grams to perform automated tests.
The instrument is connected to a system controller via LAN, GPIB or USB using VISA.
The instrument is controlled directly or supported by instrument drivers.

Remote device: External device controls the R&S NPA in remote operation mode, see
Remote operation.
Synonyms: External controller, client device

S
SCPI: Standard commands for programmable instruments.

Serial number: Unique instrument identification, provided on the rear panel of the
instrument and required to build the Computer name.
The serial number are the last 6 digits in the string <stock no.>-<serial
number>, e.g. NPA701-112233

T
TCP/IP: Transmission control protocol / Internet protocol for communication of devices
in a network (Internet or private network).

U
URL: Uniform resource locator: address string for unique identification of a device con-
nected to a network.

USB: Universal bus interface

USBTMC: USB test & measurement class specification: a protocol that is built on top
of USB for communication with USB devices.

V
VCP: Virtual COM port



Glossary: List of often used terms and abbreviationsR&S®NPA

263User Manual 1179.1664.02 ─ 05

Synonym: CDC

VISA: Virtual instrument software architecture for communication over various interfa-
ces, e.g. Ethernet, LAN or USB.

VISA library: Standardized I/O software interface library for communication of devices
over TCP/IP protocols.
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List of commands
*CLS...............................................................................................................................................................192
*ESE.............................................................................................................................................................. 192
*ESR?............................................................................................................................................................ 193
*IDN?............................................................................................................................................................. 193
*LRN?............................................................................................................................................................ 193
*OPC..............................................................................................................................................................193
*PSC.............................................................................................................................................................. 193
*RCL <Storage>.............................................................................................................................................194
*RST.............................................................................................................................................................. 194
*SAV <Storage>.............................................................................................................................................194
*SRE.............................................................................................................................................................. 194
*STB?.............................................................................................................................................................194
*TRG..............................................................................................................................................................195
*TST?.............................................................................................................................................................195
*WAI...............................................................................................................................................................195
CHANnel:LIMit<n>:HIGH...............................................................................................................................215
CHANnel:LIMit<n>:LOW................................................................................................................................215
CHANnel:LIMit<n>:PERCent?.......................................................................................................................215
CHANnel:LIMit<n>:SOURce..........................................................................................................................216
CHANnel:LIMit<n>[:STATe]............................................................................................................................216
CHANnel:LIMit<n>RESult[:STATe]................................................................................................................ 216
CHANnel:MEASurement:DATA?................................................................................................................... 218
CHANnel:MEASurement:FORMat.................................................................................................................218
CHANnel:MEASurement:FUNCtions.............................................................................................................218
CHANnel:MEASurement:FUNCtions:COUNt??............................................................................................ 219
CHANnel:MEASurement:INRush:CURRent[:DATA]??.................................................................................. 219
CHANnel:MEASurement:INRush:VOLTage[:DATA]??...................................................................................219
CHANnel:MEASurement:WAVeform:CURRent[:DATA]??............................................................................. 219
CHANnel:MEASurement:WAVeform:VOLTage[:DATA]??..............................................................................220
CHANnel:NAME.............................................................................................................................................220
CHANnel[:ACQuisition]:CURRent:CFACtor...................................................................................................199
CHANnel[:ACQuisition]:CURRent:INVert.......................................................................................................199
CHANnel[:ACQuisition]:CURRent:PROTection:RESet..................................................................................199
CHANnel[:ACQuisition]:CURRent:PROTection?........................................................................................... 200
CHANnel[:ACQuisition]:CURRent:RANGe.................................................................................................... 200
CHANnel[:ACQuisition]:CURRent:RANGe:AUTO......................................................................................... 200
CHANnel[:ACQuisition]:INRush:ACTivate..................................................................................................... 253
CHANnel[:ACQuisition]:INRush:CURRent:LEVel.......................................................................................... 253
CHANnel[:ACQuisition]:INRush:CURRent:SLOPe........................................................................................253
CHANnel[:ACQuisition]:INRush:TIME........................................................................................................... 253
CHANnel[:ACQuisition]:INRush:TRIGger...................................................................................................... 254
CHANnel[:ACQuisition]:INRush:VOLTage:LEVel...........................................................................................254
CHANnel[:ACQuisition]:INRush:VOLTage:SLOPe.........................................................................................254
CHANnel[:ACQuisition]:MODE...................................................................................................................... 201
CHANnel[:ACQuisition]:MODE[:AC]:PLL.......................................................................................................201
CHANnel[:ACQuisition]:MODE[:FILTer]:ANALog...........................................................................................201
CHANnel[:ACQuisition]:MODE[:FILTer]:DIGital............................................................................................. 202
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CHANnel[:ACQuisition]:MODE[:FILTer]:FREQuency.....................................................................................202
CHANnel[:ACQuisition]:PEAKhold:ACTivate.................................................................................................202
CHANnel[:ACQuisition]:PEAKhold:RESet..................................................................................................... 202
CHANnel[:ACQuisition]:VOLTage:CFACtor................................................................................................... 203
CHANnel[:ACQuisition]:VOLTage:INVert....................................................................................................... 203
CHANnel[:ACQuisition]:VOLTage:RANGe.....................................................................................................203
CHANnel[:ACQuisition]:VOLTage:RANGe:AUTO..........................................................................................203
CHANnel[:EXTern]:AINPut[:STATe]............................................................................................................... 209
CHANnel[:EXTern]:AOUTput:MODE............................................................................................................. 209
CHANnel[:EXTern]:AOUTput[:STATe]............................................................................................................210
CHANnel[:EXTern]:DINPut:INVert..................................................................................................................210
CHANnel[:EXTern]:DINput:MODE................................................................................................................. 210
CHANnel[:EXTern]:DINPut[:STATe]................................................................................................................211
CHANnel[:EXTern]:DOUTput:INVert.............................................................................................................. 211
CHANnel[:EXTern]:DOUTput:MODE............................................................................................................. 211
CHANnel[:EXTern]:DOUTput[:STATe]............................................................................................................211
CHANnel[:EXTern]:SENSor:CCLamp[:RATio]............................................................................................... 212
CHANnel[:EXTern]:SENSor:EXTShunt[:RESistance]....................................................................................212
CHANnel[:EXTern]:SENSor:MODE............................................................................................................... 212
CHANnel[:EXTern]:SENSor:RANGe..............................................................................................................213
CHANnel[:EXTern]:SENSor[:STATe]..............................................................................................................212
DATA:DATA?..................................................................................................................................................221
DATA:DELete.................................................................................................................................................222
DATA:LIST?................................................................................................................................................... 222
DATA:POINts?............................................................................................................................................... 222
DISPlay:TEXT:CLEar.....................................................................................................................................223
DISPlay:TEXT[:DATA]....................................................................................................................................224
DISPlay[:STATe].............................................................................................................................................223
HCOPy:DATA?...............................................................................................................................................224
HCOPy:FORMat............................................................................................................................................ 225
HCOPy:SIZE:X?............................................................................................................................................ 225
HCOPy:SIZE:Y?............................................................................................................................................ 225
INTegrator:DURation......................................................................................................................................227
INTegrator:MODE.......................................................................................................................................... 228
INTegrator:RESet...........................................................................................................................................228
INTegrator:STARt...........................................................................................................................................228
INTegrator:STIMe...........................................................................................................................................229
INTegrator:STOP........................................................................................................................................... 229
INTegrator[:STATe].........................................................................................................................................229
LOG:COUNt...................................................................................................................................................232
LOG:DURation...............................................................................................................................................232
LOG:FNAMe.................................................................................................................................................. 232
LOG:INTerval................................................................................................................................................. 233
LOG:MODE....................................................................................................................................................233
LOG:PAGE.....................................................................................................................................................233
LOG:STIMe....................................................................................................................................................234
LOG[:STATe].................................................................................................................................................. 234
STATus:OPERation:CONDition?................................................................................................................... 235
STATus:OPERation:ENABle..........................................................................................................................235
STATus:OPERation:NTRansition...................................................................................................................235
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STATus:OPERation:PTRansition...................................................................................................................235
STATus:OPERation[:EVENt]?........................................................................................................................236
STATus:QUEStionable:CONDition?...............................................................................................................236
STATus:QUEStionable:ENABle..................................................................................................................... 236
STATus:QUEStionable:ENABle?................................................................................................................... 236
STATus:QUEStionable:NTRansition..............................................................................................................237
STATus:QUEStionable:PTRansition.............................................................................................................. 237
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SYSTem:BEEPer[:IMMediate]....................................................................................................................... 239
SYSTem:DATE...............................................................................................................................................239
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SYSTem:ERRor[:NEXT]?...............................................................................................................................240
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